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1 TRAKTOR KONTROL S2 の世界へようこそ!
 

TRAKTOR KONTROL S2 を DJ コントローラーとして選んでいただき、Native Instruments チーム一同感
謝しております。

1.1 TRAKTOR KONTROL S2 とは?
 

TRAKTOR KONTROL S2 は TRAKTOR 開発者により手がけられた、専用ハードウェア、DJ パフォーマン
ス用ソフトウェアの総称です 。  TRAKTOR KONTROL S2 は フ ル 機 能 を 装 備 し た  TRAKTOR
KONTROL S2 ハードウェア及び、最新技術を採用した TRAKTOR PRO 2 ソフトウェアを融合したもので
す。
オールインワンの TRAKTOR KONTROL S2 コントローラーは人間工学を考慮した DJ ミキサーで、24-
bit/96 kHz オーディオインターフェイスを標準装備し、TRAKTOR PRO 2 の操作に最適な高解像コントロ
ーラーとして機能します。 ライブパフォーマンスに必要な全コントロール部の指先による操作を可能にしま
した。

資料の注釈について
本資料では、特定表記専用フォントを使用して特記事項や、危険事項について解説しています。以下の各アイ
コンで、特記事項内容を区別しています。
このアイコンの後に表記してある内容には、必ず従ってください。

この電球アイコンでは有効なヒントとなる内容を記載してあります。ここではしばしば機能をより効
率よく使用するための解決策が記載されていますが、必ずこれを実行しなければならないという内容
ではありません。作業効率を図るためには一度確認しておくことをお勧めします。

更に、以下の書式を使用する場合があります。
▪ 各メニューで表示される内容 (Open…、 Save as… 等) 及び、ハードドライブ、またはその他の記録媒

体のパスはイタリックで表示されます。
▪ ハードウェア自体に表記されている名称はオレンジで表記します。この書体が使用されている場合、同じ

テキストをハードウェアでも確認できるはずです。
▪ スクリーン各部で表示されるテキスト(ボタン、コントロール部、チェックボックス脇のテキスト等) はラ

イトブルーで表示されます。この書体が使用されている場合、同じテキストをスクリーン上で確認できる
はずです。

▪ 重要な名称とコンセプトはボールド体で表示しています。

TRAKTOR KONTROL S2 の世界へようこそ!
TRAKTOR KONTROL S2 とは?
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▪ コンピュータのキーボード上で操作する場合はそれらのキーワードを括弧で示します (例、「[Shift] +
[Return]」)。

► インストラクションの始めには、それぞれ再生ボタンのような矢印マークが添えてあります。

→ 操作の結果を示す場合、小さな矢印が添えられます。

1.2 TRAKTOR KONTROL S2 資料について
 

1.2.1 各資料の紹介
 

セットアップガイド
Setup Guide は 製品レジストレーションページにあります。 レジストレーション用用紙にレジストレーシ
ョンページのリンクが記載してあり、この用紙は TRAKTOR KONTROL S2 製品ボックスに同封してありま
す。 この資料は TRAKTOR KONTROL S2 システムのハードウェア/ソフトウェアをインストールする為
のガイドとなり、初歩設定からスピーカーから音が出るまでの手助けとなります。 この資料内容が
TRAKTOR KONTROL S2 を習熟する為の最初の段階となります。

ま ず セ ッ ト ア ッ プ ガ イ ド  (Setup Guide) を 参 照 し て く だ さ い 。 そ の 後 こ の  TRAKTOR
KONTROL S2 マニュアルを手にとって TRAKTOR KONTROL S2 に関する知識を深めてください。

TRAKTOR KONTROL S2 マニュアル
セットアップガイド (Setup Guide) を読み、手順に従った後は、TRAKTOR KONTROL S2 システムが起動
する状態となるはずです。 では、この TRAKTOR KONTROL S2 マニュアルを読み進めましょう。 マニュ
アルでは始めに実践的な TRAKTOR KONTROL S2 の取り扱い方法について解説します。 その後ハードウ
ェアに関する章で TRAKTOR KONTROL S2 ハードウェアコントローラーについて解説し、操作例を解説す
る章で各操作に関して解説します。 セクション ↑1.2.3, 本マニュアルについて ではマニュアル内容の概要
を紹介します。

TRAKTOR 2 マニュアル
TRAKTOR ソフトウェアの全詳細は TRAKTOR 2 マニュアルを参照してください。 アプリケーションリフ
ァレンスは TRAKTOR 2 インストールフォルダの資料用サブフォルダに PDF ファイルとして収納してあ
ります。

TRAKTOR KONTROL S2 の世界へようこそ!
TRAKTOR KONTROL S2 資料について
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1.2.2 効率よく各マニュアルを読み進める
 

各資料は以下の順序で読み進める事を推奨します。
1. セットアップガイド（Setup Guide）
2. TRAKTOR KONTROL S2 マニュアル
3. TRAKTOR 2 マニュアル

1.2.3 本マニュアルについて
 

現在読んでいる資料は TRAKTOR KONTROL S2 マニュアルです。マニュアル構成は以下となっています。
▪ ↑2, TRAKTOR KONTROL S2 の主な内容 章では TRAKTOR KONTROL S2 ユーザーインターフェ

イスと各メインエリアについてハードウェア、ソフトウェア両方の内容を紹介していきます。
▪ ↑3, 音楽ライブラリの準備章では音楽を TRAKTOR の強力なトラックコレクションに追加する方法に

ついて解説するので、手持ちの曲で TRAKTOR KONTROL S2 機能を活用する為の各機能を習得するこ
ととなります。

▪ ↑4, チュートリアル 章ではコントローラーを使用するための解説を行います。ここでは段階的に
TRAKTOR KONTROL S2 に搭載している各ツールの使用方法を紹介していきます。これらの実用例で
簡単に内容を理解することができ、コンピュータを使用した DJ に慣れ親しんでいくことが可能となりま
す。

▪ ↑5, S2 で TRAKTOR DJ を操作する 章では TRAKTOR KONTROL S2 を iOS デバイス用
TRAKTOR DJ で使用する方法を解説します。

▪ ↑6, ハードウェア 概観 章では TRAKTOR KONTROL S2 ハードウェアコントローラー上の全ハードウ
ェアコントロール部について解説します。コントロール部全てを網羅しているので、ここで各部の必要な
情報を得ることができます。

▪ ↑7, ハードウェアコントロールリファレンス 章ではショートチュートリアルを各種用意しており、コン
トローラー各部の理解を深めます。例えばサブチャプターではミキサーセクションでの操作と、実際の操
作方法について解説しています。

▪  ↑8, TRAKTOR KONTROL S2 のカスタマイズ 章では TRAKTOR KONTROL S2 を必要に応じてカ
スタマイズする方法について述べていきます。

▪ ↑9, S2 オーディオインターフェイスとコントロールパネル 章では TRAKTOR KONTROL S2 ハード
ウェアコントローラー内蔵のオーディオインターフェイスについて解説します。

▪ ↑10, トラブルシューティングとヘルプ 章では一般的な問題とその対処方法、ヘルプインフォへのアク
セス方法を紹介します。

▪ 最後に 3 つの付録では有効な追加情報を記載しています。
◦ 付録 A では TRAKTOR KONTROL S2 を各演奏環境下に対応させる為の設定例を紹介しています。

TRAKTOR KONTROL S2 の世界へようこそ!
TRAKTOR KONTROL S2 資料について
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◦ 付録 B では TRAKTOR KONTROL S2 コントローラーの技術仕様を記載しています。
◦ 付録 C ではコントローラーの全コントロール部を早見表形式で紹介しています。コントロール部の

内容を知る場合、この表を参照すると便利でしょう。

ソフトウェア、ハードウェアの呼称
資料内で、TRAKTOR KONTROL S2 ハードウェアコントローラーは「TRAKTOR KONTROL S2」 、「S2
コントローラー」または「S2」 と記載します。
同様に、TRAKTOR ソフトウェアは 「TRAKTOR」と記載する場合があります。
ですから、「TRAKTOR KONTROL S2 は S2 から TRAKTOR をコントロール可能にする専用 DJ システム
です」 といった文章が頻出することとなります。

1.3 動作環境
 

製品を使用するためにコンピュータが必要な動作環境と互換性 に関しては Native Instruments ウェブサイ
トの TRAKTOR 仕様セクションを参照してください。
http://www.native-instruments.com/en/products/traktor/dj-software/traktor-pro-2/specifications/

各オペレーションシステムでの互換性を確認するには http://www.native-instruments.com/compatibility を参
照してください。

TRAKTOR KONTROL S2 の世界へようこそ!
動作環境
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2 TRAKTOR KONTROL S2 の主な内容
 

この章では TRAKTOR KONTROL S2 のメインエリアを、TRAKTOR KONTROL S2 ハードウェアコントロ
ーラーと TRAKTOR PRO ソフトウェアの両方で紹介します。

まず初めに、TRAKTOR PRO ソフトウェアには 4 つのバーチャルデッキがあり、各デッキは Track
Deck モード、 Remix Deck モード、Live Input モードで使い分けることができる非常に柔軟なシス
テムとなっています。 TRAKTOR KONTROL S2 コントローラーを用いることでソフトウェアの上
段デッキは常に Track Decks となり、下段のデッキは Remix Decks として機能します。 セットア
ップガイドを使って S2 コントローラーと TRAKTOR ソフトウェアのこの基本設定を行ってくださ
い。 この設定が初期設定であることを念頭に入れておくと良いでしょう。

まずはこの数ページを読んでいただいて、TRAKTOR KONTROL S2 の放つ強力な印象に触れ、慣れ
親しんでください。TRAKTOR での音楽のインポート方法を熟知している方は、この章を読んだ後、
↑3, 音楽ライブラリの準備 はスキップして ↑4, チュートリアル 章にそのまま進んでください。

TRAKTOR KONTROL S2 の主な内容

 

TRAKTOR KONTROL S2 - オペレーション マニュアル - 16



ハードウェアコントローラーとソフトウェア

(1) Decks: TRAKTOR KONTROL S2 には 2 台のデッキがあります。 各デッキでトラック、またはサンプ
ルをコントロールします。 各デッキはターンテーブルや CD デッキとして考えることができますが、強力な
追加機能と接続されたコンピュータによる柔軟性を兼ね備えています。 S2 の左デッキでソフトウェアの
Track Deck A をコントロールします。 S2 の右デッキでソフトウェアの Track Deck B をコントロールし
ます。 コントローラーの CUE/REMIX SLOTS セクションで TRAKTOR の Remix Decks C と D をコン
トロールします。 サンプルのコントロールを行うには CUE/REMIX SLOTS セクションを Remix Deck モ

TRAKTOR KONTROL S2 の主な内容
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ード (Cue モードでは、これらのボタンで Track Deck A と B のキューポイントをコントロールします) に
切り替えておく必要があります。 各モードについては、セクション↑7.5, CUE/REMIX SLOTS セクション
の使用を参照してください。
(2) FX ユニット: デッキからのシグナルはハードウェア/ソフトウェアインターフェイスの上部にある 2 基
の FX ユニットで加工することも可能です。FX ユニットから TRAKTOR 内の高品質 FX の全コレクション
にアクセス可能で、S2 の左 FX ユニットでソフトウェア内の左 FX ユニットをコントロールし、TRAKTOR
の Track Deck A の音声をエフェクト加工します。S2 の右 FX ユニットでソフトウェアの右 FX ユニット
をコントロールし、TRAKTOR の Track Deck B の音声をエフェクト加工します。

各 FX ユニットで Decks A-D の音声をアサインすることが可能ですが、ここでは簡単な内容の解説
に留まります。

追加 FX ユニットをソフトウェアから起動することも可能で、これによって TRAKTOR の Remix
Decks C と D の音声を加工することが可能となり、また任意のデッキにそのユニットを使用するこ
とも可能です。TRAKTOR のバーチャルデッキとエフェクトルーティング構造が非常に柔軟に様々な
状況に対応します。詳細は TRAKTOR 2 マニュアルを参照してください。

(3) Mixer: ミキサーは TRAKTOR KONTROL S2 コントローラーの中央部にあり、この Mixer で
TRAKTOR ソフトウェアの Decks A-D の音声を制御します。各 Track Deck A と B には専用チャンネル
があり、Remix Decks C と D に対しては統合チャンネルを使用するので、合計 3 つのチャンネルを含んだ
ミキサーを使用することになります。 一般的に DJ ミキサーの使用目的は、各チャンネルの音量の調整、チ
ャンネルの各周波数帯の調節、音声の FX ユニットへの送信で、これらの調整の後、音声全体をミキサーセク
ションの最上部にある Main セクションへと送ります。 これによってミックスがオーディエンスへと届き
ます。

詳細に関しては ↑6, ハードウェア 概観 章を参照し、そのまま TRAKTOR KONTROL S2 コントロ
ーラー上のコントロール部の詳細解説部へと読み進めるのがよいでしょう。TRAKTOR ソフトウェア
の各機能に関する詳細は、インストールディスク内の TRAKTOR 2 マニュアルを参照してください。

TRAKTOR KONTROL S2 の主な内容
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3 音楽ライブラリの準備
 

殆どの場合、音楽コレクションは既にご自身のコンピュータ内に保管してあることでしょう。トラックのミッ
クスをすぐに始めたい方は、この章を参考にしてください。ここでは TRAKTOR の強力なトラックコレクシ
ョン (Track Collection ) に曲をインポートする方法を解説します。
TRAKTOR KONTROL S2 の操作方法をすぐにでも習得したい方は、この章を飛ばして ↑4, チュートリア
ル 章に進み、デモトラックを使用して TRAKTOR KONTROL S2 を操作する方法を体得してください。こ
ちらの章は後で読んでいただければ問題ありません。

3.1 トラックコレクション (Track Collection) とは?
 

トラックコレクション (またはコレクション) では TRAKTOR データベース内のトラックを全て表示しま
す。
コンピュータ上の音楽ファイル を元に、トラックコレクションではそれらのファイルをリスト表示します。
コレクションでのトラックの管理、タグ付け、ミックス内での使用のための準備は非常に簡単に行うことがで
きます。
特筆すべき点として、トラックコレクションはハードディスク内のファイル構造とは関係なく機能し、ファイ
ル構造を変更することがない点が挙げられます (TRAKTOR 内でファイルを削除した場合は除く)。

トラックコレクションとは
▪ 音楽ファイルの多様な情報を管理するデータベースとして機能します。
▪ 音楽ファイルを表示、検索する手段としてタイトル、アーティスト名、BPM、ジャンル、長さ等の特徴

(タグ)を使用します。
▪ TRAKTOR 専用情報としてトラックを保管する場所です。
▪ 情報としてトラックを扱う為のプレイリスト機能を備えています。

トラックコレクションではできないこと
▪ トラックの移動、コピー、ファイル形式を変換して隠しファイル内に保管すること。
▪ ハードディスク内のファイルの構造内の階層位置を変更すること。

トラックコレクションを使用するには、音楽ファイルをインポートする必要があります。

3.2 音楽フォルダのインポート
 

TRAKTOR はハードドライブ内にあるトラック群を簡単にインポートする機能を備えています。

音楽ライブラリの準備
トラックコレクション (Track Collection) とは?
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► ブラウザツリー内の Track Collection エントリを右クリック (Windows) または [Ctrl]+クリッ
ク (Mac OS X) し、メニューで Import Music Folders を選択します。

トラックコレクション用メニューで Import Music Folders エントリを選択する

デフォルトでは使用しているシステム内の My Music フォルダにある全ての音楽ファイルをインポートし
ます。
シンク、またはオートループ機能等を使用して DJ プレイを行う前には、分析作業を事前に行っておいてくだ
さい。TRAKTOR が音楽の特徴 (BPM 等) を分析します。 分析はブラウザで選択したトラックを右クリッ
クし、メニューから Analyze (Async) を選択します。 もう一つの簡単なトラックの分析方法は Track Deck
にトラックをドラッグする方法です。TRAKTOR の下の青いバーがトラックの分析状況を表示します。
もし他のフォルダ、または外部ハードディスクに音楽ファイルがある場合は、TRAKTOR 音楽フォルダにそ
れらのフォルダも以下のように追加します。
1. Preferences > File Management と進みます。
2. Music Folders セクションの下部にある Add… をクリックします。
3. 追加するフォルダを選択します。
4. OK をクリックします。
この作業を繰り返し、全ての音楽フォルダを追加します。
サブフォルダも自動的にスキャンされます。よってこのリストにサブフォルダを手動追加する必要はありま
せん。

音楽ライブラリの準備
音楽フォルダのインポート

 

TRAKTOR KONTROL S2 - オペレーション マニュアル - 20



3.3 iTunes によるトラック管理
 

iTunes で音楽コレクションを管理している場合、TRAKTOR 2 は iTunes ライブラリと iTunes プレイリス
トに直接アクセスします。

3.3.1 iTunes にある曲の再生
 

TRAKTOR KONTROL S2 から直接 iTunes ライブラリとプレイリストをブラウズすることが可能です。ち
なみに、この操作はハードウェアコントローラーを用いたトラックのブラウズ、ロード操作を覚える為の絶好
の機会となります。この操作を行うには以下のコントロール部を使用します。
▪ SHIFT ボタン

▪ BROWSE エンコーダー

▪ BROWSE エンコーダーの下にある LOAD ボタン A/B

トラックの閲覧とデッキへの追加方法は以下です。
1. SHIFT を押したまま BROWSE エンコーダーを回して iTunes を選択します。 SHIFT ボタンを押し

たまま、BROWSE を押して iTunes の内容を展開します。
2. 同じようにプレイリスト内を移動します。
3. ブラウザツリーで希望するプレイリストを選択したら、SHIFT ボタンを放します。
4. BROWSE エンコーダーを回して先ほど選択した iTunes のプレイリストを閲覧し、トラックを選択し

ます。
5. BROWSE エンコーダーの下の、LOAD ボタン A を押して選択したトラックを左デッキに (TRAKTOR

のデッキ A です) にロードします。

音楽ライブラリの準備
iTunes によるトラック管理
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6. 4-5 の作業を繰り返し、LOAD ボタン B を押してトラックを右デッキに (TRAKTOR の Track Deck
B をコントロールします) ロードします。

iTunes ツリーノード (Tree Node) では iTunes ライブラリとプレイリストの表示機能のみを含んでいま
す。この表示画面では編集機能は使用できません。

ソフトウエアでの同様の操作方法
もちろん以上の作業を TRAKTOR ソフトウェアユーザーインターフェイスで行うことも可能です。
1. ブラウザツリーで iTunes アイコンをクリックしてノードを開きます。
2. iTunes で使用する時と同じように、ライブラリとプレイリストをブラウズします。
3. 通常の TRAKTOR プレイリストでの操作と同じように、デッキにトラックをロードします(例、デッキ

にトラックをドラッグする)。

3.3.2 iTunes から曲を複数選択してインポートする
 

iTunes ライブラリから複数のトラックを TRAKTOR ユーザーインターフェイスを介してトラックコレクシ
ョンにインポートすることも可能です。
1. ブラウザツリーで iTunes アイコンをクリックしてノードを開きます。
2. トラックコレクション (Track Collection) にインポートする曲を選択します。
3. ブラウザツリーの Track Collection アイコンに選択した複数のトラックをドラッグします。
4. または選択したトラック上で右クリック (Windows) 、 または [Ctrl]-クリック (Mac OS X) してメニ

ューから Import to Collection を選択することも可能です。

3.3.3 iTunes プレイリストのインポート
 

TRAKTOR ユーザーインターフェイスを介し、iTunes プレイリストを直接 TRAKTOR プレイリストとして
インポートすることも可能です。
1. ブラウザツリーで iTunes アイコンをクリックしてノードを開きます。
2. インポートするプレイリストを選択します。
3. Playlists アイコンにプレイリストをドラッグします。

► またはプレイリスト上で右クリック (Windows) または [Ctrl]-クリック (Mac OS X) してメ
ニューから Import to Playlists を選択することも可能です。

音楽ライブラリの準備
iTunes によるトラック管理
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4 チュートリアル
 

この 章では TRAKTOR KONTROL S2 を使用する際に頻出する使用方法について解説します。
チュートリアルは実際に作業を行いながら進めます。 単純な操作から紹介し、徐々に複雑な内容へと解説を
進めることで、TRAKTOR KONTROL S2 システムに慣れ親しんでいただきます。 この内容を把握した後
は、TRAKTOR KONTROL S2 を使用してミックスが行える様になっている事でしょう。
ここから紹介するチュートリアルでは TRAKTOR KONTROL S2  インストールの際にハードディスクにコ
ピーされたデモトラックを使用します。ですからトラックコレクションに曲をインポートしていない状態で
も以下のチュートリアル内容を進めることが可能です。コレクションに曲をインポートする方法に関しては
上記の↑3, 音楽ライブラリの準備章を参照してください。

コントローラーの左デッキは TRAKTOR の Track Deck A 右デッキは TRAKTOR の Track Deck
B に対応します。

4.1 最初のトラックを再生する
 

このチュートリアルではまず、トラックのロード方法と、再生方法について解説し、さらにオーディオアウト
プットのチェック方法と、再生音声が確認できない場合の対処方法について解説していきます。

必要条件
ここでは TRAKTOR KONTROL S2 システムが起動し、使用可能な状態となっていることを前提とします。
この条件を満たしていない場合は、別途のセットアップガイドを参照しそこでの必要事項を終えてからここに
戻ってください。
このチュートリアルを始める前に TRAKTOR のセッテイングを変更した場合は、以下の手順に従って
TRAKTOR KONTROL S4 システムを初期設定の状態に戻しておくことを強く推奨します。
1. TRAKTOR ソフトウェアのスクリーンの最上部 (Mac OS X)、またはウインドウの最上部 (Windows)

にあるメニューバーで Help メニューをクリックし、Help > Start Setup Wizard と選択します。
2. 表示されるウインドウで、Next をクリックして S2 が接続してあることを確認します。
3. 次のウインドウで TRAKTOR 使用時に外部ミキサーを使用するか設定します。TRAKTOR 使用時に

コントローラーのミキサーを使用する場合は Yes を選択します。
4. 次のウインドウで TRAKTOR で使用する Deck Flavors を選択します。ドロップダウンメニューで 2

Track Decks + 2 Remix Decks を選択し、Next をクリックします。
5. この内容を適用する為に、 Finish (終了) をクリックしてセットアップウィザードを終了します。

チュートリアル
最初のトラックを再生する
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→ ここまでの設定で、TRAKTOR を S2 コントローラーで制御することが可能となります。
更に外部ミキサーを使用する際、TRAKTOR ソフトウェア上のミキサーは表示されなくなります。しかし S2
の操作によって変化するソフトウェアミキサーの状態を確認したい場合もあります。その場合はレイアウト
セクションのドロップダウンメニューで TRAKTOR インターフェイスの見た目を以下のように変更します。

► TRAKTOR のヘッダの虫眼鏡アイコンの隣にあるドロップダウンメニューをクリックし、リ
ストで Mixer を選択します。

→ これでユーザーインターフェイスの中央部に TRAKTOR のミキサーが表示されます。

4.1.1 トラックのクイックロード
 

デモトラックから 「Techno 1」をデッキ A にロードします。トラックを選択してロードするには、S2 上で
これらのコントロール部を使用します。
▪ 2 つの SHIFT ボタン (各デッキの下にあります)のどちらか

▪ BROWSE エンコーダー (ミキサーの中央部):

▪ 左デッキの LOAD ボタン (BROWSE エンコーダーの下の ｢A｣ とある部分です):

チュートリアル
最初のトラックを再生する
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TRAKTOR ソフトウェアウインドウで以下を行います。
1. SHIFT を押したまま BROWSE エンコーダーを使用してブラウザツリーからプレイリストを選択しま

す。 SHIFT を押したまま BROWSE エンコーダーボタンを押してそのフォルダを開きます。
2. SHIFT を押したまま BROWSE エンコーダーを使用して Demo Tracks プレイリストを選択します。

Demo Tracks のプレイリストが表示されます (Demo Tracks プレイリストが見つからない場合は、
ブラウザツリーの Explorer から開いてください)。

3. SHIFT を放して BROWSE エンコーダを使用し、 プレイリストの Techno 1 を選択します。
4. トラックがハイライト表示されたら、コントローラーの LOAD ボタン A を押してトラックデッキ A に

トラックをロードします。(トラックを Track Deck B にロードする場合は、コントローラーの LOAD
ボタン B を押します)。

チュートリアル
最初のトラックを再生する
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→ トラックがロードされました。 TRAKTOR で、トラックの波形 と情報がデッキ A に表示さ
れます。

S2 を使用してトラックをロードするには、TRAKTOR のデッキにブラウザ、またはコンピュータの
フォルダから直接トラックをドラッグアンドドロップすることも可能です。

4.1.2 トラックの再生
 

► トラックをロードしたら、左デッキの PLAY ボタンを押します。

→ トラックが再生開始します。 PLAY ボタンが光り、TRAKTOR の波形が動き出します。

右デッキの PLAY ボタンを押すと、Track Deck B のトラックの再生を開始します。

各デッキごとのチャンネル
各デッキで再生しているオーディオはミキサー上の各チャンネルで更にコントロール可能です。デッキ A に
トラックをロードしているので、サウンドはチャンネル A (左ミキサーチャンネル) でコントロールします。
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チャンネル A

この時点でスピーカーまたは PA から音声が確認できるはずです。そうでない場合は、以下のセクションを
確認してください。

4.1.3 トラック音声が聞こえない場合
 

デッキで トラックが再生されているのに再生音量が低すぎる場合、または無音の場合は、以下のことを確認
してください。

► S2 の下部で、クロスフェーダーを一番左にしてください。
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► 上にあるチャンネル A のチャンネルフェーダーを一番上まであげて下さい。

► Channel A のレベルメーターが反応します。 反応していない場合は、左チャンネルの HI、
MID、LOW と FILTER ノブが中央に調節してあるか確認し、チャンネルの上部にある GAIN/
FILTER エンコーダーを押してチャンネルインプットのゲインを 0 dB にします。

► ミキサーの中央上部の MAIN LEVEL ノブが最低でも 12 時の方向よりも右に調節してある
か確認してください。

ソフトウェアのヘッダの TRAKTOR の MAIN レベルメーター、または S2 の MAIN LEVEL メーターが反応
しているのに音声を確認できない場合は、S2 のメインアウトプットから PA 間での接続を順に確認してくだ
さい。
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4.2 曲のミックス
 

ここまでで TRAKTOR KONTROL S2 (↑4.1, 最初のトラックを再生する参照)を操作して素早くトラック
をロードし、トラックの再生ができるようになったはずなので、次に曲をミックスしてみましょう。 ここか
らは、デジタル DJ が知っておくべきミックスの基本的操作を解説します。トラックの試聴、トラックの同
期、ベストな位置からのトラックの再生、クロスフェーダーを使用したトラックのミックス方法について解説
します。

必要条件
ここからの解説は、前述したチュートリアルの内容を把握しているものとします(↑4.1, 最初のトラックを再
生する参照)。TRAKTOR KONTROL S2 は以下の状態となっています。
▪ トラック「Techno 1」はデッキ A にロードしてあります。トラックは再生しており、音声も確認できる

状態です。
▪ クロスフェーダーの位置は左いっぱいとなっています。

4.2.1 ミックスするトラックのロードと再生
 

ここではミックスする次のトラックとして「Techno 2」 を選択して、前述したデッキ A での手順と同様に
デッキ B にロードします。
1. Demo Tracks プレイリストで Techno 2 を選択します。
2. LOAD ボタン B を押し、デッキ B にトラックをロードします。

TRAKTOR ウインドウでは、デッキ B にトラック情報と波形が表示されます。
3. コントローラーの右デッキの PLAY ボタンを押し、再生を開始します。

→ トラックが再生開始します。 PLAY ボタンが点灯し、TRAKTOR のデッキ B の波形が動き出
します。

この時点では S2 のクロスフェーダーが左いっぱいの状態なので、デッキ B のトラックはまだスピーカーか
ら確認することはできません。—それではゆっくりとデッキ B のトラックをミックスしてみましょう。
先に進む前に、S2 のフロントパネルにある CUE MIX ノブを真ん中にしてください。
ゆっくりと右方向にクロスフェーダーを動かすことで、デッキ B のトラックが徐々に聞こえ始め、クロスフ
ェーダーを更に右に動かすことでデッキ A のトラックが徐々にフェードアウトしていきます。ここまででは
まだ満足いくミックスになっていないのは明らかです。次のトラックをミックスする前に、デッキ B のトラ
ックをデッキ A のトラックにビートマッチさせる操作が必要です。もう一度、クロスフェーダーを左いっぱ
いに動かしてください。
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クロスフェーダーを右いっぱいに動かしてもデッキ B の音声が確認できない場合は、上記のトラブルシュー
ティング ↑4.1.3, トラック音声が聞こえない場合 を参照してください。

4.2.2 ヘッドフォンを使用してミックスを正確に行う (ビートマッチン
グ)。

 

ここからは次のトラック (ここではトラック B) のミックス をヘッドフォン内で準備できるように慣れる必
要があります。

CUE ボタン

► S2 で、 チャンネル B の CUE ボタン (フェーダーの上にあります) を押します。

→ ボタンが光り、デッキ B が現在 Cue チャンネルに送信されていることを表示し、この音声を
ヘッドフォンで確認することができます。

常時 S2 のフロントパネルにあるこの CUE MIX ノブを使用してヘッドフォン内でキュートラック (デッキ
B) とメインミックス (デッキ A) のバランスを調整することが可能です。キュートラックを重点的に試聴す
る場合はノブを反時計回りに回し、メインミックスを聞く場合は、時計回りに回します。
ここまでで、観客にメインミックスを聞かせたままデッキ B の曲を試聴することができるようになります。
ヘッドフォンで聞いているミックスとは関係なく、メインミックスはクロスフェーダーとチャンネルフェーダ
ーでコントロール可能です。

4.2.3 トラック同士の同期
 

デッキ B で再生しているトラックをミックスする前に、 TRAKTOR の自動シンク機能を使用してデッキ A
のテンポにあわせます。 この作業は SYNC ボタンを押すだけで行うことができます。

SYNC ボタンです。

► 右デッキの SYNC ボタンを押すとデッキ A のテンポに同期します。
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→ SYNC ボタンが点灯します。これは 2 つのトラックが完全に同期したことを意味します。
フロントパネルの CUE MIX ノブをゆっくり回すことで、デッキ A に同期した状態のミックストラック (デ
ッキ B) をミックス内で確認することができます。
トラックのテンポ調整中の音声は観客に聞かれることがないように注意してください。

4.2.4 スタートポイントとしてキューポイントをセットする
 

トラックをミックスするポイントを正確に指定したい場合もあることでしょう。例えば殆どの場合、テンポだ
けでなく、トラックのダウンビートもマッチさせる必要があるでしょう。トラックの特定の位置を使用するこ
とを(ミックスやトリガー等) 「キューイング」といいます。
TRAKTOR KONTROL S2 ではこのキューの為のポイントをマークすることができ、それらをキューポイン
トと呼びます。 この機能でこれらのポイントを何度でも同じパフォーマンスで、または次の回のパフォーマ
ンスでも使用することが可能となります。

4 つの使用していない状態の CUE/REMIXSLOTS ボタンです。

► 右デッキで、トラックの再生状態に関わらず、点灯していない CUE/REMIXSLOTS ボタンを
ダウンビート上で押します。仮にこれを CUE/REMIXSLOTS ボタン 1 とします。

→ ボタンが青く点灯します。これはキューポイントを設置したことを意味し、同じボタンを押す
ことでこのポイントに戻ることができます。

キューポイントのビートへのスナップ
TRAKTOR の Snap 機能を使用すれば、ビートにあわせてキューポイントを正確に配置することにそれほど
気を使う必要はありません。Snap モードをオンにすると、トラック内に設置したキューポイントはそこから
一番近いビートに移動しするので、これによりこのポイントに直接何度でも戻ることができるようになりま
す。Snap モードを起動するには、TRAKTOR のミキサーの MAIN ノブの下にある S ボタンを押します。
(ミキサーを表示していない場合は、ユーザーインターフェイスの左上にあるドロップダウンメニューでミキ
サーレイアウトを選択します。このメニューは虫眼鏡シンボルの左にあります)。
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TRAKTOR のマスターパネルにあるスナップモードインジケーターボタン（S）です。

トラック同士を揃える
両方のトラックを揃える作業は非常に簡単です。
1. デッキ B は再生させておいてください (PLAY ボタンが点灯した状態)。
2. 他のトラックのダウンビートを確認しながら先ほどダウンビートを配置した CUE/REMIXSLOTS ボタ

ンを押します。

→ デッキ B の再生位置が保存したキューポイントに移動し、(TRAKTOR ウインドウを確認して
ください) 再生がそこから始まります。両方のトラックが完全に揃ったので、これでミックス
が可能な状態となります。

ビートスティック
ここでも、ボタンを押すタイミングに細心の注意を注ぐ 必要はありません。デフォルトで TRAKTOR は両方
のトラックのビートをマッチさせるので、突然の曲間移動でもビートマッチの状態を崩すことはありませ
ん。 これは Quantize モードによるもので、マスターパネルの QUANT ボタン (Q) が点灯しているかで起動
を確認することができます(以下図参照)。
Quantize モードをオンにすることで、トラック中を移動しても(例、CUE/REMIXSLOTS ボタンを押すこと
による曲間移動)ビートマッチした状態となり、現在保たれている同期の状態を崩すことはありません。

Snap モードインジケーターと Quantize モードインジケーターは両方とも TRAKTOR のマスターディスプレイにあります。

4.2.5 備考－左トラックが終わってしまった場合
 

デッキ A の「Techno 1」はチュートリアルを開始してからずっと再生しているので、トラックが終わりそ
うになっている可能性もあるでしょう。そういった場合、以下の手順を行ってください。
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► 左デッキで、SHIFT + CUE を押してトラックの最初にスキップします。
ではチュートリアルに戻ります。

4.2.6 チャンネル EQ とフィルターを使用してトラックをミックスする。
 

では TRAKTOR KONTROL S2 の EQ とフィルターを使用してみましょう。

EQ と FILTER ノブです。

► チャンネル B の EQ ノブを回してキュートラックの音声を確認してください。
EQ は違和感無くトラックをミックスするのに最適なツールです。最も一般的なテクニックはミックスする
トラックのベースラインをフィルターしておくことです。

ここからが本格的なミックス作業となります。まず CUE MIX ノブを右いっぱいに回してヘッドフォ
ンでメインミックスを確認します (またはヘッドフォンをはずしてスピーカーからメインミックスを
確認します)。

トラックのミックス方法例は以下です。
1. クロスフェーダーが右側にある状態で、チャンネル B の LOW ノブを下げ、デッキ B のトラックから

ベース成分がほぼない状態にしておきます。
2. クロスフェーダーを徐々に中央に向かって動かし、チャンネル B の音声を徐々にミックスします。
3. 両方のトラックが同時になっており、ベースを元の状態に戻すには、チャンネル A のベースを下げつ

つ、チャンネル B のベースを徐々に上げます。
4. クロスフェーダーを徐々に完全に右に持っていくことでトラックミックスが完了します。
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→ これが TRAKTOR KONTROL S2 を使ったあなたの最初のミックスです!

4.2.7 全てを手で行う
 

TRAKTOR のシンク、キュー機能を使うことなく、マニュアル操作でミックスを行うことも可能です。
本製品を使用する際、全ての DJ 操作をマニュアルで行うことはないでしょう。しかし、マニュアル操作に慣
れ親しんでおくことは大切です。
▪ マニュアル操作を知っておけば、レコードによる DJ 時のビートマッチ、または自分の前の DJ と交代す

るときに便利でしょう。
▪ マニュアル操作と、TRAKTOR の先進的な機能を使用して、あなたのミックススタイルを築いてくださ

い。
マニュアル操作を行う前にまず、デッキ A に新しい曲を追加し、先ほどミックスしたばかりのデッキ B のト
ラックにミックスします。
ここからは デッキ B の音声がスピーカーから出力している音声です。ですので、ソフトウェア上でデッキ
A  をコントロールするコントローラーの左デッキを使用します。

最初のステップ
1. まずクロスフェーダーが右いっぱいとなっているか確認します。
2. Deck B のトラックがまだ再生している間に、Demo Tracks プレイリストから Deck A に House 1

をロードします (BROWSE エンコーダーを使用してリスト内のトラックを選択し、LOAD ボタン A を
押して Deck A にトラックをロードします)。

3. 左デッキの PLAY を押し、新しくロードしたトラックの再生を開始します。
4. 同じデッキで SYNC ボタンがオフの状態になっているか確認します。
5. ミキサーでチャンネル B フェーダーの上の CUE ボタンを起動解除し、チャンネル A を起動してヘッ

ドフォンで新規追加した曲を試聴します ( CUE MIX ノブを任意に調節してください)。

テンポの調節
各デッキのテンポは TEMPO フェーダーで調節します。
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TEMPO フェーダーを使用してデッキのテンポを調節します。

► 曲の雰囲気がマッチするまで BPM を調節する、または 他の曲と BPM が完全に同期するま
で (TRAKTOR の Track Deck B の上部で確認してください)、左デッキの TEMPO フェーダ
ーを調節します。

ジョグホイールによる手動キュー
ジョグホイールを使用して曲をミックスする場所を探すことも可能です。

S2 コントローラーの左ジョグホイールです。

チュートリアル
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1. 左デッキで、ジョグホイールを押して回すことでキュー出し作業を行います。(デッキの下にある
SHIFT ボタンを押しながらジョグホイールを回すことで、素早くトラック内を移動することも可能で
す)

2. キュー出しする場所が定まったらその位置でホイールを押したままにしておき、他のトラックのダウン
ビートに合わせて手を放します。
デッキ A はその場所から再生を開始します。

ジョグホイールでベストなキューポイントを探す前に、(PLAY ボタンを押すことで) 再生をとめておくこと
もできます。 ポイントが決まったら、ジョグホイールを放し、曲は止まった状態なのでこのポイントを逃す
ことはありません。 他のトラックのダウンビートに合わせて、左デッキの PLAY を押してください。

ビートのアライン
トラック同士に若干のずれがある場合は、ジョグホイールの外側を使用してトラック同士のずれを修正するこ
とも可能です。

► 左デッキで、ジョグホイールの外枠を任意の方向に動かし、一時的にテンポをずらすことで必
要のないトラックのずれを修正します。

→ これでトラック同士が完全に同期します。

ここまでの操作内容は TRAKTOR の Sync 機能を使用している場合でも便利です。TRAKTOR の自
動ビート検知機能が割り出した結果が、例えば超低音の影響で同期の”ノリ”が悪い場合があリ、そうい
った場合は上記の方法で修正を行います。手動でトラックのビートグリッドを修正できなかった場
合、ジョグホイールの外輪を使用して調節することでトラック同士の違和感を解消できます。

新規トラックのミックス
► 準備ができたら、デッキ B の曲からクロスフェーダーを使用してデッキ A の曲をミックスし

てください。

→ これが TRAKTOR KONTROL S2 を使ったあなたの最初のマニュアルミックスです!
手動によるビートマッチを習得するまでには時間がかかります。習得には集中して練習することが必要で、こ
こではその方法について詳しく解説はしません。練習あるのみです。
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4.3 レベルの調整
 

更に先に進む前に、ミックスでは音量調節も重要な要素であることを解説しておく必要があります。ここでは
簡単なヒントを例に出すので、今後の参考にしていただければと思います。
このセクションの敷居が若干高いと感じた場合でも、特にライブ環境でのトラブルを避けるために、時間をか
けて読み進めてここでの内容を把握しておくことを推奨します。

4.3.1 セオリー
 

ミックスでは異なるソースからシグナルを混ぜることになります(そしてそれらの音声を加工する場合もあり
ます)。
基本ルールは、 シグナルのクリッピングを避けつつ、ダイナミックレンジをフル活用することです。これら
を守るべき理由として、以下の二つがあります。
▪ ダイナミックレンジをフル活用することで、ミックス内のノイズレベルを最低限に抑えることができま

す。その結果曲の詳細がよりよい状態で表現されます。
▪ シグナルがクリップしてしまい、音声を上げるほど音が歪むようになることは避けてください。音量が大

きな部分(ビートの場合がほとんどです) がカットされ、ダイナミックレンジが低減し、音声に歪みが生じ
ます。これによりスピーカーにダメージが生じ、当然観客も迷惑することでしょう。(ほぼ間違いなくク
ラブのオーナーやテクニシャンがあなたに文句を言いに来ることでしょう)

以上を理由に音量を最適な状態で保っておくことが重要です。

4.3.2 練習
 

音量調整の為に、S2 にはいくつかの レベルメーターとコントロール部を装備しています。各レベルメーター
にはシグナルレベルを示す青い LED とクリッピングを示すオレンジの LED を備えています。

S2 の LEVEL メーターです。

上記したルールはこれらのメーターで以下のように反映されます。
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► レベル調整の調節の上達には練習が不可欠です。音量が常に青色 LED の上部に留まるように
し、赤 LED には極力到達しないように心がけてください。

レベルをクリッピングさせミックスサウンドをダーティーな音声にすることは推奨しません。そういった音
声を得るには、代わりに TRAKTOR の FX を使用してください。

各チャンネルのレベルチェック
ミキサーの各チャンネルにはフェーダーの横に垂直方向に表示するチャンネルレベルメーターを搭載してい
ます。 このメーターではそのチャンネルのプレフェーダーレベル (チャンネルフェーダーで調節する前の音
声レベル) を表示します。 このレベルを調節するには、チャンネルの上部にある GAIN/FILTER エンコーダ
ーを使用します。

GAIN/FILTER エンコーダーは各チャンネルの上部にあります。

► チャンネルの GAIN/FILTER エンコーダーを調節し、音声が赤 LED に達することによるクリ
ッピングを裂けつつ、音声がなるべく青表示部の上の位置に到達するよう調整します。

チャンネルの EQ と フィルターセッティングもレベルに影響し、同じように設定した FX ユニットも音量に
影響することを念頭において調節してください。 これらの内容を変更する際には、そのつど GAIN/FILTER
エンコーダーも調節してください。
もちろんあなたのトラックの表現力に関して妥協する必要はありません。常に音量を最大にするのではなく、
トラック内で最大になる部分にあわせてゲインを調節しておくとよいでしょう。

チャンネル同士のレベルを合わせる
更に 2 つのチャンネル同士の必要以上の音量差を無くすために曲同士の平均的な音量をそろえる必要があり
ます。

► キューしたチャンネルをミックスする前に、GAIN/FILTER ノブを調節してチャンネルメータ
ーが現在スピーカーから流れている曲のチャンネルメーターと大体同じになるよう調節しま
す。
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TRAKTOR は新規にトラックをロードするたびにトラックレベルを自動的に調節します。この
「Autogain」機能はトラックから検出されたゲイン情報を元に機能します。とはいっても EQ、 フィ
ルター、キュートラックに適用したエフェクトによってはミックスを開始する前に音量をもう一度確
認するのが賢明でしょう。更にトラック中のどこでミックスを開始するかで音量が異なるので、その
部分の音量を他のトラックの音量と揃えることが重要です。

メインレベルの確認
全てのチャンネルから送信される各シグナルはチャンネルフェーダーとクロスフェーダーの位置に関係し、最
終的に一つにまとまります。 このミックスは TRAKTOR のメインアウトプットからメインセクションに送
信されます。 下の S2 の MAIN LEVEL ノブの図を参考にしてください。

S2 の MAIN セクションです。

TRAKTOR PRO 2 のヘッダにある MAIN レベルメーターで MAIN LEVEL ノブで調節する前のミックスレ
ベルを確認することができます。 このレベルを調節するには、TRAKTOR PRO のマスターパネルの MAIN
レベルメーターの真下にある MAIN ノブを使用します（以下参照）。

TRAKTOR の MAIN メーターと MAIN ノブです。

► TRAKTOR のマスターパネルにある MAIN ノブを調節して、MAIN レベルメーターが赤いクリ
ップ表示用 LED に到達しない程度にレベルが青表示 LED の上部を示すように調節します。
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デフォルトでは TRAKTOR のメインアウトプットに リミッターが設置されています。 このリミッターを有
効にすると、MAIN レベルメーターはクリッピングを表示しなくなり、 代わりにリミッターが有効となると、
LED が反応するようになります。 リミッターが音声の 歪みに対応した結果として、削減されたダイナミック
レンジを取り返すことはできなくなります。 ですから、リミッターを使用しているとはいえ、音声のクリッ
プが無いようにしておくことを推奨します。
赤いクリッピング LED が点灯した場合、S2 の MAIN LEVEL を下げてもその音声自体が歪んでしまってい
るので意味はありません。

クリッピングやリミッティングが起きる場合は TRAKTOR の MAIN ノブを下げてください。

MAIN LEVEL メーターが低すぎる場合は、チャンネルフェーダーが低すぎないか確認してください。

4.4 ループ機能 とキュー機能
 

ここまでで、基本的なミックス操作方法について学んだので、ここからは TRAKTOR KONTROL S2 のルー
プ機能について解説します。

必要条件
ここからの解説は、ここまでのチュートリアルの内容を把握しているものとします。TRAKTOR
KONTROL S2 は以下の状態となっています。
▪ トラック「House 1」はデッキ A にロードしてあります。トラックは再生しており、音声も確認できる

状態です。
▪ クロスフェーダーの位置は左いっぱいとなっています。

4.4.1 ループの再生
 

S2 の各デッキには専用ループコントロールを装備しており、ジョグホイールの真下の LOOP セクションに
あります。
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ループセクションは左から、LOOP MOVE エンコーダー、 LOOP IN / LOOP OUT 各ボタン、LOOP SIZE エンコーダーとなっています。

ループを既定のサイズにセットする
ではデッキ A にループを追加しましょう。

LOOP SIZE エンコーダーです。

► 再生中のトラックにループをセットするには、LOOP SIZE エンコーダーを押します。

→ この操作で自動的にループを追加します。
Loop size は TRAKTOR のループセクションの数値に対応します。

Loop Size ディスプレイです。

► ループのサイズを変更するには、先ほど使用した LOOP SIZE エンコーダーを回して任意の数
値に設定します。

ループサイズ設定値はループをセットする前後どちらの時点でも設定することが可能です。この設定
を先にしておくと、次に設定するループがそのサイズにセットされます。

手動でループをセットする
ループのスタートポイントとエンドポイントを手動で設定することも可能です。 設定はループセクションの
LOOP IN と LOOP OUT ボタンを使用して行います。
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LOOP IN と LOOP OUT ボタンです。

1. LOOP IN ボタンを押し、Loop In Point をセットします。
2. LOOP OUT ボタンを押し、Loop Out Point をセットします。

LOOP OUT ボタンを押すと、同時にループが設定されループ再生を開始します。
上記のチュートリアルで Snap モードについては解説済みです(↑4.2.4, スタートポイントとしてキューポイ
ントをセットする参照)。このモードは Loop In と Loop Out Points にも影響するので、この設定で各ルー
プポイントは自動的にビートに設置されます。

もちろん手動で設定したループのサイズを上述した LOOP SIZE エンコーダーで変更することも可能
です。

ループを手動で設定する際、TRAKTOR のループセクションで表示される Loop Size が実際のループサイズ
と合わない場合があります。

ループの移動
使用しているループをループセクションの左にある LOOP MOVE エンコーダーを用いて素早く移動させる
ことも可能です。

LOOP MOVE エンコーダー

► ループを移動するには、LOOP MOVE エンコーダーを回します。
移動範囲も TRAKTOR のループセクションで表示しているループサイズに対応します。

ループを起動していない状態で LOOP MOVE エンコーダーを回すと、同じループサイズで前後に移
動することができます。 詳細は↑7.3.2, テンポリセットを参照してください。
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ループの保存
上記のチュートリアルで キューポイントの保存方法について解説しました。 保存方法はシンプルで、点灯し
ていない CUE/REMIX SLOTS ボタンを押すのみです。

点灯していない CUE/REMIX SLOTS ボタンです。

ループの保存方法もほぼ同様です。

► ループを保存するには、点灯していない CUE/REMIX SLOTS ボタンを押します。

→ CUE/REMIX SLOTS ボタンが緑色に点灯します。これはループをこのボタンに設置したこ
とを意味し、同じホットキューボタンを押すことでこのポイントに戻ることができます。

同じボタンが緑点灯します。

ループの解除
現在のループを解除する場合は、以下の手順に従ってください。

► ループを解除するには LOOP MOVE または LOOP SIZE エンコーダーを押します。

→ ループが停止し、通常のトラック再生を開始します。

ループが起動していない状態で LOOP MOVE エンコーダーを押すと、ループが起動し、トラック内
の次のループが再生されます。

4.4.2 ホットキューの使用
 

このチュートリアルと上記のチュートリアルで、ホットキューを使用してキューポイントとループを保存する
方法を解説しました。ここではこれらの使用方法について更に掘り下げて解説します。
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設定内容が異なる各 CUE/REMIX SLOTS ボタンです。

既に解説したように、点灯していない CUE/REMIX SLOTS ボタンを押すと、ループが起動していない場合
は、ボタンを押した時点での再生位置にキューポイントを設置します(ホットキューボタンが青く点灯しま
す)。 ループが起動している場合はループを保存します(ボタンが緑に点灯します)。
ソフトウェア上のデッキの波形では、対応する位置にホットキューボタンが示す色と同じ色の線が表示されま
す。更にその線に表示される番号はホットキューボタンの番号と同じなので、正しく区別することができま
す。

キューポイントをホットキュー 2 に、ループをホットキュー 3 に保存した状態の波形ディスプレイです。

間違えた場合、またはあるホットキューをもう必要としない場合は、素早く削除することも可能です。

► ホットキューを削除するには、SHIFT ボタンを押したまま削除対象の CUE/REMIX SLOTS
ボタンを押します。

→ これでボタンの点灯が消えるはずです。

例
ホットキューはブックマークとしての意味合いを持つだけのものではなく、曲の再構成に用いたり、ビートジ
ャグリングに応用することも可能です。
例としてここではホットキュースロットに保存したループをミックスの中に導入する方法を紹介します。こ
こで紹介する内容を、今までの復習として操作内容を確認しながら行ってください。
ここまでのチュートリアルの内容に忠実あれば、デッキ B に 「Techno 2」がロードされたままとなってい
るはずです。ここではデッキ A のトラックがスピーカーから流れており(クロスフェーダーが左いっぱいの
状態)、デッキ B でミックスするトラックを準備しているとします。
1. 次のトラックの再生を開始し、S2 の中央の任意のチャンネルの CUE ボタンを起動することでヘッド

フォンで試聴できる状態にします。
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2. 右デッキのループセクションの各コントロールを操作し、トラックのイントロ周辺で任意のループを設
定します。

3. いいループが見つかったら、点灯していない CUE/REMIX SLOTS ボタンを押して保存し、ループを再
生したままの状態にします。

4. ここまでを設定してから、例えば前述したようにループの低音成分をカットしておいて、ループのミッ
クスを開始します(↑4.2.6, チャンネル EQ とフィルターを使用してトラックをミックスする。参照)。

5. トラックが完全にフェードアウトする直前に、用意しておいたループを解除すればミックスが完了しま
す。

4.5 ミックス内でサンプルを使用する
 

前章で紹介したように、TRAKTOR ソフトウェアでは 4 つのバーチャルデッキを用意しており、各デ
ッキは Track Deck モード、Remix Deck モード、Live Input モードで使用することが可能です。
S2 コントローラーの左右の物理デッキは TRAKTOR ソフトウェアの上部のデッキ A/B をコントロ
ールします。 S2 と共に使用することでこれらのデッキは常に Track Deck モードとなります。 更
に S2 にはソフトウェアのデッキ C/D をコントロールする為の CUE/REMIX SLOTS セクションを
設けています。 S2 と共に使用することでこれらのデッキは常に Remix Deck モードとなります。
セットアップガイドを使って S2 コントローラーと TRAKTOR ソフトウェアの基本設定を行ってく
ださい。

S2 で TRAKTOR の Remix Decks C と D をコントロールするには、CUE/REMIX SLOTS セクションを
Remix Deck モードにする必要があります。 モード切替は REMIX ノブの下の A/B ボタンで行います。

REMIX セクションの A/B ボタンです。

REMIX ノブで両方の Remix Deck の音量をコントロールします。 CUE/REMIX SLOTS セクションを
Remix Deck モードにすると、Track Decks の Cue Points をコントロールする代わりに、Remix Deck C/
D の上部 Sample Slots をボタン 1-4 でコントロールします。
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最初の Sample Slot の上部 Sample Cell にサンプルをロードした状態の Remix Deck C です。

Remix Deck を用いてサンプルをセットに取り入れることはもちろん、サンプルを取り込んで即座にトラッ
クのリミックスを行うことができます。Remix Deck を使ってレイヤー可能な 8 クリップ分のトラックを
操り、新しくトラックを組むことも可能です。では S2 から Remix Decks をコントロールする方法を解説
します。

旧バージョンで TRAKTOR の Sample Decks をしていた場合でも混乱する必要はありません。以前
の Sample Slot 用各機能はそのまま使用することが可能です。

必要条件
ここからの解説は、ここまでのチュートリアルの内容を把握しているものとします。TRAKTOR
KONTROL S2 は以下の状態となっています。
▪ トラック「Techno 2」はデッキ B にロードしてあります。トラックは再生しており、音声も確認できる

状態です。ここからはトラックを再生するデッキを“トラックデッキ” と呼び、Remix Deck と区別しま
す。TRAKTOR 2 では、2 つの上部のデッキ (A と B) がトラックデッキで、下の 2 つのデッキが (C
と D) リミックスデッキとなります。

▪ デッキ A は停止した状態です(そうでない場合は、左デッキの PLAY ボタンを押してください)。
▪ クロスフェーダーの位置は右いっぱいとなっています。

4.5.1 コレクションからサンプルをロードする
 

トラックコレクションから REMIX SLOTS にサンプルを直接ロードできます。
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1. ミキサー中央の REMIX ノブの下の A ボタンを押します。

 
これによりコントローラーの CUE/REMIX SLOTS ボタンを Remix Deck モードに切り替えます。 A
ボタンが点灯し、4 つの CUE/REMIX SLOTS ボタン 1-4 でソフトウェアの Remix Deck C の
Sample Slot をコントロール可能となります。

2. SHIFT を押したまま BROWSE エンコーダーを使用してブラウザツリーから Track Collection フォ
ルダを選択します。 SHIFT を押したまま BROWSE エンコーダーボタンを押してそのフォルダを開き
ます。

3. SHIFT を押したまま BROWSE エンコーダーを使用してブラウザツリーから All Remix Sets フォル
ダを選択します。 SHIFT を押したまま BROWSE エンコーダーボタンを押してそのフォルダを開きま
す。

4. SHIFT を押したまま BROWSE エンコーダーを使用してブラウザツリーから Dirty Trap フォルダを
選択します。

5. SHIFT を放し、BROWSE エンコーダーを回してプレイリストの「C3 Bells #1」を選択します。
6. 左のデッキで SHIFT と CUE/REMIX SLOTS ボタンの一つを押し(ここでは最初のボタンを選択しま

す)、このスロットにサンプルをロードします。

この操作はソフトウェアから行うことも可能です。リストからサンプルを任意のスロットにドラッグ
アンドドロップしてください。

これでサンプルがロードされ、再生可能な状態となりました。
▪ TRAKTOR PRO では Remix Deck C の最初のサンプルスロットの上部サンプルセルにサンプルがロー

ドされた状態となっているはずです。
▪ S2 では対応する CUE/REMIX SLOTS ボタンが薄く点灯し、サンプルがロードされた状態であり、音声

が発音されていない状態を意味します。
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4.5.2 サンプルのトリガー
 

薄く点灯した CUE/REMIX SLOTS ボタンを押すことでサンプルをトリガーすることができます。
1. 薄く光っている CUE/REMIX SLOTS ボタンを押してサンプルをトリガーします。
2. ボタンをもう一度押すと、サンプルスロットをミュートします。ミュート解除するにはもう一度押しま

す。
3. SHIFT + CUE/REMIX SLOTS ボタンを押すとサンプルが停止し、もう一度起動するとサンプルがスタ

ート位置に戻ります。
サンプルはループ再生します。これはサンプルが Loop モードとなっているからで、 サンプルセルの左のル
ープシンボルがこのモードであることを表示します。

Loop モードのサンプル「C3 Bells #1」です。

サンプルの再生モードを One-shot モードに切り替えるには Remix Deck の Advanced Panel を開く必
要があります。デッキ上部の境界線を何回かダブルクリックすることでデッキレイアウトを切り替えて
Advanced Panel を表示します。
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詳細パネル（Advanced Panel）を備えた状態の Remix Deck です。右下で Play Type ボタンにカ

ーソルを当てており、ここで再生モードを One-shot 、または Loop モードに切り替えます。

► サンプルの用途に応じて Advanced Panel (上記スクリーンショット参照) の右下の Play
Type ボタンをクリックしてサンプルを One-shot モードに切り替えます。

One-shot モードではサンプル再生中に関係する CUE/REMIX SLOTS ボタンを押すことで Sample Slot
が停止します。

サンプルの再生を停止した後もう一度 SHIFT + CUE/REMIX SLOTS ボタンを押すとサンプルから
サンプルスロットを削除します。

サンプルが聞こえない場合は、TRAKTOR ソフトウェアのチャンネル C のフェーダーがあがっているか確認
してください。

4.5.3 トラックデッキからのサンプリング
 

ここまでで TRAKTOR のブラウザを使用してリミックスデッキの一つにサンプルをロードする方法につい
て解説しましたが、ここでは便利なパフォーマンス機能を紹介します。
1. デッキ (TRAKTOR のデッキ B) で「Techno 2」をまだ再生してているか確認してください。 再生し

ていない場合は PLAY を押して再生を開始してください。 トラックが終わりかけている場合は、
SHIFT + CUE でトラックの最初に戻ってください。

2. 右デッキで Remix Deck モードを起動するには、 REMIX ノブの下の REMIX Mode ボタン (「B」と
ある部分です) を押します。

3. ↑4.4, ループ機能 とキュー機能で解説するようにループセクションのコントロール部を使用し、デッ
キ B でループを作成してください。

4. 点灯していない CUE/REMIX SLOTS ボタンを押します。ここではボタン 1 を押します。

→ これで Track Deck B で再生しているループを自動的にサンプルし、Remix Deck D の最初
のサンプルスロットの上部サンプルセルにコピーします。
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デッキ B のループを Deck D の最初のサンプルスロットの上部サンプルセルにエクスポートしま

した。

これでループを Remix Deck D で再生することが可能となります。更に Snap モードと SYNC を起動する
ことでループを Track Deck B と完全に同期させることが可能となります。
CUE/REMIX SLOTS ボタンはループモードでは上記と同様の再生コントロールを装備しています (押すこ
とでサンプルのミュート/ミュート解除、SHIFT と共に押すことで停止、もう一度押すとサンプルの頭出し、
SHIFT と共にもう一度押すことでアンロード)。
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上記したように、Sample Play Type を Loop と One-shot モードのどちらかに切り替えることがで
きます (↑4.5.2, サンプルのトリガー参照)。

これでデッキ B に異なるトラックをロードしても、元のトラックのループが Remix Deck D に保存された状
態となり、いつでも再トリガーすることが可能となります。ループを取り出し、様々なタイミングでミックス
に使用することができるので便利です。

CUE/REMIX SLOTS ボタンを押したときにループを再生していなくても、ソースデッキから音声を
取り出しますが、現在再生している位置から抽出することとなります。 ループは自動的に現在設定し
ているループサイズにカットされます (TRAKTOR で表示値を確認してください)。

► デッキ B からいくつかのサンプルを取り出し、上述した各操作に慣れてください (トリガリン
グ、ミュート等)。

4.5.4 サンプルの削除
 

サンプルセルの内容を削除したい場合は SHIFT を押しながら任意の CUE/REMIX SLOTS ボタンを押して
サンプルを停止して、もう一度同じ動作を繰り返してサンプルセルを削除してください。 CUE/REMIX
SLOTS ボタンがオフの状態となります。
次のチュートリアルは TRAKTOR のエフェクトに関する内容です。

Remix Deck の詳細は TRAKTOR 2 マニュアルで確認してください。

4.6 FX の追加
 

ここまででトラックとサンプルをデッキで再生し、ミックスに関する基礎も学んだのでここからはエフェク
ト (TRAKTOR では ”FX” と呼びます) について解説を進めます。
TRAKTOR は強力なエフェクトセクションを装備しています。デフォルトで TRAKTOR には 2 つの異なる
FX ユニットがあり、 これらを各デッキに自由にアサインすることが可能です。これらの FX Units は S2 で
は各デッキの上にあります。
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TRAKTOR の FX ユニットです。

S2 コントローラーの FX ユニットです。

必要条件
ここからの解説は、ここまでのチュートリアルの内容を把握しているものとします。TRAKTOR
KONTROL S2 は以下の状態となっています。
▪ トラック「Techno 2」はデッキ B にロードしてあります。トラックは再生しており、音声も確認できる

状態です。
▪ デッキ A は停止した状態です(そうでない場合は、左デッキの PLAY ボタンを押してください)。
▪ クロスフェーダーの位置は右いっぱいとなっています。

4.6.1 グループモード
 

TRAKTOR FX ユニットは 2 つのモード (Group モードと Single モード) で操作することができます。
Group モードでは一つの FX ユニットで最大 3 種類の TRAKTOR 内蔵エフェクトを使用することができま
す。Single モードでは一つの FX ユニットで 1 種類のエフェクトを使用でき、コントロールノブを用いてそ
のエフェクトのパラメーターを詳細設定することが可能です。
まず Group モードについて解説します。ここでは S2 の左の FX Unit (FX1) に注目します。当然、右の FX
も同様に機能します。

► FX ユニットを Group モードに設定するには、Preferences > Effects > FX Panel Mode と
進み、ドロップダウンメニューから Group を選択します。
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→ TRAKTOR ソフトウェアでは対応する FX Unit の上に 3 つのエフェクトスロットが設置さ
れるはずです (上図参照)。

4.6.2 FX Unit の準備
 

では 3 つの異なるエフェクトを 使用する FX Unit にロードしてみましょう。
1. SHIFT ボタンを押したまま FX On ボタン(FX Unit の左、DRY/WET ノブの下にあります) を押して 3

種のデフォルトエフェクトをロードします。

 
これで ディレイ、リバーブ、フランジャーがロードされました。

2. FX ボタン 1-3 を押して 3 種のエフェクトから起動するエフェクトを選択します。もちろん 3 種のエ
フェクトを同時に使用することもできます。

 
起動した FX ボタンは点灯します。

3. 更なるステップとして、DRY/WET ノブを左いっぱいに回しておき、後にエフェクトを効果的に使う為
に準備しておくのもよいでしょう。

→ FX Unit を用いた音声処理の為の準備はこれで万全です。

チュートリアル
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4.6.3 デッキを FX ユニットにアサインし、FX 処理を施す
 

では FX ユニットをデッキにアサインしましょう。 アサインにはミキサーの各チャンネルの上、GAIN/
FILTER エンコーダーの下の FX アサインボタンを使用します。

各チャンネルの FX アサインボタンです。

ここでは FX Unit 1 をデッキ B にアサインします。
1. チャンネル B にある左 FX アサインボタン(「1」と表示してあります) を押してデッキ B を FX Unit 1

にアサインします。
2. ゆっくりと DRY/WET ノブを右に回して FX 効果を適用します。

→ これでデッキ B の音声が FX Unit 1 によって加工されます。

他のチャンネルを同じ FX Unit にアサインすることも可能です。例えばサンプルをロードしてあるデ
ッキ C または D に FX を適用する場合でも、ソフトウェア上の任意のチャンネルで FX アサインボタ
ン「1」を押せばアサイン完了となります。

4.6.4 FX ユニットのコントロール
 

FX ノブ 1-3 を回すことでこの FX ユニットの各エフェクトをコントロールすることが可能です。

FX ノブ 1-3 です

► FX ノブ 1-3 を任意に回し、得られる音声を確認してください。各 FX は FX1-3 のボタンを
押すことで個別に起動/起動停止することが可能です。

スロット内での FX の交換
各スロットに他の FX をロードすることも可能です。では最初の FX スロットを Gater と交換してみましょ
う。
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1. TRAKTOR の FX Unit 1 の最初のスロットで SHIFT を押したまま FX ボタン 1 を何回か押して
Gater を選択します。

2. 最初の FX が起動していない場合は、FX ボタン 1 を押して起動します (ボタンが点滅している必要が
あります)。

→ Gater が等間隔で音声をカットしているか確認してください。

Gater の効果を正確に確かめるには FX ボタン 2 と 3 を切っておくと良いでしょう。

テンポと同調する FX
ここからは以下の手順に従ってください。

► FX ノブ 1 を様々な位置にし、音声にどのような効果が現れるか確認してください。

→ ゲートエフェクトがテンポと同調していることが確認できるでしょうか?これは一時的にテン
ポを強調する為に効果的なエフェクトです。

右デッキの TEMPO フェーダーを下に動かしトラックを速く再生すると、ゲーターも反応します。

4.6.5 シングルモード (Single Mode)
 

各 FX Unit をシングル(Single) モードに変換することも可能です。各 1 個のパラメーターを備えたマルチ
FX の代わりに、Single モードでは複数のパラメーターを備えた単体の FX を使用することが可能となりま
す。
ここでは S2 の右 FX Unit (FX2) のモードを変えます。
1. 右の FX Unit が Group モードとなっている場合は、Preferences > Effects > FX Panel Mode と

進み、FX2 ドロップダウンメニューで Single を選択し、FX Unit をシングルモードに切り替えます。
2. SHIFT + FX On ボタンを押して FX Unit に単体の FX をロードします。 SHIFT を押したまま FX On

ボタンを押し、好みの FX を選択します。
3. 同じ FX On ボタンを押し(この時 SHIFT を押す必要はありません) 、FX Unit 全部を起動します。 

FX On ボタンが点灯します。
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4. チャンネル B で右の FX Assign ボタン(「2」と表示)を押し、デッキ B にもこの FX Unit をアサイン
します。このチャンネルの左 FX Assign ボタンはオフの状態にしておくことで、追加した FX 効果を
更にはっきりと確認できるでしょう。

FX ノブ 1-3 と FX ボタン 2 と 3 はその FX のパラメーターとして機能します。いつでも FX ボタン 1 を
押すことで変更したパラメーター値をデフォルトの状態にリセットすることができます。

Group モードでは、DRY/WET ノブでエフェクトのドライ/ウェットバランスを調節する為に使用し
ます。

4.6.6 FX UNIT のスナップショットの保存
 

同じ FX 設定を常時使用し、使用するパラメーターの値をデフォルトとして使用したい場合は、以下の手順に
従ってください。
1. FX ノブとボタンを任意の設定にします。
2. ソフトウェア内の FX Unit の左下にあるディスクシンボルをクリックします。
次回エフェクトを起動すると、保存したパラメーターが復元されます。

4.7 同期 (Synchronization)
 

では次に、TRAKTOR の本格的な同期機能について解説します。ここでの内容に慣れてしまえば、これらの
強力なツールを使ってリッチで複雑なミックスを作ることができるようになるでしょう。

4.7.1 イントロダクション
 

ここまでのチュートリアルでも、TRAKTOR の同期機能を既に使用しました(以下がここまでの使用例です)。
▪ 現在流れているトラックにミックスするトラックを同期させる (↑4.2, 曲のミックス参照)。
▪ ループをビートから外れること無くキューポイントに移動させる (↑4.4, ループ機能 とキュー機能参

照)。
▪ トラックからサンプルを抽出しトラックと同期再生させる (↑4.5, ミックス内でサンプルを使用する参

照)。
▪ Gater FX のトラックへの同期 (↑4.6, FX の追加参照)。

これらの同期がなされる為には、TRAKTOR は同期するための指標となるメインテンポを必要とします。当
社では、このテンポをテンポマスター (tempo master) と呼びます。
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テンポマスター
テンポマスターは TRAKTOR の全領域で有効となる同期用参照テンポとなります。使用状況によって
TRAKTOR の内部クロック、トラックデッキ A/B のどちらかがマスターテンポとして機能します。テンポマ
スターは使用状況によって流動的に変化しますが、テンポマスターを同期の為に使用するというルールは変わ
りません。
Track Deck でこの Sync 機能を起動する (SYNC ボタンを押します) と、このデッキのトラックは現在のテ
ンポマスターに同期します。
以下がテンポマスターとして成り立ちます。
▪ テンポと(小節等の)時間的な区切りを供給する TRAKTOR のクロック。
▪ テンポと現在再生しているトラックのビートを供給するトラックデッキ。

ビートグリッド
Track Deck ビートとテンポ情報を供給する参照テンポとして成立するには、ロードしたトラックのビート特
性が特定されている必要があります。ですから、トラックは TRAKTOR で分析し、BPM と ビートの位置情
報を特定する必要があります。この分析結果を当社ではビートグリッド (Beatgrid) と呼びます。各トラッ
クはそれぞれ異なるビートグリッドを含んでいます。

トラックの波形とビートグリッドです(白い縦線がビートグリッドです)。

トラックのビートグリッドはそのトラックデッキがテンポマスターになったときに使用するだけでなく、現在
のテンポマスターに同期する際にも使用します。
チュートリアル内で使用するトラックはあらかじめ分析されているのでテンポマスターとして安心して使用
できる情報(ビートグリッド)を備えています。手持ちの曲に同期機能を効率よく適用するには、まずそれらの
トラックを分析しておく必要があります。詳細は↑3, 音楽ライブラリの準備章を参照してください。ビート
グリッドと、分析、トラックコレクションの詳細に関しては、別途の TRAKTOR 2 マニュアルを参照してく
ださい。

同期できるもの、できないもの
基本的にループモードで再生しているサンプルと、時間が関係する FX は常時自動的に現在のテンポマスター
にシンクします。
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各トラックデッキでは、例えば手動でビートマッチする場合 (↑4.2, 曲のミックス参照)、全くビートマッチ
をしない場合の為に自動シンク機能を無効にしておくことも可能です。

4.7.2 セットアップ例
 

様々なデッキのセットアップを用いてミックスを作成することが可能で、例えばトラックデッキのみの使用、
またはその下の Remix Deck を使用することも可能です。
好みの DJ スタイルと、デッキのセットアップによって、テンポマスターの指定方法も異なってくることでし
ょう。以下ではその使用例を挙げておきます。

自動的に TRAKTOR に決定させる－Auto モード
まず TRAKTOR の クロックに注目しましょう。

► TRAKTOR のウインドウの左上にあるメトロノームアイコンをクリックしてマスタークロッ
クパネルを表示します。

TRAKTOR のマスタークロックパネルです。

このマスタークロックパネルで起動したオートモード用 AUTO ボタンを確認することができます。

Auto モードはデフォルトで起動した状態となっており、ここまでのチュートリアルは、このモードを
起動した状態で行いました。

AUTO を起動すると、TRAKTOR は各トラックデッキの使用状況に応じて自動的にトラックデッキをテンポ
マスターとして設定します。この機能によって使用中にテンポマスターの指定に関して全く気にする必要が
なくなるということです。

トラックデッキ上で全く再生を行っていない場合は、クロックがマスターとなり、これによってスピ
ーカーから流れる FX や、ループの音声テンポが保たれます。

確認する場合は以下の通りです。

チュートリアル
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1. 再生しているデッキを停止します。
TRAKTOR のマスタークロックパネルの MASTER インジケーターが点灯し、クロックが現在のテンポ
マスターであることを示します。

2. デッキ A と B に各トラックをロードします。
3. デッキ A の再生を開始します。これでデッキ A がテンポマスターとなり、TRAKTOR の左デッキディ

スプレイの MASTER ボタンが点灯します。

4. デッキ B を再生し、デッキ A のトラックに (手動、または自動シンク機能を用いて) ビートマッチさせ
ます。

5. デッキ A を停止します。

→ これでデッキ B がテンポマスターとなり、TRAKTOR の左デッキディスプレイの MASTER ボ
タンがオフとなり、右デッキのインジケーターが点灯します。

Auto モードではミックスで新規トラックを使用する度に参照テンポを設定するので単一のテンポに縛られ
ることがなくなります。同時に、FX と他のデッキも同期します。
手動＋自動シンクの組み合わせによる演奏を模索している場合もやはり、ソフトウェアのクロックパネルにあ
る AUTO を起動したままにし、必要であれば S2 にある各デッキ用 SYNC ボタンを使用できる状態にして
おくと便利でしょう。
▪ SYNC を有効にすると、デッキはミックス中一定のテンポを保つようになります。
▪ SYNC をオフにすると、トラックを追加する度にそのトラックのテンポがテンポマスターとなります。

手動で特定のデッキをテンポマスターとして指定することも可能です。

チュートリアル
同期 (Synchronization)

 

TRAKTOR KONTROL S2 - オペレーション マニュアル - 59



► 手動で トラックデッキをテンポマスターに指定するには、そのデッキで SHIFT + SYNC を押
します。

テンポマスターとしてクロックを使用する
ビートシンクしたトラックのみを使用するミックスを行う場合、またはセット中同じ BPM を使用する場合
は TRAKTOR のクロックをマスターテンポとして使用するこのモードの使用が最適です。設定方法は以下
です。
1. TRAKTOR のクロックパネルで AUTO ボタンを無効にします。
2. クロックパネルの MASTER ボタンを起動してクロックをマスターテンポにします。

するとクロックパネルは以下のような状態となります。

 
S2 で両方のデッキで SYNC ボタンを押し、同期機能を起動します。

これで瞬時に全デッキがクロックのテンポと同期します。その後 MASTER ボタンの右にある数値を設定す
ることでクロックのテンポを任意の再生テンポに変更します(上図参照)。

► クロックのテンポを表示する BPM 数値をクリックしたままマウスを上下に動かすことでテ
ンポを変更することも可能です。

→ 各デッキでもテンポが変化します。
いつでも S2 の任意のデッキで SHIFT + SYNC を押すことでそのトラックデッキをテンポマスターにする
ことが可能です。

4.7.3 同期用のその他のツール
 

同期に関連する機能であるその他の機能として、キーロック機能があります。

スナップとクオンタイズ (Snap/Quantize) モード
Snap と Quantize モードについては↑4.2, 曲のミックスのチュートリアル内で既に紹介しました 。
▪ Snap モードはループやキューポイントを確実にトラックのビート上に配置されるように機能します。
▪ Quantize モードはトラック内のどの場所(ループ、キューポイント、ビート)に移動してもビートを維持

するように正確にシンクする為のサポートとなります。
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Both Snap と Quantize モードは TRAKTOR ソフトウェアインターフェイスのミキサー部にある各ボタン
で有効/無効にします。

SNAP (S) と QUANT (Q) ボタンで各 Snap と Quantize モードを起動/起動解除します。

プレイスタイルに合わせて起動/起動解除してください。以下は設定例です。
▪ ループをビートにあわせて再生したい場合は SNAP モードを起動し、LOOP SIZE エンコーダーを任意

設定します。
▪ 逆にキューポイントをビートとは関係ないバッキングボーカルに合わせて設定したい場合は、点灯してい

ない CUE/REMIX SLOTS ボタンを押す前に SNAP モードを解除しておきます。
▪ 同期しているトラックにバックビートに合わせてビートマッチしたトラックをミックスする場合は、

PLAY ボタン (または CUE/REMIX SLOTS ボタンのどれか) を押す前に Quant ボタンを起動しておき
ます。

▪ 逆に Remix Deck にロードしてあるサンプルで思いのままにジャムする場合、または CUE/REMIX
SLOTS ボタンを連続的に押し( Remix Deck モードの場合、CUE/REMIX SLOTS ボタンで TRAKTOR
の Remix Deck C/D をコントロールします)てサンプルを立て続けに連続再生する場合は、QUANT を
解除して細かいビートを刻めるようにしておきます。

▪ 様々な可能性を試してください。

トラックのキーのロック
トラックの同期中にテンポを変えるとそれにあわせてトラックの音程も変化します。テンポの微調整であれ
ば問題ではありません。しかし大きくテンポを変えた場合の音程変化によって、キックに迫力がなくなる、ボ
ーカルが不自然に聞こえる、等の理由で曲の印象が異なってしまう場合があります。
To avoid this, TRAKTOR KONTROL S2 provides you with a Keylock feature that uncouples the
tone from the tempo of a track:
1. デッキ A と B にテンポが大きく異なるトラックをロードしてください。
2. 両方のデッキを再生し、デッキ B をデッキ A に同期してください。

デッキ B のトラックの音程が明らかに変化するはずです。
3. ここで S2 の右デッキの SHIFT + PLAY を押します。 このデッキの KEYLOCK 機能が起動します。
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→ トラックの音程がオリジナルのピッチに戻ることで、トラックがオリジナルの雰囲気に近くな
ります。 In デッキセクションでは KEYLOCK インジケーターが点灯してそのデッキでキー
ロック機能が有効となっていることを表示します。:

DJ スタイルによってシンクの用途が異なる為、シンクセッティングに正解はありません。満足良く結果がで
るセッテイングをいろいろと試してください。

チュートリアル
同期 (Synchronization)
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5 S2 で TRAKTOR DJ を操作する
 

TRAKTOR KONTROL S2 は iOS デバイス用 TRAKTOR DJ アプリ用に設計されています。 このセクショ
ンでは TRAKTOR DJ app に対して S2 を使用する際の主要機能について解説します。 ここで iOS デバイ
スとは iPad、iPhone、iPod touch の事を指します。

iPhone app は TRAKTOR DJ for the iPhone の事を指します。

S2 は現時点で以下の iOS デバイスに対応しています。
▪ iPhone 5c
▪ iPhone 5s
▪ iPhone 4
▪ iPhone 4S
▪ iPhone 5
▪ iPod touch (5 世代)
▪ iPod touch (4 世代)
▪ iPad 2
▪ iPad (3 世代)
▪ iPad (第 4 世代)
▪ iPad mini

iPad (第 4 世代)、iPad Mini、iPhone 5 で S2 を使用するには、Apple 社の Lightning-to-Dock ア
ダプターが必要です。

5.1 TRAKTOR DJ 操作のための S2 の主要機能
 

このセクションでは iOS デバイスで TRAKTOR DJ アプリを使用する際の、S2 によるアプリの主要機能の
操作について解説します。

5.1.1 トラックのブラウズとロード
 

以下のチュートリアルを参照して S2 を用いて TRAKTOR DJ 内の音楽コレクションをブラウズし、トラッ
クをロードする方法を習得してください。
1. BROWSE エンコーダーを押して TRAKTOR DJ 内の音楽ファイルツリーを表示します。
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→ 音楽は Songs、Playlists、Artists、Albums、 Genre の各カテゴリーで分類されています。
1. Songs で BROWSE エンコーダーをもう一度押してソングコレクションに移動します。
2. BROWSE エンコーダーを回してトラックコレクションを閲覧します。
3. LOAD ボタン A または B を押し、トラックをロードします。

→ TRAKTOR DJ の表示がデッキビューモードに切り替わります。S2 デッキの LOAD ボタン
がオレンジに点灯し、トラックがロードされたことを表示します。

1. トラックを再生してください。
2. BROWSE エンコーダーをもう一度押すと(または LOAD ボタンを押すと) TRAKTOR DJ の他の曲の

ブラウズを開始することができます。
3. BROWSE エンコーダーを回して他のトラックをブラウズします。
4. トラックを選択して、BROWSE エンコーダーを押してください。

→ TRAKTOR DJ の Recommended Tracks が表示されます。 app は Key/BPM 情報を元にこの
お勧めリストを生成します。 ツリーの階層を上層に戻すには、S2 の SHIFT ボタンを押しな
がら BROWSE エンコーダーを回します。 各カテゴリーを表示するには (Songs、Playlists、
Artists) SHIFT + BROWSE エンコーダーを押します。

1. 空いている S2 デッキに次のトラックをロードします。

5.1.2 デッキボリュームコントロールとクロスフェーダー
 

S2 で TRAKTOR DJ app をコントロールする場合、制御するデッキはデッキ A & B となります。S2 の A
& B チャンネルフェーダーで、デッキ A/B のボリュームをコントロールします。クロスフェーダーを左一杯
に切り、A のボリュームフェーダーが上がっている場合は、デッキ A の音声のみが聞こえます。クロスフェ
ーダーを右一杯に切り、B のボリュームフェーダーが上がっている場合は、デッキ B の音声のみが聞こえま
す。
S2 のクロスフェーダーを操作すると、TRAKTOR DJ 上のクロスフェーダーも反応して動きます。チャンネ
ルフェーダーも同様に反応します。
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S2 のミキサーセクションと、対応する TRAKTOR DJ イコライザーセクションです。

TRAKTOR DJ のデッキ A は上部に、デッキ B は下部にあります。 iPhone 用 TRAKTOR DJ ではデッキ
ビュースライダーがデッキ A が上に、デッキ B が下にあることを示します。

5.1.3 フィルターの使用
 

S2 の GAIN/FILTER エンコーダーの一次機能として、TRAKTOR DJ の対応するデッキの Filter エフェクト
をコントロールする機能があります。 使用方法は以下です。

► GAIN/FILTER エンコーダーを回します。 右に回すと低域が減衰し、左に回すと高域が減衰し
ます。 GAIN/FILTER エンコーダーを右に回すと TRAKTOR DJ のフィルターも右に動き、
左に回すとその逆となります。

TRAKTOR DJ デッキで Filter 画面を表示する方法は以下となります。

► TRAKTOR DJ デッキの Equalizer 画面で Filter セクションを指で操作することができます。
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TRAKTOR DJ のフィルターです。

5.1.4 チャンネルゲインの調節
 

S2 の GAIN/FILTER エンコーダーの二次機能として、TRAKTOR DJ の対応するデッキのゲインレベルをコ
ントロールする機能があります。ゲインレベルの調節方法は以下です。

► SHIFT を押しながら GAIN/FILTER エンコーダーを回します。 時計回りに回すと、デッキで
再生しているトラックのゲインレベルが上がります。 逆に反時計回りに回すと、再生してい
るトラックのゲインレベルが下がります。

チャンネル A のゲインレベルを調節しています。

SHIFT を押しながら GAIN/FILTER エンコーダーを押すことで、ゲイン値がリセットされます。
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5.1.5 EQ の使用
 

S2 のチャンネル A または B のどちらかの EQ ボタンを押すことで、TRAKTOR DJ の Equalizer セクショ
ンを確認することができます。 S2 を使用して TRAKTOR DJ デッキ用 Equalizer 画面を表示する方法は以
下となります。

► チャンネル A または B にある FX ボタン 2 を押します。

→ 各 TRAKTOR DJ デッキ用 Equalizer ドローワーが表示されます

TRAKTOR DJ の Equalizer 画面です。

チャンネル A の LOW EQ を左に回すと、TRAKTOR DJ の Equalizer が反応します。
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5.1.6 ヘッドフォンキュー
 

CUE VOL ノブは S2 のフロントパネルにあり、ヘッドフォンアウトプット音量を設定します。CUE MIX ノ
ブでメインミックスのみを聞く、キューチャンネルのみを聞く、またはその両方をヘッドフォンで聞くことが
できます。

S2 のフロントパネルにあるヘッドフォンインプットと CUE コントロールです。

ヘッドフォンでのトラックキューは以下のように行います。
1. 各デッキ A と B にトラックをロードします。
2. 両方のデッキで PLAY ボタンをクリックし、再生を開始します。
3. CUE MIX ノブを真ん中に回します。
4. CUE VOL ノブを調節してヘッドフォンのボリュームを快適な状態に設定します。
5. チャンネルフェーダーを上げ、クロスフェーダーを使用して各トラックが再生されるか確認してくださ

い。
6. チャンネル A  にクロスフェーダーを切り、デッキ A のトラックのみが聞こえる状態にします。同時に

チャンネル B のチャンネルボリュームフェーダーを下げきります。
7. CUE ボタン B を押します。

→ ボタンが点灯し、デッキ B がキューチャンネルに送信され、ヘッドフォンで試聴可能な状態
となります。これでキューが機能しているので、クロスフェーダーを動かしてもデッキ B を
聞くことができるようになります。

1. CUE ボタン B をもう一度押してキューを解除し、CUE ボタン A を押します。

→ クロスフェーダーを動かしてもデッキ A のトラックを聞くことができるようになります。こ
れはデッキ A のキューが機能しており、更に CUE MIX ノブが中心に位置しているためです。

1. CUE ボタン A と B を押して両方起動します (点灯します)。
2. CUE MIX ノブを左一杯に回します。
3. ここで 2 つの CUE ボタンをオンオフと切り替えてください。 両方の CUE ボタンがオフ（点灯してい

ない場合）の場合、ヘッドフォンで音声を確認することができなくなります。
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4. では両方のキューボタンをオフの状態にしてください。
5. CUE MIX ノブを右一杯に回します。チャンネルフェーダーが上がっている場合は、ヘッドフォンでメ

インミックスを確認することができます。
チャンネルフェーダーの両方が下がっている場合、ヘッドフォンで音声を確認することはできません。
1. クロスフェーダーを動かし、ヘッドフォンキューでメインミックスを確認してください。
ヘッドフォンで聞いているミックスとは関係なく、メインミックスはクロスフェーダーとチャンネルフェーダ
ーでコントロールすることとなります。

5.1.7 デッキコントロール
 

S2 のジョグホイールです。

S2 のジョグホイールでスクラッチ、キューポイント検索、トラックテンポの手動設定、まき戻し、トラック
のシークや、サーチが行えます。

トラックシーク
TRAKTOR DJ でトラックをシークする方法は以下です。
1. ジョグホイールのトッププレートを押しまわし、トラックをシーク (再生開始に最適な場所を見つける、

等) します。
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2. キュー出しする場所が定まったらその位置でホイールを押したままにしておき、他のトラックのダウン
ビートに合わせて手を放します。
デッキ A はその場所から再生を開始します。

ジョグホイールでベストなキューポイントを探す前に、(PLAY ボタンを押すことで) 再生をとめておくこと
もできます。

► ポイントが決まったら、ジョグホイールを放しても、曲は止まった状態なのでこのポイントを
逃すことはありません。他のトラックのダウンビートに合わせて、左デッキの PLAY を押し
てください。

ストライプナビゲーション
TRAKTOR DJ デッキでトラックを再生しているときに、ストライプナビゲーション（Stripe Navigation)を
行うことができます。 この機能で再生位置を変えることなく視覚的にトラックを確認し、トラックの任意の
位置に移動することができます。 ストライプナビゲーションを起動する方法は以下となります。

► 再生しているデッキで、SHIFT + ジョグホイールを押しまわします。

→ これで視覚的にトラックをナビゲートすることができます。
トラックの任意の位置に移動する方法は以下となります。

► CUE ボタンを押します。
ストライプナビゲーション機能を解除する方法は以下です。

► ループ MOVE エンコーダーを押します。

手動ミックス
S2 を使って TRAKTOR DJ のデッキを通常のターンテーブルと同じように使用することも可能です。
SYNC モードをオフにし、ジョグホイールを操作してテンポを微調整します。 これは手動ビートマッチング
に慣れている DJ のための機能です。
SYNC モードと KEYLOCK をオフにして、Pitch Bend を行うことも可能です。

FLUX モードを起動し、ジョグホイールによるスクラッチと HotCue ボタンの活用によるプレイを探
求してみるのもいいでしょう。
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TEMPO フェーダーの使用
S2 で Track Deck のテンポを手動でコントロールすることで TRAKTOR DJ のトラックテンポをコントロ
ールすることができます。 現在再生しているトラックのテンポを変更することで TRAKTOR DJ のグロー
バルテンポが変更します。 デフォルトではトラックを再生すると TEMPO フェーダーでの設定値で再生さ
れます。 TEMPO フェーダーはデフォルトでテンポを 8% 変更することが可能です。 トラックによっては
この設定値を大きく超えるテンポで変更したい場合もあることでしょう。 そういった場合の設定値の変更方
法は以下となります。
1. トラックの速度を速くするか、遅くするかにより、S2 の TEMPO フェーダーを可動域の最後の位置ま

で移動することで、次の速度段階に設定することができます。
2. SHIFT を押したまま TEMPO フェーダーを中心の位置に戻します。 SHIFT ボタンを放すと、BPM を

更に調節することが可能となります。更に変更する場合は、同じ方法を繰り返します。

TRAKTOR DJ で可能なテンポレンジ変更値は 8%/12%/25%/50% です。

5.2 トランスポートセクションの使用
 

S2 のトランスポートセクションは S2 の両側のジョグホイールの下に設けてあります。 左のトランスポー
トセクションで  TRAKTOR DJ のデッキ A をコントロールし、右セクションでデッキ B をコントロールし
ます。 S2 のトランスポートセクションでコントロールできる内容は以下です。
▪ 再生 (& Keylock) 機能
▪ キュー (& Restart)
▪ HotCues
▪ Loop 機能
▪ Move 機能
▪ デッキ同期 (& BeatGrid モード) 機能
▪ Flux モード機能

このセクションではトランスポートセクションの各ボタンの機能について解説します。また、TRAKTOR DJ
app 使用時の RGB ボタンの反応についても解説します。

5.2.1 PLAY ボタン
 

各 PLAY ボタンを押すことで対応する TRAKTOR DJ デッキを再生します。 トラックが再生中の場合、
PLAY ボタンを押すとデッキを一時停止します。
S2 の PLAY ボタンで再生を開始すると、ボタンが緑に点灯します。
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Keylock
TRAKTOR DJ デッキのキーロック（Keylock）機能は TRAKTOR DJ デッキで SHIFT+ PLAY を押すこと
で起動します。

5.2.2 CUE ボタン
 

S2 の CUE ボタン機能は TRAKTOR DJ では以下のように機能します。 トラック再生時は、CUE ボタンを
押すとその地点にキューマーカーを設置し、トラックを停止します。 再生を続けると保存したキューポイン
ト付近から再生を開始します。

5.2.3 SYNC (MASTER) ボタン
 

S2 の SYNC ボタンでトラックのテンポを、現在 TRAKTOR DJ で再生しているトラック (MASTER) のテ
ンポ (BPM) に自動的に同期します。その時 S2 の SYNC ボタンはオレンジに点灯します。
TRAKTOR DJ 使用時にデッキが半同期の状態になる場合があります。これはデッキの BPM があっていて
も、位相が合っていない場合のことを示します。以下は例です。
▪ 2 トラックを再生中、スクラッチを行い (FLUX ボタンを起動していない状態で) 手を放した場合。
▪ 2 トラックが同期しているが、キューポイントをタイミングを無視して使用した場合、

TRAKTOR DJ デッキが半同期の状態。 TRAKTOR DJ デッキの SYNC シンボルが赤く点灯し、対応する
S2 SYNC ボタンがオレンジに点滅します。
SYNC 機能のリセットは以下の方法で行います。

► S2 の点滅する SYNC ボタンを押します。

→ これでトラックが同期します。S2 の SYNC ボタンの点滅が止み、TRAKTOR DJ の SYNC は
緑に点灯します。

BeatGrid Edit モード
SHIFT + SYNC を押すことで TRAKTOR DJ 対応するデッキで BeatGrid Edit モードが起動します。 この
モード時にはトラックの Beatgrid を手動で以下のように調節できます。
▪ ジョグホイールを回して波形とグリッドの位相を合わせる。
▪ HotCues 1-4 を使用して正確なダウンビートを選択することも可能です。
▪ ループ MOVE エンコーダーでトラックを 4 ビートにあわせることも可能です。
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5.2.4 FLUX ボタン
 

TEMPO フェーダーの上にある FLUX ボタンを押すことでデッキに対して TRAKTOR DJ の Flux Mode を
使用することが可能となります。 Flux モードでトラックのフレーズ感を損なうことなくキューポイント間
やループを移動することができるようになります。

5.2.5 HotCue ボタン
 

HotCue ボタンは S2 のトランスポートセクションの CUE/REMIX SLOTS エリアの一部として設置してあ
ります。 各 CUE/REMIX SLOTS エリアには 4 つのホットキューボタン (1-4) があります。 これらの
RGB バックライトボタンは TRAKTOR のキューボタンの色に対応しています。
▪ 青: キューポイント
▪ 緑: ループ
▪ 黄: ロード
▪ オレンジ: フェードイン/アウト
▪ 白: グリッドマーカー

TRAKTOR DJ は Beat Grid の位置を HotCue ポイントとして保存します。 多くのトラックに白い
ホットキューボタンが設定されるのはこのためです。

TRAKTOR DJ の Loop Slicer 使用時は S2 のホットキューボタン 1-4 でスライスをコントロール
し、モードが起動している間は緑に点灯します。 「ループの使用」セクションを参照してください。

TRAKTOR DJ の Freeze Mode 使用時は S2 のホットキューボタン 1-4 でスライスをコントロー
ルし、モードが起動している間は青に点灯します。 Move エンコーダー/Freeze モードの使用に関す
るセクションを参照してください。

保存したキューポイントやループ等を削除するには、SHIFT ボタンを押しながら削除したい HotCue
ボタンを押します。 するとボタンが消灯します。

HotCue ポイントの設定
S2 を使用して新規 HotCue を作成する方法は以下です。

► バックライトがついていない HotCue ボタンの一つを押します。

→ 選択した HotCue ボタンが青く点灯します。
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5.2.6 ループの使用
 

手動で LOOP IN/OUT ボタンを設定、またはループ SIZE エンコーダーでループサイズを選択、エンコーダ
ーを押して設定することで、S2 上で TRAKTOR DJ のループ機能を使用できます。

ループ SIZE エンコーダーを使用して TRAKTOR DJ のループをトリガーします。

S2 を使用したループの保存
トラックで設置したループが気に入っているなら、S2 で保存することも可能です。

► ループモードを起動し、バックライトがついていない HotCue ボタンを押します。

→ 選択された HotCue ボタンが緑に点灯し、ループがそこに保存されます。

保存したキューポイントやループ等を削除するには、SHIFT ボタンを押しながら削除したい HotCue
ボタンを押します。 するとボタンが消灯します。

Loop Slicer モード
1. 以下のインストラクションで TRAKTOR DJ の Loop Slicer の設置方法を習得してください。
2. 選択したデッキで、ロープ SIZE エンコーダーまたは LOOP IN/OUT ボタンを使用して手動で設定した

ループを用いて、ループを起動します。
3. ループ MOVE エンコーダーを押して TRAKTOR DJ の Loop Slicer モードを連動させます。
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→ これで TRAKTOR DJ は選択したループサイズ値を使ってスライスを作成するようになりま
す。 S2 の 4 つのホットキューボタンは緑に点灯し、Loop Slicer を起動している間はスライ
スをトリガーできます。

1. Loop Slicer 時に各 Hotcue ボタンを使用し、どのような結果を得られるか試してください。
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TRAKTOR DJ の Loop Slicer モードで HotCue ボタン ４をトリガーしています。

Loop Slicer モード時に MOVE エンコーダーを回すことで、ループのスタートポイントを移動するこ
とができます。 左右に動かすことでループのスタートポイントを移動します。 エンコーダーを押し
ながら回すことでループを 1 小節ごと移動させることができます。

Loop Slicer Mode で緑の Hotcue ボタンをトリガーする際に Loop Encoder を回すことでどんな
結果を得られるか試してください。

5.2.7 ループ MOVE エンコーダーの使用
 

ループ MOVE エンコーダーは TRAKTOR DJ 使用時にいくつかの役割を果たします。 エンコーダーのデフ
ォルトモードはトラック内の Beatjump です。 左に回すとトラックの牛をに移動し、右に回すと曲の先に進
みます。

波形ズーム
SHIFT + S4 のループ MOVE エンコーダーの一つを回すことで対応する TRAKTOR DJ デッキの波形を拡
大表示します。 左右に回すことでトラックデッキがズームイン、アウトします。
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Freeze モード
S4 のループ MOVE エンコーダーの一つを押すことで対応する TRAKTOR DJ デッキの Freeze モードが
起動します。 TRAKTOR DJ は Freeze Mode エリアをスライス（Slices）に分割します。 対応する S4 セ
クションの Hotcue ボタン 1-4 は青表示されるようになり、TRAKTOR DJ の Slices 1-4 に対応します。

ループ MOVE エンコーダーを押すことで TRAKTOR DJ の Freeze モードと連動します。

Loop Slicer モードとは違い、Freeze Mode を起動すると Freeze モードセクションにプレイバック
マーカーがあれば再生を続けます。

Freeze モードは再生しているトラックで現在表示しているセクションに対して機能し、各セクションはキュ
ーポイントとしてトリガーすることができます。 Freeze Mode のキューポイントはトラックのセクション
となります。
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Freeze Mode でホットキューボタン ２ をトリガーしています。

Freeze Mode セクションのスケールと各キューセクションは使用している表示スケールによって設定され
ます。 現在表示しているトラックのスケール調節は SHIFT を押しながらループ MOVE エンコーダーを回
すことで行います。 左右に回すことでトラックデッキがズームイン、アウトします。 このレベルでは各キッ
クやハイハット、スネアをトリガーすることが可能となります。
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SHIFT を押しながらループ MOVE エンコーダーを回すことで TRAKTOR DJ の表示スケールを調節します。

Freeze Mode でループ MOVE エンコーダーを回すことでアサインの調整を行うことができます。

► ループ MOVE エンコーダーを回すと、アサインのグループサイズによって Freeze アサイン
が移動します。 ループ MOVE エンコーダーを押しまわすことで１単位のアサインサイズで
アサインが移動します。

5.3 FX の使用
 

このセクションは TRAKTOR DJ のエフェクトの使用方法を解説します。 以下のチュートリアルを参照し
て S2 を用いたエフェクトの使用方法を習得してください。

TRAKTOR DJ にはエフェクト用に 3 つのバンクを設けてあり、それぞれ 8 個のエフェクトを収納し
ています。

5.3.1 デッキのエフェクトディスプレイの表示
 

S2 を使用して TRAKTOR DJ のデッキのエフェクトディスプレイを表示する方法は以下です。

► チャンネルセクション A または B 上部にある FX ボタン 1 を押します。
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→ TRAKTOR DJ のエフェクトディスプレイがデッキに応じて表示されます。 このエフェクト
の上部は 3 つのエフェクトを含んでいます。 それぞれバンクから現在有効なエフェクトを表
示しています。

各エフェクトを TRAKTOR DJ エフェクトバンクから選択するには、TRAKTOR DJ 内で手動で切り
替える必要があります。 各エフェクトセクションを押して、ドロップダウンメニューを表示、8 つの
選択肢から任意のものを選んでください。

TRAKTOR DJ のエフェクトディスプレイセクションです。

5.3.2 S2 の FX セクションの使用
 

S4 には 2 つの FX セクションがあり、それぞれジョグホイールの上にあります。 ここで FX ボタン (1-3)
を押して TRAKTOR DJ のエフェクトを起動します。対応する FX ノブを操作することで各パラメーターを
コントロール (TRAKTOR DJ の X 軸)し、DRY/WET ノブ (TRAKTOR DJ では Y 軸となります) でエフェ
クト量を調節します。

エフェクトのトリガーとコントロール
S2 の FX ボタン (1-3) (FX 1 または FX 2 セクションにあります) のどれかを押すと、対応する
TRAKTOR DJ エフェクトと連動します。 ボタンを押すと、オレンジに点灯します。 TRAKTOR DJ のエフ
ェクト画面では、対応する FX バンクがオレンジに点灯します。
以下のチュートリアルを参照して S2 で TRAKTOR DJ のエフェクトをコントロールする方法を習得してく
ださい。
1. デッキ A にトラックをロードして再生してください。
2. チャンネル A 上部の FX ボタン 1 を押して TRAKTOR DJ のエフェクト画面を表示してください。
3. TRAKTOR DJ で 一番左のバンクで Delay を選択してください。
4. S2 の FX 1 セクション (上部左) で FX ボタン 1 を押してください。

ボタンがオレンジに点灯します。再生しているトラックにもディレイがかかります。
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5. FX ノブ 1 を左右どちらかに回してください。
TRAKTOR DJ を見ると、FX ノブの動きに応じて TRAKTOR DJ の X 軸が動くのが確認できます。
FX ノブを右に動かすと、Delay エフェクト用 X 軸が反応します。

6. エフェクトを起動したまま、DRY/WET ノブを右に動かします。
Delay エフェクト効果が増します。 この動きは TRAKTOR DJ のエフェクト画面の Y 軸に反映され
ます。

7. では FX ノブ 1 を右いっぱいに回します。

 
Delay エフェクト量が増します。エフェクト画面も反応します。
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8. では両方のノブを左に回してください。 エフェクト効果が薄れるのが確認できます。

9. では FX ボタン 2 と 3 を押し、3 つの FX 全部を起動します。
3 つの FX ボタンがオレンジに点灯し、再生しているトラックに TRAKTOR DJ の 3 つのエフェクトが
かかります。

10. DRY/WET ノブを回すことで選択した 3 つ全てのエフェクトを操作でき、TRAKTOR DJ の Y 軸が連
動します。
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6 ハードウェア 概観
 

この章ではコントローラーセクションと関連するソフトウェア上の各コントロール部の概要を紹介します。

6.1 トップパネル - メインエリア
 

このセクションではコントローラーのトップパネルエリア各部の紹介及び、ソフトウェア上での関連項目につ
いて紹介します。

6.1.1 デッキ (Decks)
 

TRAKTOR KONTROL S2 には 2 つの物理デッキを搭載しています。 これらのデッキで常に TRAKTOR
ソフトウェアのトラックデッキ A/B をコントロールします。 また、これらのデッキを専用モードを起動して
使用することで、TRAKTOR の Remix Deck C/D を CUE/REMIX SLOTS セクションでコントロールする
ことも可能です。 対応するモードは Remix Deck モードといい、各デッキの 4 つの CUE/REMIX SLOTS
ボタンで Remix Deck の Sample Slots をコントロールします。 (CUE/SAMPLES セクションのモードに
関しては↑7.5, CUE/REMIX SLOTS セクションの使用を参照してください)。 まとめると、以下のようにな
ります。
▪ S2 の左デッキで TRAKTOR の上部にあるトラックデッキ A をコントロールします(Remix Deck モー

ドでは Remix Deck C をコントロールします)。
▪ S2 の右デッキで TRAKTOR の上部にあるトラックデッキ B をコントロールします(Remix Deck モー

ドでは Remix Deck D をコントロールします)。
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S2 コントローラーのデッキ A です。
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TRAKTOR デッキコントロール用の関連コントロール部分です。

TRAKTOR KONTROL S2 コントローラーの各デッキには以下のコントロール部があります。
▪ 多機能ジョグホイールのトッププレート (1) と外輪部 (2) で各操作を行います。
▪ Tempo ユニット (3) で再生スピードを調節します。
▪ Loop セクション (4) でループの設定、編集を行います。
▪ CUE/REMIX SLOTS セクション (5) デキューポイントの設定とキュー出し操作を行います( ↑7.5,

CUE/REMIX SLOTS セクションの使用参照)。
▪ PLAY 、 CUE ボタン (6) です。
▪ 各デッキには SHIFT ボタン (7) があり、押したまま他のコントロール部を操作することで通常とは異な

る機能を果たします (↑7.1.3, SHIFT ボタンによる二次機能へのアクセス参照)。
▪ FLUX ボタン (8) を押すことで TRAKTOR の Flux モードが起動します。

デッキの多くのコントロール部は必要に応じてカスタマイズ可能です。 詳細は↑8, TRAKTOR
KONTROL S2 のカスタマイズ章を参照してください。
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2 種類のオーディオ素材– 2 種類のデッキ
まず初めに、TRAKTOR ソフトウェアには 4 つのバーチャルデッキがあり、各デッキは Track Deck
モード、Remix Deck モード、Live Input モードで使い分けることができる非常に柔軟なシステムと
なっています。 TRAKTOR KONTROL S2 コントローラーを用いることでソフトウェアの上段デッ
キ A/B は常に Track Decks となり、下段のデッキ C/D は Remix Decks として機能します。 別途
のセットアップガイドを使って S2 コントローラーと TRAKTOR ソフトウェアの基本設定を行って
ください。

デッキでは異なる 2 種類のオーディオ素材を扱うことが可能で、それぞれ異なるデッキを使用します。
▪ Tracks: トラックは ハードディスクにデジタルファイル形式を用いて収納された曲の事を指します。例

えば通常の DJ プレイではトラックの選曲順をあらかじめ準備することがあり、通称としてプレイリスト
(Playlist) と呼ぶことがあります。トラックを操作するデッキをトラックデッキ(Track Decks) とい
います。S2 を使用する場合、TRAKTOR のデッキ A/B は常時トラックデッキモードで操作します。

▪ Samples: サンプルは通常の曲と比べ、比較的小さいオーディオ素材の事を指します。サンプルの音声
内容はトラックと異なる点はありませんが、相違点としてはそのサイズと、使用用途で、サンプルは一般
的にはトラックと比べて非常に小さく、ミックス中に断片的に追加されるものとして多用されます。特に
ライブリミックスでサンプルは非常に効果的に機能します。サンプルを扱うデッキを Remix Decks
といいます。各 Remix Deck にはサンプルに関連した全機能を備えた ４ つの Sample Slots があり、
それぞれのスロットに最大 16 のサンプルを装備することができます。S2 を使用する場合、TRAKTOR
のデッキ C/D は常時 Remix Deck モードで操作します。

6.1.2 ミキサー (Mixer)
 

ミキサー (Mixer) は TRAKTOR KONTROL S2 コントローラーと TRAKTOR PRO 2 ウインドウの中央部
にあります。
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S2 コントローラーと TRAKTOR のミキサーです。

ミキサーはメインチャンネル (main channels、1) で、オーディオシグナルは上記の 2 つのデッキからこ
こに送信されます。 各デッキごとにチャンネルが装備してあります。 ですのでチャンネルはデッキと同様
に A から B で表記してあります。 更に Remix Deck channel (2) があり、TRAKTOR の Remix Decks
C と D のボリュームをコントロールします。 コントロールはミキサー中央部の REMIX ノブを使用します。
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他の DJ ミキサーと同様に、ミキサーの使用目的は各チャンネルの音量調整をすることと、チャンネルの周波
数帯域調整を行うこと、必要であればメイン出力前に FX ユニット (↑6.1.3, FX ユニット (FX Units)参照)
に音声を送り、その後最終的にメインセクション (Main セクション、3) に音声が送信され、その音声が観客
に届きます。 もちろんミキサーにはクロスフェーダー (4) 各チャンネルの途切れることのないミックスを実
現します。
TRAKTOR KONTROL S2 ハードウェアコントローラーのミキサーには、一般的な DJ ミキサーには搭載し
ていない機能が盛り込まれています。 例えばブラウズエンコーダー (BROWSE エンコーダー、5) を使用す
れば、プレイリスト内を素早く閲覧できますし、各インジケーターとスイッチを備えたマスターディスプレ
イ (Master Display、6) で各情報とオプションを確認することができます。 ミキサーセクションの全コン
トロール部の詳細に関してはセクション↑7.7, ミキサーの使用を参照してください。
TRAKTOR KONTROL S2 の物理インプットとアウトプットを扱うミキサー関連のコントロール部はそれぞ
れ S2 のフロントパネル、リアパネルに備えてあります (以下のセクション↑6, ハードウェア 概観参照)。

6.1.3 FX ユニット (FX Units)
 

再生している音声に エフェクトを追加することでミックスに新たな可能性を加えます。TRAKTOR では高
品質の各種 FX を装備しています。これらの FX は FX Units と呼ばれる部分にロードすることが可能で
す。

TRAKTOR KONTROL S2 の FX Unit 1 です。

TRAKTOR の FX Unit 1 です。

デフォルトでは 2 つの FX ユニットが起動した状態となっています。FX Unit 1 と FX Unit 2 は
TRAKTOR の A-D の任意のチャンネルにアサイン可能です。
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ハードウェア上では TRAKTOR KONTROL S2 にもまた 2 つの FX Units (コントローラーでは FX1 と
FX2 と表記されます)があり、ソフトウェア内の FX ユニットに対応します。
FX ユニットの各コントロール部の詳細はセクション↑7.8, FX ユニットの使用を参照してください。
TRAKTOR の環境設定で更に 2 つ FX ユニットを追加、起動することも可能です。  4 つの FX ユニットを
使用することで FX ルーティング内容が変更します。 詳細はセクション

6.2 リアパネル
 

このセクションでは TRAKTOR KONTROL S2 のリアパネルにある全ソケットとコントロール部を解説し
ます。 フロントパネルと共に、ここでは TRAKTOR KONTROL S2 で他の機材(ヘッドフォン、マイク等)を
使用する為、またはシステムを起動する為の各部を備えています。

TRAKTOR KONTROL S2 のリアパネルです。

(1) MIC セクション: TRAKTOR KONTROL S2 にマイクを接続する為のマイク端子です。 詳細は↑6.2.1,
MIC セクションを参照してください。
(2) OUTPUTS セクション: TRAKTOR KONTROL S2 とメインミキサー、またはアンプシステムに接続す
る為の端子です。 詳細は↑6.2.2, OUTPUTS セクションを参照してください。
(3) ケンジントンロックスロット : 機器の盗難防止の為にここにケンジントンロックを施錠します。
(4) POWER セクション: 詳細は↑6.2.3, POWER セクションを参照してください。

6.2.1 MIC セクション
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GAIN ノブ: マイクのゲインを調整します。
MIC ソケット: Microphone インプット (jack 1/4")

6.2.2 OUTPUTS セクション
 

OUTPUTS セクションには TRAKTOR KONTROL S2 コントローラーのメインアウトプット用端子を備え
ています。

リアパネルの OUTPUTS セクションです。

LEVEL ノブ: BOOTH/MAIN スイッチを BOOTH にした場合、ここで RCA のアウトプットゲインを調節
します。
BOOTH/MAIN スイッチ: スイッチを BOOTH にして RCA のアウトプットボリュームをミキサーの
MAIN ボリュームノブの代わりに GAIN コントロールノブでコントロールします。 MAIN モードで RCA
と 1/4" ソケットの両方をミキサー上部の MAIN ボリュームノブでコントロールします。
MAIN/BOOTH Outputs 1/2 RCA 端子 (1/2): TRAKTOR KONTROL S2 のメインアウトプットです
(ライン、アンバランスド)。 これらの端子を使用して TRAKTOR KONTROL S2 をアンバランスドインプッ
トが付いたアンプシステム、またはメインミキサーに接続します。
Main Outputs 1/2 1/4" 端子 (1/2): TRAKTOR KONTROL S2 のメインアウトプットです(ライン、バラ
ンスド)。 これらの端子を使用して TRAKTOR KONTROL S2 をバランスドインプット付アンプシステム、
またはメインミキサーに接続します。

6.2.3 POWER セクション
 

POWER セクションには S2 をコンピュータと電源に接続する端子と、ON/OFF スイッチがあります。

リアパネルの POWER セクションです。
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USB 端子 : ここで S2 を USB ケーブルを介してコンピュータ、または Native Instruments iOS ケーブル
を用いて iOS デバイスに接続します。

可能であれば、コントローラーには S2 ボックス内に同封してある USB ケーブルを使用してくださ
い。低品質の USB ケーブルを使用すると情報伝達精度が下がり、最終的に S2 のパフォーマンスが下
がります。

電源コネクター : ここに電源ケーブルを接続します。
ON/OFF スイッチ : 機器の電源をここでオン/オフします。

6.3 フロントパネル
 

このセクションでは TRAKTOR KONTROL S2 のフロントパネルにある全ソケットとコントロール部を解
説します。 S2 のフロントパネルにはミックスに必要な要素を備えています。

TRAKTOR KONTROL S2 のフロントパネルです。

ヘッドフォン端子(PHONES) : キューチャンネルのステレオアウトプットです(jack 1/4")。ここにヘッドフ
ォンを接続します。
ヘッドフォンボリュームノブ (CUE VOL) : ヘッドフォンの音量をここで調節します。
ヘッドフォンミックスノブ(CUE MIX) : マスターアウトとキューチャンネル音量バランスをここで調節しま
す。
MIC ENGAGE スイッチ : スイッチを入れてマイクチャンネルを起動します。 マイク端子はリアパネルに
あります (↑6.2.1, MIC セクション参照)。
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MIC ENGAGE スイッチをのぞいてフロントパネルの全てのノブは軽く押すことで格納可能な構造に
なっており、機材運搬中に損傷するリスクを大幅に軽減します。

6.4 コントロール部の種類
 

TRAKTOR KONTROL S2 には各種コントロール部があり、ここではそれらを簡単に紹介します。

6.4.1 各ボタン
 

S2 の (これは CUE/REMIX SLOTS ボタン 2 です) ボタンです。

各ボタン は TRAKTOR KONTROL S2 の随所に設置されています。 ボタンの性質は以下 3 種です。
▪ いくつかのボタンはボタンを押すことでその機能します (「trigger」 動作です) 例えば CUE/REMIX

SLOTS ボタンがその一つで、CUE/REMIX SLOTS ボタンを押すと、このボタンで設定した再生位置か
ら再生を開始します。

▪ いくつかのボタンはもう一度押すことでボタンの性質が変わり、(「トグル/toggle」 アクション) 例え
ば PLAY ボタンは一度押すことでトラックを再生し、もう一度押すことでトラックが停止します。

▪ いくつかのボタンはボタンを押し続けることで機能します(「ゲート/gate」 または 「ホールド/hold」
アクション)。 特に SHIFT ボタンはその性質だけを持つボタンです(以下参照)。

TRAKTOR KONTROL S2 の全ボタンは LED を備えており、使用状況を提示します。 基本的に LED はボ
タンの現在の状態を示しますが、各ボタンによってその意味は異なります。詳細は各ボタンを解説する各セク
ションで確認してください。

SHIFT ボタン
各機能をトリガーする代わりに、SHIFT ボタン(各デッキにあります) は TRAKTOR KONTROL S2 上の他
のコントロール部の機能を変更する為に機能し、それらのコントロール部の二次機能を起動します。

SHIFT ボタンに関する詳細はセクション↑7.1.3, SHIFT ボタンによる二次機能へのアクセスを参照
してください。
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6.4.2 各ノブ
 

S2 のノブです。

各ノブ は動作範囲に制限があるローターリーポテンションメーターで、動作範囲はノブに記載してある白い
リングの範囲となっています。ノブを回すことでパラメーターの値を設定します。ノブに書かれた白い線が
パラメーターの現在の設定とを示す手がかりとなります。使用目的によりますが、殆どの場合真ん中 (デフォ
ルト)に引っ掛かりがあり、白線もその位置ですこし途切れます。

6.4.3 エンコーダー
 

S2 のエンコーダーです。

各エンコーダー はエンドレスロータリーコントロールで、白いリングがついています。 ノブを回すことでソ
フトウェアの現在のパラメーター値に沿って値を変更します。 全てのエンコーダーは値を詳細設定できる使
用となっています。
他にも押すことで他の機能を果たすロータリーエンコーダーもあります。
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6.4.4 ジョグホイール
 

S2 のジョグホイールです。

機能のみに関して言及すると、ジョグホイールは回し続けることができ、トッププレートを押すことでも機能
することから、上記のエンコーダーに非常に似ています。サイズの他に大きく異なる点は、押す動作が非常に
小さくても機能することで、トッププレートに手を置いたり、ホイールの外輪部分に振れることで機能しま
す。これにより、以下の異なるコントロールを使用可能となります。
▪ ジョグホイールの外輪を回転させる。
▪ トッププレートを軽く押しながらジョグホイールを回す。

これによりジョグホイールが多機能で正確なコントロール部となります (例、スクラッチ、トラック内の移動
リスト内の閲覧)。
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6.4.5 各フェーダー
 

S2 のフェーダーです。

フェーダー は可動範囲に制限があるリニアコントロール部です。 フェーダーは全て絶対値を設定する為の
ものです (TEMPO フェーダーは例外となる場合があります。↑7.3, テンポユニットの使用参照)。

6.4.6 各メーター、各インジケーター
 

メーターです。

各インジケーター、各メーターは単体、または複数の LED によるもので、 TRAKTOR KONTROL S2 シス
テム内の各状態とレベルをリアルタイムに提示します。
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6.4.7 各スイッチ
 

スイッチです。

各スイッチはリアパネルのみにあります。これらのスイッチで TRAKTOR KONTROL S2 を起動したとき
の基本的なオプションをコントロールします。

6.4.8 各ソケット
 

S2 のリアパネルにある RCA メインアウトプットソケットです。

ソケット はリアパネル、フロントパネルのみにあります。これらのソケットで各種ケーブルを (USB、オー
ディオ、MIDI、等) TRAKTOR KONTROL S2 に接続します。
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7 ハードウェアコントロールリファレンス
 

この章では S2 コントローラーの各セクションの操作方法について解説します。コントローラーに関して不
明な点がある場合、特定の操作方法を確認したい場合は、この章の内容を参照してください。
この章では TRAKTOR KONTROL S2 の実際の操作を中心に解説を進めます。もちろん S2 上での操作は
瞬時に TRAKTOR に反映します。TRAKTOR ソフトウェアの全機能詳細に関しては、TRAKTOR 2 マニュ
アルを参照してください。

↑13, 付録 C – クイックリファレンス章のクイックリファレンスでは S2 の各コントロール部の基本
機能を解説しています。

7.1 基本知識として
 

7.1.1 S2 コントローラーの基本構造
 

以下のセクションではコントローラーの各セクション (例えば LOOP セクション、または CUE/REMIX
SLOTS セクション等) の操作方法詳細を紹介しています。 まずは各コントローラーの構造を把握し、コント
ローラーの使用方法を理解する際に役立ててください。
基本的に、TRAKTOR KONTROL S2 には左右 2 台のデッキとミキサーがあり、これらはコントローラーの
中央に位置しています。 デッキで TRAKTRO ソフトウェアのトラックデッキ A と B をコントロールしま
す。 更に Remix Deck モードではコントローラーの CUE/REMIX SLOTS セクションで TRAKTOR の
Remix Deck C と D をコントロールします。
ミキサーの 2 つのメインミキサーチャンネルでトラックデッキ A/B をコントロールします。 3 つ目の
REMIX チャンネルで TRAKTOR の Remix Deck C/D のボリュームをコントロールします。
S2 をサンプル再生が可能な 2 つのデッキとミキサーを備えた従来の DJ ミックス用セットアップとしてと
らえてください。
更に専用ゲインコントロール付マイクチャンネルも搭載しています。 このチャンネルは直接 S2 のメインア
ウトに送信され、このマイク機能は S2 をコンピュータに接続していない状態でも使用することが可能です。

7.1.2 TRAKTOR の各デッキ 、Track Deck、Remix Deck について
 

TRAKTOR ソフトウェアには A から D までのバーチャル デッキ (Decks) があります。 各デッキで各モー
ド (TRAKTOR ではデッキフレーバーと呼びます) を使用することができ、モードは Track Deck モード、
Sample Deck モード、Live Input モードとなっています (詳細は↑6.1.1, デッキ (Decks)を参照してくださ
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い)。 モードを活用することで TRAKTOR をカスタマイズ可能な柔軟なシステムとして使用することができ
ます。 しかし TRAKTOR KONTROL S2 コントローラーを用いる場合、ソフトウェアの上段デッキ A/B は
常に Track Decks となり、下段のデッキ C/D は常に Remix Decks として機能します。 別途のセットアッ
プガイドを使って S2 コントローラーと TRAKTOR ソフトウェアの基本設定を行ってください。

7.1.3 SHIFT ボタンによる二次機能へのアクセス
 

SHIFT ボタン (S2 の各デッキに付属) は TRAKTOR KONTROL S2 の各コントロール部の ”変更ボタン” と
して機能します。 言い換えると、このボタンと他のボタンを同時に使用することで、各ボタンの二次機能に
アクセスします (コンピュータのキーボードにある [Shift] キーと同じです)。

SHIFT ボタンです。

► 各コントロール部の二次機能にアクセスするには各コントロール部を押す前に SHIFT ボタン
を押したままにしておきます。

左右デッキと FX ユニットのコントロール部では SHIFT は SHIFT ボタンを押した場所のデッキ、FX ユニッ
トに機能します。
ミキサーでは両側にある SHIFT ボタンのどちらを押してもミキサーの二次機能にアクセスします。
資料によってはこの二次機能を「シフトレイヤー/Shift layer」として表現する場合があります。

トラックデッキでは、SHIFT ボタンでデッキのテンポを指定することも可能です。 詳細は↑7.6.3,
SHIFT ボタンを参照してください。
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7.2 ジョグホイールの使用
 

ジョグホイール(図は右デッキです)です。

ジョグホイールにはトラックの再生に関わるいくつかの機能を備えています。
▪ テンポベンド (Tempo bending): ジョグホイールの外輪に触れる事で、デッキのテンポを一時的に調整

することができます。外輪に触れるのをやめると、デッキのテンポが元のテンポに戻ります。
▪ スクラッチ (Scratch): ジョグホイールのトッププレートを押すことで、ビートのキュー出し、スクラッ

チを全て手動で行うことが可能となります。またこの操作でトラック内の特定の位置を正確に指定する
ことが可能となります。トッププレートから手を放すと、デッキが元の常態に戻ります (再生、または停
止)。

▪ シーク (Seek): SHIFT を押しながらジョグホイールのトッププレートを回すと、トラック内を素早く移
動することが可能となります。

ジョグホイールのトッププレートを押すと BROWSE エンコーダーの下の LOAD ボタンが点灯し、再生位置
を手動操作していることを示します。
ジョグホイールはその他の機能も備えています。
▪ 起動しているループ上で LOOP IN または LOOP OUT ボタンを押しながらジョグホイールを動かすと、

各ループインポイント (Loop In Point) またはループアウトポイント (Loop Out Point) を調節するこ
とが可能となります。 詳細については、セクション↑7.3.2, テンポリセットを参照してください。
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▪ 更に FX コントロールまたはフィルターコントロールの際にジョグホイールを活用可能です。 詳細はセ
クション↑8.2.1, S2 コントロールオプションを参照してください。

7.3 テンポユニットの使用
 

TEMPO フェーダーでデッキのテンポをコントロールします。

7.3.1 テンポフェーダー
 

TEMPO フェーダーとテンポリセットボタンです。

TEMPO フェーダーを上下することで、フォーカスデッキのテンポをコントロールします。 デフォルトでは
TEMPO フェーダーのテンポ調整幅は ±6 % です。

テンポフェーダーの調整幅は Preferences > Transport > Tempo で変更可能です。ソフトウェア
デッキのテンポフェーダーと S2 の TEMPO フェーダーはここでの設定値に対応します。

アブソルートモード (Absolute Mode)
デフォルトで TEMPO フェーダーはアブソルートモードとなっています。このモードで S2 上で TEMPO
フェーダーを動かすと、フェーダー情報が 1:1 でソフトウェアのデッキのテンポフェーダーに伝達され、ソ
フトウェアのテンポフェーダーをコントロールすることとなります。
Absolute モードではソフトウェアのデッキのテンポは以下の方法でソフトウェアのデッキのテンポを変更
しない限り、 S2 の TEMPO フェーダー位置に対応します。
▪ そのデッキで SYNC を起動し、ソフトウェアデッキ上で他のテンポに同期した場合。 テンポマスターで

はないデッキで SYNC を起動すると、デッキのタンポをフェーダーで手動コントロールすることはでき
なくなります (フェーダー機能はソフト、ハードの両方で無効の状態となります)。

▪ ソフトウェアでテンポフェーダーを移動した場合。

ハードウェアコントロールリファレンス
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リレティブ (Relative) モード
TEMPO フェーダーをリレティブモードに切り替えることも可能です。 このモードでハードウェアの
TEMPO フェーダーでの操作内容は S2 のフェーダーの位置とは関係なくソフトウェアのデッキ上のテンポ
フェーダーに対応します。 このモードで TEMPO はデッキ同期時、デッキの切り替え時に対応するようにな
ります。 Relative モードを起動するには、Preferences > TRAKTOR KONTROL S2 > S2 Control
Options > Tempo Faders と進みます。 詳細は↑8.2.1, S2 コントロールオプションを参照してください。

7.3.2 テンポリセット
 

TRAKTOR デッキをオリジナルのテンポにリセットする方法は以下です。

► S4 で SHIFT + 対応する FLUX ボタンを押します。

→ フォーカスデッキのテンポが 0 % となり、TEMPO フェーダーが無効の状態となります。
テンポを固定することでコントローラーのテンポフェーダーは無効の状態となりますが、トラックのテンポは
他のデッキと同期する (SYNC を起動してください) ことで変動しますし、ソフトウェア上でテンポを変更す
ることでも変動します。 TEMPO フェーダーを再度起動する方法は以下です。

► S4 で SHIFT + 対応する FLUX ボタンを押します。

7.4 LOOP セクションの使用
 

ループ・セクションです。

ループセクションにはトラックでループを設定、加工する為の必要なコントロール部各部が揃っています。
ループセクションには中央に 2 つのボタン、傍らに 2 つのプッシュエンコーダーがあります。 左から右に、
ループ MOVE エンコーダー、LOOP IN ボタン、LOOP OUT ボタン、ループ SIZE エンコーダーのコントロ
ール各部があります。
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7.4.1 LOOP IN と LOOP OUT ボタンです。
 

LOOP IN と LOOP OUT ボタンです。

LOOP IN と LOOP OUT ボタンで再生トラックのフローティングループ(浮動ループ、Floating Loop)を手
動設定します。
LOOP IN ボタンでフローティングキューポイント(Floating Cue Point)を現在の再生位置に配置します。
フローティングキューポイントは LOOP OUT ボタンを押すことでループインポイントに変化します。

LOOP IN ボタンは再生を止めることなくフローティングポイントを設定する為に最適なツールです。

LOOP OUT ボタンで 現在の再生位置にループアウトポイントを設定することで 、先ほど設定したフローテ
ィングキューポイントと、このループアウトポイントを使用したフローティングループを作成します。

複数のループの為に同じループインポイントを使用可能で、新規ループアウトポイントを設置するこ
とで新規フローティングループが作成されます。

LOOP IN 、LOOP OUT ボタンはインジケーターとしても機能し、これらの同時点灯はループが再生されて
いることを意味します。 ループが起動していても再生位置がループの外の場合は、 LOOP OUT のみが点灯
します。

► LOOP IN または LOOP OUT ボタンのどちらかを押しながらジョグホイールを回すことで再
生しているループのループイン/アウト各ポイントを調整することができます。

これらの操作はフローティングループに直接影響します (元々のループの設定には影響しません)。 ですか
ら、これらの変更したループを後でも使用したい場合は、この設定を保存する必要があります。 例えばこの
操作は点灯していない CUE/REMIX SLOTS ボタンを押すことで保存できます (セクション↑7.5, CUE/
REMIX SLOTS セクションの使用参照)。

オートループモードに切り替えると、LOOP IN と LOOP OUT ボタンの別機能が起動します。
Preferences > TRAKTOR KONTROL S2 > S2 Control Options > Loop Buttons と進んで設置を
行ってください。 詳細は↑8.2.1, S2 コントロールオプションを参照してください。
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7.4.2 ループ MOVE エンコーダー
 

ループ MOVE エンコーダー

ループ MOVE エンコーダーでループの起動/起動解除、ループの移動、トラック内のジャンプ操作を行いま
す。

LOOP MOVE エンコー
ダー

No Loop active Loop active

回す 現在のループのサイズ (TRAKTOR のループ
コントロールセクションの数値です) でビー
トジャンプ (Beatjump) します。

現在のループのサイズ (TRAKTOR のループ
コントロールセクションの数値です) で移動
します。

SHIFT + 回す 1-ビート単位でビートジャンプします。 1-ビート単位でループが移動します。

押す ループを起動します (トラックの現在、また
は次のループが起動します)。

ループを停止します。

これらの操作はフローティングループに直接影響します (元々のループの設定には影響しません)。 ですか
ら、これらの変更したループを後でも使用したい場合は、この設定を保存する必要があります。 例えばこの
操作は点灯していない CUE/REMIX SLOTS ボタンを押すことで保存できます (セクション↑7.5, CUE/
REMIX SLOTS セクションの使用参照)。

7.4.3 ループ SIZE エンコーダー
 

ループ SIZE エンコーダーです。

ループ SIZE エンコーダーでループサイズを選択/調整し、選択したサイズでフローティングループを設定し
ます。

ハードウェアコントロールリファレンス
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LOOP SIZE エンコーダ
ー

No Loop active Loop active

回す 次に設定するフローティングループ用にルー
プサイズ (ビート単位) を設定します。選択
したループサイズは TRAKTOR のループコ
ントロールセクションで確認できます。

ループのサイズを半分/倍にする。

押す 選択したループサイズで現在の再生位置に新
規フローティングループを設置、起動します。

ループを停止します。

TRAKTOR ソフトウェアのトラックデッキのループサイズディスプレイです。

ループ MOVE とループ SIZE エンコーダーを押すことでループの起動/停止が可能です。 ループ
SIZE エンコーダーでループで起動する際との相違点は、現在の位置に新規フローティングループを追
加設置する点です。

これらの操作はフローティングループに直接影響します (元々のループの設定には影響しません)。 ですか
ら、これらの変更したループを後でも使用したい場合は、この設定を保存する必要があります。 例えばこの
操作は点灯していない CUE/REMIX SLOTS ボタンを押すことで保存できます (セクション↑7.5, CUE/
REMIX SLOTS セクションの使用参照)。

7.5 CUE/REMIX SLOTS セクションの使用
 

モードによっては S2 の各 CUE/REMIX SLOTS セクションの 4 つの CUE/REMIX SLOTS ボタンは以下
の機能をコントロールします。
▪ TRAKTOR のトラックデッキ A/B (キューモード) 用キューポイントです。
▪ Remix Deck C/D (Remix Deck モード) のサンプルスロットです。

Track Deck と Remix Deck に関しては↑6.1.1, デッキ (Decks)を参照してください。

7.5.1 Cue モード
 

Cue モードではホットキュースロットとなる 4 つの CUE/SAMPLES ボタンです。
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Cue モードでこのボタンはデッキのホットキュースロットとして機能します。 ホットキューで配置、保存し
たキューポイント、またはループに瞬時に移動することが可能です。

CUE の状態
以下は TRAKTOR が Track Deck の場合です。 各 CUE/REMIX SLOTS ボタンの RGB 配色はスロットの
現在の状態を示します。

CUE ボタン ホットキュースロットの状態

無点灯 ホットキュースロットが空です。

ブルー そのホットキュースロットはキューポイントを含んでいます。

グリーン
イエロー
オレンジ
ホワイト

ホットキュースロットはループを含んでいます。
ホットキュースロットは Load Marker を含んでいます。
ホットキュースロットは Fade-In または Fade-Out Marker を含んでいます。
ホットキュースロットは Grid Marker を含んでいます。

ホットキュースロットにキューポイント、またはループを保存する。
点灯していない空のボタンを押してホットキュースロットに現在の再生位置を保存することが可能です。 キ
ューポイント、またはループが現在の再生位置に保存されます。
▪ 再生位置が有効なループの外である場合、キューポイントが保存されます。 すると、対応する CUE/

REMIX SLOTS ボタンが青く点灯します。
▪ 再生位置が起動したループ内であれば、このループがホットキュースロットに保存されます。 すると、

対応する CUE/REMIX SLOTS ボタンが緑に点灯します。

ループ内にキューポイントを設置する場合はループ MOVE エンコーダー等を使用してループを停止
してからキューポイントを設定します。

設定したホットキューへの移動
点灯した状態の CUE/REMIX SLOTS ボタンを押すことでそこに保存してあるキューポイント/ループに移
動します。 再生中のデッキではジャンプ後も再生が止まることはありません。一時停止した状態のデッキで
は設定したキューポイント/ループから再生を開始しますが、対応する CUE/REMIX SLOTS ボタンを押して
いる間だけの再生となります。 ボタンを放すと、そのキューポイント/ループの先頭位置で停止します。
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ホットキュースロットの削除
ホットキュースロットの内容を削除するには、SHIFT を押しながら削除する CUE/REMIX SLOTS ボタンを
押します。 削除が終わると、ボタンの LED ライトが消えます。
ホットキュースロットを削除することで、そこで保存したキューポイントやループも削除されます。

7.5.2 Remix Deck モード
 

Remix Deck モードで CUE/REMIX SLOTS ボタンは TRAKTOR ソフトウェア の Remix Deck C/D の 4
つのサンプルスロットとして機能します。 サンプルスロットで現在ロードしているトラックをサンプリン
グ、またはブラウザからサンプルをロード、再生します。 コントローラーデッキの CUE/REMIX SLOTS セ
クションを Remix Deck モードに切り替える方法は以下となります。

► コントローラーの中央部にある REMIX ノブの下の各 Remix Deck ボタン (A/B) を押しま
す。 Remix Deck モードボタンが点灯し、関連する CUE/REMIX SLOTS セクションが
Remix Deck モードとなったことを示します。

4 つの CUE/REMIX SLOTS ボタンは Remix Deck モード時の Remix Deck の 4 つの Sample Slots に対応します。

Remix Deck のコンセプトに関してはセクション↑6.1.1, デッキ (Decks)を参照してください。
Remix Deck の各使用例を解説したセクション↑4.5, ミックス内でサンプルを使用するもあわせて確
認してください。

CUE/REMIX SLOT の状態
各 CUE/REMIX SLOTS ボタンの LED はサンプルスロットの現在の状態を示します。

CUE/REMIX SLOTS ボタン Remix Slot の状態

無点灯 空の Sample Slot です。

薄く点灯 サンプルはロードされた状態で停止、又はミュートされています。

点灯 サンプルがロードされ、再生しています。
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現在のトラックからサンプリングする。
デッキにトラックがロードしてあれば、そのデッキの CUE/REMIX SLOTS ボタン(空のスロット)を押すこ
とでトラックからサンプルを直接サンプリングすることが可能です。 サンプルは現在の再生位置からサンプ
リングされます。
▪ 現在の再生位置が起動しているループ内である場合は、サンプルはそのループのコピーとなります。サン

プルの再生位置もループ内の再生位置と同じとなります。
▪ 現在の再生位置が起動しているループの外である場合は、サンプルは現在の位置から再生します。 サイ

ズは選択したループサイズによって決まります (TRAKTOR の Loop Size Display で設定値を確認可能
です。↑7.4.3, ループ SIZE エンコーダー参照)。

CUE/REMIX SLOTS ボタンが薄く点灯し、サンプルがロードされ、ミュート、または停止した状態であるこ
とを示します。

サンプルがミュートした状態か、停止した状態かを判断するには、コンピュータの TRAKTOR ソフト
ウェアで確認します。サンプルがミュートしている場合は、 サンプルスロット内の波形が薄く光り、
CUE/REMIX SLOTS ボタンが点灯/無点灯の場合、サンプルが再生しているか停止しているか確認す
ることができます。

ロードしてあるトラックからサンプリングし、メインミックスで 3 回サンプルを再生すると、そのサ
ンプルは自動的にコレクションに保存されます。

プレイリストからサンプルをクイックロードする
SHIFT を押したまま点灯していない CUE/REMIX SLOTS ボタンを押すと、現在起動しているプレイリスト
からそのサンプルスロットに選択したサンプルをロードします。

ループ、ワンショットモードによるプレイバックコントロール
サンプルをサンプルスロットにロードすると、CUE/REMIX SLOTS ボタンでそのサンプルの再生コントロー
ルが可能となります。 機能内容はサンプルの再生モード (ループまたはワンショット) により異なります。
Remix Deck の Advanced Panel でサンプル再生タイプの設定を行うことができます。 Advanced Panel
はデッキレイアウトによって表示される場合とされない場合があり、デッキ上部の境界線を何回かダブルクリ
ックしてレイアウトの表示内容を変更して Advanced Panel を表示します。
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詳細パネル（Advanced Panel）を備えた状態の Remix Deck です。右下で Play Type ボタンにカ

ーソルを当てており、ここで現在選択している Sample Cell の再生モード（One-shot と Loop モー

ド）を切り替えます。

Advanced Panel の右下の Play Type ボタンをクリックしてサンプル再生モードを Loop か One-shot モ
ードのどちらかにします。
ワンショットモード (One-shot モード) で、サンプルを一回再生します。 CUE/REMIX SLOTS ボタンは以
下のように機能します。

再生状態 CUE/REMIX SLOTS ボタン

サンプルが停止した状態 ここを押して再生を開始します。

サンプルを再生している。 ここを押すと、サンプルを頭出しした状態で停止します。

ループモード (Loop モード) ではサンプルをループ再生します。 CUE/REMIX SLOTS ボタンは以下のよ
うに機能します。
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再生状態 CUE/REMIX SLOTS ボタン

サンプルが停止した状態 ここを押して再生を開始します。

サンプルを再生している。 押すことでサンプルをミュート/ミュート解除します。
SHIFT + と関連するボタンを押して再生を停止し、サンプルの冒頭部分に再生開始位置
が移動します。

サンプルの削除
停止しているサンプルスロットの内容を削除するには SHIFT と削除対象となる CUE/REMIX SLOTS ボタ
ンを押します。 サンプルスロットのサンプルを再生している場合は、SHIFT + CUE/REMIX SLOTS ボタン
を押して再生を停止します。 この動作をもう一度行うと、サンプルスロットが削除され、LED が無効の状態
となります。

7.6 Transport Control Area の使用
 

7.6.1 CUE と PLAY ボタン
 

CUE  と PLAY ボタン

デッキの下の CUE と PLAY 各ボタンはデッキで常用するコントロール部です。

CUE ボタン
CUE ボタンの各機能は以下です。
▪ デッキ再生中に CUE を押すとフローティングキューポイントに移動、停止します。
▪ デッキを停止している時は CUE を押すことで新規フローティングキューポイントを設置します (設定し

てあるフローティングキューポイントに上書きします)。 これにより CUE ボタンを押している間はその
位置からの再生を続けます。 ボタンを放すと、配置したフローティングポイントに戻り停止します。

SHIFT + CUE でトラックの最初にスキップします。 再生状態 (再生、または停止の状態) はこの作業とは関
係なく続行されます。
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PLAY ボタン
PLAY ボタンでデッキのトラックを再生/停止します。ボタンの点灯は、そのデッキが再生していることを意
味します。
SHIFT + PLAY でデッキのキーロックを起動/解除します。 キーロックを起動すると、デッキディスプレイ
で KEYLOCK インジケーターが点灯します (キーロック機能に関しては TRAKTOR 2 マニュアルと↑
4.7.3, 同期用のその他のツールを参照してください)。

7.6.2 SYNC ボタン
 

SYNC ボタンです。

SYNC ボタンでデッキがテンポマスター(他のデッキまたはクロック)に同期するかを決めます。 ボタンの点
灯は同期機能が有効であることを意味します。
同期機能を使用すると、アブソルートモード(デフォルト)の場合、TEMPO フェーダーが無効の状態となりま
す。 詳細は↑7.3, テンポユニットの使用を参照してください。
SHIFT + SYNC でデッキがテンポマスター (tempo master) となり、このデッキのテンポが他のデッキ、ま
たは各 FX の参照テンポとなります。デッキをテンポマスターとして設定すると、TRAKTOR の対応するデ
ッキセクションの MASTER ボタンが点灯しま す(↑4.7, 同期 (Synchronization) 参照)。

7.6.3 SHIFT ボタン
 

SHIFT ボタンです。

SHIFT ボタンを押し続けることで各コントロール部の二次機能を起動します。
この機能はデッキの種類とは関係なく、常に使用可能です。 詳細はセクション↑7.1.3, SHIFT ボタンによる
二次機能へのアクセスを参照してください。
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ビートのタッピング
トラックデッキの SHIFT を何回か押し (タッピングといいます)、トラックのビートグリッドを修正する為の
ツールとして活用します。
これにより S2 のトラックのビートグリッドを修正できます。

7.7 ミキサーの使用
 

S2 の中央にあるミキサーです。
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このセクションでは TRAKTOR KONTROL S2 のミキサーの基本操作について解説します。

クイックリファレンス↑13.1, クイックリファレンスではミキサーの各コントロール部についての基
本機能を解説しています。

ミキサー概観
ミキサーは 2 つのメインチャンネルを装備しており、各チャンネルで特定のデッキ音声をコントロールしま
す。チャンネル A、B でそれぞれデッキ A、B (S2 の左右デッキ) をコントロールします。
ミキサーチャンネルのレイアウトは理にかなっているので迷うことなく使用できます。
▪ TRAKTOR KONTROL S2 の左チャンネルで TRAKTOR PRO 2 の左トラックデッキ (Deck A) のシグ

ナルをコントロールします。
▪ TRAKTOR KONTROL S2 の右チャンネルで TRAKTOR PRO 2 の右トラックデッキ (Deck B) のシグ

ナルをコントロールします。
更に Remix Deck モードを使用する場合、TRAKTOR の Remix Deck C/D 両方の音量をコントロールしま
す。

シグナルフロー
デッキシグナルは S2 のメインアウトプットに出力されるまでに以下の場所を通過します。
1. まずチャンネル最上部の GAIN エンコーダーを通過します。
2. そこから EQ とフィルターセクションを通過します。
3. FX ユニットを起動し、デッキをそこにアサインしてある場合は、フィルターセクションを通過します。
4. FX ユニットからチャンネルフェーダーを通過、クロスフェーダーに送信されます。
5. クロスフェーダーを通過した後シグナルは MAIN セクションに到達し、これがアウトプット出力となり

ます。

7.7.1 GAIN/FILTER エンコーダー
 

GAIN/FILTER エンコーダーです。

GAIN/FILTER エンコーダー は S2 で TRAKTOR PRO、または TRAKTOR DJ app を使うかで異なる性質
を持ちます。
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TRAKTOR PRO を使用する場合、GAIN/FILTER エンコーダーでチャンネルフェーダーに送る前に、各デッ
キからのシグナルのインプットレベルを調節します。

► GAIN/FILTER エンコーダーを回してチャンネルインプットゲインを調節します。

ここでの調整値が下部のチャンネルメーターで表示する内容となり、チャンネルメーターがクリップ
表示する場合は、GAIN/FILTER エンコーダーを調節します。 レベル調整詳細に関してはセクション
↑4.3, レベルの調整 を参照してください。

以下はデッキのインプットを 0 db にリセットする方法です。

► GAIN/FILTER エンコーダーを押します。
GAIN/FILTER エンコーダーの二次機能は TRAKTOR デッキのフィルターコントロール機能です。

► SHIFT を押しながら GAIN/FILTER エンコーダーを回します。 右に回すと低域が減衰
（HPF）し、左に回すと高域が減衰（LPF）します。

TRAKTOR DJ で GAIN/FILTER エンコーダーを使用する方法に関しては↑5.1.3, フィルターの使用を参照
してください。

7.7.2 EQ ノブ
 

各 EQ ノブです。

各チャンネルには EQ セクションがあり、 3 つのノブ HI、MID、LOW があり、シグナルの低中高音周波数
帯域をそれぞれコントロールします。
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► 各 EQ ノブを右に回して各周波数帯域を持ち上げ、左に回して帯域を減衰させます。中央部で
はシグナルは原音の状態となります。

TRAKTOR は個性ある EQ 各種を備えています。EQ タイプは Preferences > Mixer > EQ
Selection と進んで選択することが可能です。 詳細は TRAKTOR 2 マニュアルを参照してください。

7.7.3 FX アサイン・ボタン
 

FX アサインボタンです。

GAIN/FILTER エンコーダーの下にある FX アサインボタン (“1” と “2”と表記) でチャンネルと対応するデ
ッキを任意の FX ユニット (通常のレイヤー) とどちらかのクロスフェーダーサイドにアサインします (シフ
トレイヤー)。
FX ユニットアサインは左右ボタンのどちらかを押してチャンネルを FX ユニット 1 または 2 にアサインし
ます。対応する FX にチャンネルがルーティングされると、ボタンが点灯します。同じチャンネルから両方の
ボタンを使用すると、FX ユニット 1 と FX ユニット 2 がチャンネルのシグナルを直列処理します。

S2 の FX ユニット詳細はセクション↑7.8, FX ユニットの使用を参照してください。
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7.7.4 チャンネルフェーダーとチャンネルレベルメーター
 

チャンネルフェーダーとレベルメーターです。

チャンネルフェーダーでシグナルがクロスフェーダー、メインセクションに到達する前のチャンネルの音量を
コントロールします。
チャンネルメーターでこのチャンネルのフェーダーレベルを目で確認することができます。
▪ 青表示でシグナルがクリッピングしていないことを意味します。
▪ オレンジはシグナルがクリッピングしていることを意味します。

このメーターでシグナルが適切な音量になっているか確認することができます。またチャンネル同士の音量
を同じ程度に調整してミックスが違和感なく保たれるように調整します。

チャンネルレベルを修正するには、チャンネルの上にある GAIN/FILTER エンコーダーを使用しま
す。 レベル調整詳細に関してはセクション ↑4.3, レベルの調整 を参照してください。

7.7.5 クロスフェーダー
 

クロスフェーダーです。
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クロスフェーダーで左右の音声バランスを制御します。中央にすると、クロスフェーダーは無効となり、各チ
ャンネル音量は各チャンネルフェーダーでコントロール可能な状態となります (上記参照)。クロスフェーダ
ーの両端で任意の音声が完全にカットされます。

TRAKTOR の環境設定 (Preferences) でクロスフェーダーの性質を変更することが可能です。詳細
は TRAKTOR 2 マニュアルを参照してください。

Preferences > Mixer > Crossfader と進んでクロスフェーダーの性質を変更することも可能です。
詳細は TRAKTOR 2 マニュアルを参照してください。

7.7.6 MAIN セクション
 

ミキサーのメインセクションです。

メインセクションでミックス全体の音声をモニター、調整することが可能です。この部分はミックスが観客の
耳に届く直前の、S2 の音量最終コントロール部です。

7.7.7 ヘッドフォンキューボタン
 

ヘッドフォンキューボタンです。

ヘッドフォンキューボタン(CUE) でチャンネルシグナルをキューチャンネル(ヘッドフォン)に送ります。 こ
の機能はミックス前のオーディオを試聴する為の、DJ プレイの必須機能の一つです。

► CUE ボタンを押してチャンネルのシグナルをヘッドフォンに送信します。
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ヘッドフォン CUE ボタンは使用中点灯します。
CUE MIX 機能の使用方法に関しては↑4.2.2, ヘッドフォンを使用してミックスを正確に行う (ビートマッチ
ング)。を参照してください。

7.7.8 マスターディスプレイ
 

マスターディスプレイ

マスターディスプレイには TRAKTOR KONTROL S2 システムの各情報を表示します。

アラートインジケーター

アラートインジケーターです。

トアラートインジケーターは基本的に TRAKTOR KONTROL S2 システムに問題が生じた場合に表示され
ます。TRAKTOR のメインボリュームノブ、またはヘッドフォンボリュームノブの設定が低すぎる場合、
CPU メーターが高すぎる場合、ラップトップの電源アダプターが接続されていない等の場合にこのインジケ
ーターが点滅します。

USB インジケーター

USB インジケーターです。

USB インジケーターは S2 とコンピュータ間の USB 接続情報を提示します。このインジケーターは常に表
示します。点滅した場合は、接続に問題がある、またはドライバに問題があることを意味します。

► S2 を使用する前に、USB インジケーターが常に表示された状態であるか確認してください。
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マイクロフォンインジケーター

マイクロフォンインジケーターです。

マイクロフォンインジケーターはマイクロフォンチャンネルが起動したときに点灯します。 コントローラー
のフロント部にある MIC ENGAGE ボタンを押してマイクロフォンチャンネルを有効/無効にします。

MIC セクションの詳細は↑6.2.1, MIC セクションを参照してください。

7.7.9 Browse エンコーダー(BROWSE) と Load ボタン (A と B)
 

BROWSE エンコーダーです。

Load ボタン (A/B)

BROWSE エンコーダーと LOAD ボタンは TRAKTOR KONTROL S2 のトラックまたはサンプルのブラウ
ズ、コピーに使用します。 操作方法は↑7.9, ブラウズとロードを参照してください。
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7.7.10 Remix Deck ノブと Mode ボタン (A/B)
 

Remix Deck ノブと Mode ボタン (A/B) です。

REMIX ノブで TRAKTOR の Remix Deck C/D をコントロールします。 Remix Deck モードを起動する
には、Mode ボタン、またはデッキの CUE/REMIX SLOTS セクションの下のモードボタン A または B を
押します。任意のデッキの CUE/REMIX SLOTS セクションでトラックデッキをコントロールするか、
TRAKTOR の Remix Deck C/D をコントロールするか設定します。 キューモードと Remix Deck モード
に関しては↑7.5, CUE/REMIX SLOTS セクションの使用を参照してください。

7.8 FX ユニットの使用
 

S2 の FX ユニット 1 と 2 で TRAKTOR の FX ユニットをコントロールすることが可能です。ソフトウェ
アの FX ユニットの全てのコントロールは S2 でも使用できます。
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S2 の左 FX ユニットです。

(1) FX On ボタン
(2) FX DRY/WET ノブ
(3) FX ノブ 1
(4) FX ノブ 2
(5) FX ノブ 3
(6) FX ボタン 1
(7) FX ボタン 2
(8) FX ボタン 3

7.8.1 シングルモードとグループモード
 

TRAKTOR の各 FX ユニットは 2 つの異なるモードで使用することができます。
▪ Group モード: では FX ユニットで 3 つの異なる FX を直列使用することが可能です。各 FX はノブと

ボタン (各 1 つ) でコントロールします。
▪ Single モード: 各 FX ユニットにシングル FX を搭載することが可能で、ノブとボタン (各 3 つ) を操作

して詳細を設定することが可能です。
FX ユニットのコントロール部は FX ユニットのモードによって異なる機能を果たします。
モード設定は TRAKTOR で Preferences > Effects > FX Panel Mode と進みます。

7.8.2 FX ユニットリファレンス
 

以下のリストは FX ユニットの各コントロール機能を表示しています。

コントロール部 シングルモード (Single Mode) グループモード (Group mode)

FX オンボタン 通常は FX ユニット全体を起動/起動解除し
ます (起動すると点灯します)。
SHIFT を使用して FX リストから FX を選
択します (Preferences > Effects > FX
Pre-Selection と進んで設定します)。

通常は使用しません。
SHIFT との併用で、3 種の FX をロードしま
す (Preferences > Traktor Kontrol S2 > S2
Control Options > Direct FX 1-3)。

FX DRY/WET ノブ ドライ/ウェットシグナルバランスを調節します。

ハードウェアコントロールリファレンス
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コントロール部 シングルモード (Single Mode) グループモード (Group mode)

FX ノブ 1-3 FX パラメーター 1-3 (FX により内容が変
化します)。

1 番目、2 番目、3 番目の FX 用パラメーター
です。

FX ボタン 1-3 FX ボタン 1: 全 FX パラメーターをデフォ
ルト値にリセットします。
FX ボタン 2 と 3: FX によって内容が変化
します (起動により点灯)。
SHIFT + ボタンで既存の FX をロードしま
す (Preferences > Traktor Kontrol S2 >
S2 Control Options > Direct FX 1-3 で
内容を設定します)。

FX スロット 1-3 を起動/起動解除 (スロット
が起動すると点灯します)。
SHIFT + ボタンで FX リストの次の FX をス
ロットにロードします (Preferences >
Effects > FX Pre-Selection で設定します)。

FX ユニットをチャンネルにアサインする。
FX ユニットは各チャンネルにアサイン可能で、デッキのシグナルを加工することができます。アサインは任
意のチャンネルで FX アサインボタンを使用します。
TRAKTOR の環境設定で更に 2 つ FX ユニットを追加、起動することも可能です。  4 つの FX ユニットを
使用することで FX ルーティング内容が変更します。

7.9 ブラウズとロード
 

S2 にはトラックとサンプルを探して任意のデッキ、またはサンプルスロットにロードする為のいくつかの手
段があります。

クイックリファレンス↑13.3, FX ユニットクイックリファレンスではブラウズ、ロード、コピーに関
する基本機能を解説しています。

トラックとサンプルのブラウズ
ミキサー中心部にある BROWSE エンコーダーでトラックとサンプルを素早くロードすることができます。
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ミキサーの上部にある BROWSE エンコーダーです。

1. SHIFT を押したまま BROWSE エンコーダーを回してブラウザツリー内を移動します。
2. SHIFT と BROWSE を押してブラウザツリーのフォルダを展開、縮小します。
3. SHIFT を放して BROWSE エンコーダーを回して現在ハイライト表示しているプレイリスト内のトラ

ックを閲覧します。
この動作で TRAKTOR ブラウザがスクロールするか確認してください。
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BROWSE エンコーダーを回して現在選択しているプレイリスト内をスクロールします。

ブラウザ、プレイリスト、お気に入り (Favorites) に関しては TRAKTOR 2 マニュアルを参照してくださ
い。

► 選択したトラック、またはサンプルをデッキにロードするには BROWSE エンコーダーの下
の LOAD ボタン A または B を押します。

例えば SHIFT + 空のサンプルスロットがある CUE/REMIX SLOTS ボタンを押して選択したサンプ
ルをそのサンプルスロットにロードします（Remix Deck モードを起動している場合）。 詳細は↑7.5,
CUE/REMIX SLOTS セクションの使用を参照してください。

7.10 Native TRAKTOR モードと MIDI モード
 

TRAKTOR KONTROL S2 コントローラーでは TRAKTOR モードと MIDI モードの 2 つを使い分けること
ができます。

7.10.1 Native Traktor モード
 

このモードは TRAKTOR の通常使用 (本マニュアルで解説する内容) に用います。
Native Traktor モードでは TRAKTOR KONTROL S2 が USB を介して (Native Instruments 独自の
NHL プロトコルを使用することで、 TRAKTOR KONTROL S2 のノブの動きを MIDI に変換) 直
接 TRAKTOR とやりとりします。

7.10.2 MIDI モード
 

MIDI モードで TRAKTOR KONTROL S2 を MIDI コントローラーとして使用することができます。
MIDI モードで TRAKTOR KONTROL S2 は バーチャル MIDI ポートから、 TRAKTOR KONTROL S2 ド
ライバによる MIDI データのみをホストコンピュータのオペレーションシステムに伝達します。
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S2 を MIDI モードで使用する際は、TRAKTOR の S2 環境設定 （Preferences）で Enable MIDI
mode via Shift + Shift チェックボックスにチェックを入れる必要があります。

S2 の環境設定（preferences）の MIDI Mode セクションです。

► では TRAKTOR KONTROL S2 を用いて MIDI モードと TRAKTOR モードを切り替える方
法を解説します。

► S2 の一方のデッキで SHIFT を押したままもう一方のデッキの SHIFT を押します。

→ MIDI モードを起動すると、SHIFT ボタンが点灯します。
TRAKTOR KONTROL S2 の MIDI プロパティ（例えば MIDI チャンネルや個々のコントロールの CC ナンバ
ー）をカスタマイズするには、Controller Editor を使用します。 コントローラーエディター(Controller
Editor)は TRAKTOR KONTROL S2 インストール過程で既にインストール済みのはずです。 コンピュータ
に Controller Editor が無い場合は TRAKTOR KONTROL S2 のインストールディスクでインストールし
てください。

TRAKTOR モードと MIDI モードは同時に使用することが可能で、例えば TRAKTOR モードで
TRAKTOR を使用し、SHIFT の両方を押して MIDI モードに切り替え、MIDI で他のソフト、ハード
ウェアをコントロールすることができます。
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8 TRAKTOR KONTROL S2 のカスタマイズ
 

TRAKTOR KONTROL S2 はカスタマイズ可能な DJ システムです。 各機能は自分の好みの設定にカスタ
マイズ可能で、カスタマイズ可能な部分は、オーディオ設定、デッキ、ミキサー、トランスポートコントロー
ル、ソフトウェア全体のレイアウト、FX、ブラウザ、ファイル管理機能です。
TRAKTOR KONTROL S2 のカスタマイズをパフォーマンス中に行うのは得策ではないので、これらのカス
タマイズ作業は全てソフトウェア内で完結するようにしてあります。 これにより、ライブ中アクシデントに
よる設定変更を防ぐこともできます。

8.1 環境設定ウインドウ
 

TRAKTOR KONTROL S2 カスタム設定の殆どは環境設定ウインドウで行います。

TRAKTOR ウインドウの右上にある環境設定ボタンです。

► ヘッダ (TRAKTOR の上部) の右にある環境設定ボタン を押して TRAKTOR の環境設定（環
境設定）画面を開きます。

アプリケーションメニューバーの File メニューから Preferences…を選択して開くこともできます。

環境設定ウインドウの設定項目は数ページにわたり、それぞれシステムの特定の機能をカスタムできるように
なっています。
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環境設定ウインドウ

 

TRAKTOR KONTROL S2 - オペレーション マニュアル - 125



環境設定ウインドウの左側のリストがカスタム可能な各機能の見出しとなっています。

1. 設定画面を開くにはリストの見出し部分をクリックします。
2. 必要に応じて設定を変更してください。
3. 設定が終わったら、環境設定ウインドウの下にある Close を押します。
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8.2 S2 コントロール部の設定と環境設定
 

このセクションでは、TRAKTOR KONTROL S2 コントローラーのトップパネルにあるコントロール部の設
定について解説します。 次のセクションでは TRAKTOR KONTROL S2 を使用する際に大切な設定につい
て解説します。

環境設定ウインドウの設定の全詳細に関しては、TRAKTOR 2 マニュアルを参照してください。

環境設定ウインドウの S2 専用設定ページは TRAKTOR KONTROL S2 です。

► 環境設定ウインドウで TRAKTOR KONTROL S2 を押し、TRAKTOR KONTROL S2 コントロー
ラーの設定ページを開きます。
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TRAKTOR KONTROL S2 設定ページです。

このページの各設定項目は S2 Control Options、Restore Default、Calibration 、LEDs となっています。

8.2.1 S2 コントロールオプション
 

環境設定にある TRAKTOR KONTROL S2 ページの S2 Control Options セクションで TRAKTOR
KONTROL S2 コントローラーを好みの設定に調整してください。 以下はこれらのセッティングに関する内
容です。
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Direct FX 1-3
3 つのメニュー Direct FX 1、Direct FX 2、と Direct FX 3 で SHIFT を押すとロードする FX を選択しま
す。

Direct FX 1-3 セッテイングです。

Single モードでは SHIFT + FX ボタン 1、 SHIFT + FX ボタン 2 、または SHIFT + FX ボタン 3 を
押し、選択した Direct FX を各 FX スロットにロードします。 Group モードでは SHIFT + FX On 
を押して 3 つの Direct FX を各 FX スロットにロードします。 詳細は↑7.8, FX ユニットの使用を
参照してください。

Loop Buttons
ループボタン (Loop Buttons) の設定でトラックデッキの LOOP IN と LOOP OUT ボタンの別機能を選択
します。

Loop Buttons セッテイングです。

ループセクションでトラックのループを操作します。 詳細は↑7.3.2, テンポリセットを参照してく
ださい。

オプションは以下となっています。
▪ Manual Looping (デフォルト): このオプションを選択すると、ボタンはマニュアルループ用ボタンとな

ります。
◦ ループが起動していない時に LOOP IN ボタンを押すとフローティングキューポイントを設置し、

LOOP OUT ボタンでループアウトポイントをセットし、フローティングループ (浮動ループ) がこの
ポイント間で起動します。

◦ ループを起動すると、ジョグホイールをまわしながらこれらのボタンを押すことで各ループインポイ
ント、ループアウトポイントを移動させることが可能となります。

▪ Auto Loop : このオプションを選択すると、ボタンはオートループ機能に対応します。
◦ ループを起動していない状態で LOOP IN と LOOP OUT ボタンを使用すると 4-ビートと 8-ビート

のフローティングループが起動します。
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◦ ループ起動時に LOOP IN ボタンを押すとループが半分に、LOOP OUT ボタンを押すと倍になりま
す。

Tempo Faders
テンポフェーダー (Tempo Faders) を設定してテンポフェーダーをアブソルート (Absolute) モードまたは
リレティブ (Relative) モードに切り替えることができます。

Tempo Faders セッティングです。

TEMPO フェーダーはセクション↑7.3, テンポユニットの使用で解説しています。

▪ Absolute (デフォルト): S2 のテンポフェーダーの位置を変更するとソフトウェアデッキのテンポフェ
ーダーがその位置を追従します(セクション↑7.3, テンポユニットの使用参照)。

▪ Relative : このモードで S2 の TEMPO フェーダーでの操作内容はハードウェアのフェーダーの位置と
は関係なくソフトウェアのデッキ上のテンポフェーダーに対応します。この機能はデッキのテンポを他
の方法で変更した場合(デッキを他のテンポに同期した場合、デッキフォーカスを変更した場合、ソフト
ウェアでテンポを変更した場合等)便利です。
◦ これでアクシデントにより TEMPO フェーダーを触ってしまってもテンポが大きく変わることはな

くなります。
◦ Tempo Offset ボタンは Absolute モードの機能と同等です。 TEMPO フェーダーのテンポ可変幅

を調整することも可能です。テンポオフセットボタンの両方が点灯していない状態でこのボタンを
押すと、レンジを上下に調整できます(例、デフォルト値 ±6 % では 6 % 変化します)。 ソフトウェ
アデッキのテンポフェーダーも動作に追従します。

◦ Absolute のように SHIFT を押しながらフェーダーを動かすことで、ソフトウェアのデッキテンポ
を変更することなく TEMPO フェーダーの位置を変更することができます。 これによりソフトウェ
ア上のテンポレンジ幅をカバーできるだけに留まらず、この幅を大きく超えてデッキテンポ可変幅
±100 % を使用することが可能となります (Preferences > Transport > Tempo での設定幅によ
る)。 当然ソフトウェアのテンポフェーダーレンジを越えると、ここでの表示内容はデッキテンポと
は関係ないものとなります。 マウスでソフトウェアフェーダーを動かすことで、デッキテンポはソ
フトウェアのフェーダー位置に戻ります。
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ジョグホイール
Disable Jog Wheel Push チェックボックスにチェックを入れると、ジョグホイールのスクラッチ操作を行
っても反応しなくなります。このオプションは緊急の場合、またはトラックの再生中にスクラッチを行わない
場合に使用します。

LED メーター
LED メーターでは TRAKTOR の内蔵ミキサー内の VU (Volume Units) メーターを表示します。オプショ
ンを Master または PGM にすることでハードウェアの VU メーターの表示内容を切り替えます。
▪ Master: このオプションにすると、LED メーターはマスターバスの現在の出力状況を表示します。
▪ PGM (デフォルト): このオプションにすると、LED メーターはデッキ A/B の現在の PFL (プレフェーダ

ーレベル) を表示します。

8.2.2 デフォルト復元（Restore Default）
 

Restore Default セクションには Restore ボタンがあるのみです。

Restore ボタンです。

このボタンを押すと、TRAKTOR KONTROL S2 をデフォルトの状態に戻す前に、確認メッセージが表示さ
れます。

► Yes をクリックして TRAKTOR KONTROL S2 をデフォルトの状態に戻します。 No を押す
と、何も変更することなく環境設定ウインドウに戻ります。

→ Yes を押すことで 全ての TRAKTOR KONTROL S2 設定がデフォルトの状態となります。
これで TRAKTOR KONTROL S2 をフレッシュな状態から始めることができます。

Setup Wizard を使用してデッキとコントローラーの設定をいつでも再設定することが可能です。
TRAKTOR のアプリケーションメニューバー（フルスクリーンモード以外でこのバーが表示されます）
にある Help メニューから Start Setup Wizard を選択してください。 Setup Wizard に関してはセ
クション↑8.4, セットアップウィザード (Setup Wizard)を参照してください。
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8.2.3 Calibration (キャリブレーション)
 

Calibration セクションで S2 の各ノブとフェーダーをキャリブレーション(較正)し、各コントロール部を最
適な状態に調整します。

Calibration セクションです。

キャリブレーション処理は 4 つの各グループに対して個別に行うことが可能で、専用 Recalibrate ボタンを
押すことで実行します。
▪ FX Knobs: FX ユニットの FX DRY/WET ノブと FX ノブ 1-3 のキャリブレーションを実行します。
▪ EQ Knobs: ミキサーの全てのチャンネルの EQ、FILTER ノブのキャリブレーションを実行します。
▪ Faders: TEMPO とチャンネルフェーダーをキャリブレーションします。
▪ Crossfader: ミキサーのクロスフェーダーのキャリブレーションを実行します。
▪ Jogwheel: チャンネル A/B 用ジョグホイールのキャリブレーションを行います。

8.2.4 LED
 

LED セクションには S2　の全 LED の明るさを調節する為の 2 つのスライダーがあります。
▪ On State Brightness: On の状態の LED の明るさを調節します。
▪ Off State Brightness: Off の状態(薄く点灯)の LED の明るさを調節します。

8.3 その他の設定項目
 

このセクションでは TRAKTOR KONTROL S2 の反応に影響するその他の TRAKTOR 環境設定について解
説します。

8.3.1 デッキの種類の変更
 

TRAKTOR を S2 コントローラーと共に使用する際にデッキの種類を切り替えることは推奨しません。
TRAKTOR と S2 コントローラーを使用する際にはデッキ A/B をトラックデッキモードに、デッキ C/D
は Remix Deck モードにしておく必要があります。
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↑6.1.1, デッキ (Decks)で解説したように、TRAKTOR KONTROL S2 でデッキ C/D をコントロールする
ことが可能です。 しかしデッキ C と D は Remix Decks にしておく必要があります。 設定は
Preferences > Decks Layout > Deck Flavor と進んで行います。

Deck Flavor セクションでデッキ C/D の種類を変更することが可能です。

このセクションでは各メニューが各デッキと連動しています。

► 下段デッキの種類を変更するには、各メニューをクリックして (C または D) ドロップダウン
メニューから Remix Decks を選択します。環境設定 (Preferences) ウインドウの下部にあ
る Close を押して設定内容を適用します。

Setup Wizard を起動してデッキを基本設定の状態にリセットすることも可能です。 Setup Wizard を使用
すると、TRAKTOR の設定を全てデフォルトの状態に戻してしまうので注意してください。 Setup Wizard
の詳細はセクション↑8.4, セットアップウィザード (Setup Wizard)で確認してください。

8.3.2 インプットルーティングの調整
 

TRAKTOR KONTROL S2 のオーディオインプットは TRAKTOR ソフトウェアに完全対応しています。 オ
ーディオインプットは TRAKTOR 内の任意の場所にルーティングすることが可能です。 ルーティング方法
は 2 通りで、Setup Wizard を使用する方法と、TRAKTOR の環境設定を使用する方法があります。

セットアップウィザードの使用
TRAKTOR KONTROL S2 の設定は Setup Wizard を使用するのが一番簡単でしょう。 デッキ設定のどれ
かを選択することで自動的にルーティングが施されるので、オーデーィオルーティングを気にする必要がなく
なります。
Setup Wizard を使用すると、TRAKTOR の設定を全てデフォルトの状態に戻してしまうので注意してくだ
さい。 Setup Wizard の詳細はセクション↑8.4, セットアップウィザード (Setup Wizard)で確認してくだ
さい。

8.4 セットアップウィザード (Setup Wizard)
 

セットアップウィザード(Setup Wizard) で簡単に TRAKTOR KONTROL S2 の設定を行うことができま
す。 Setup Wizard で以下の 2 つを行います。
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▪ ここでは基本設定となるデッキ設定を選択することで、自動的にオーディオルーティングを行います。
▪ これにより TRAKTOR KONTROL S2 の全設定をデフォルトの状態にリセットします。

Setup Wizard の起動方法は以下です。

► アプリケーションメニューバーの Help メニューで Start Setup Wizard を選択する方法 (こ
のバーはフルスクリーンモードでは表示されません)。

または

► 環境設定ウインドウの左下隅にある Setup Wizard ボタンを押します。

セットアップウィザード (Setup Wizard)

Setup Wizard のメニューは一つで、ここで以下の設定内容の一つを選択します。選択肢は 2 Track Decks
(デフォルト)、2 Track Decks + 2 Remix Decks、4 Track Decks、2 Track Decks + 2 Live Inputs で
す。
各デッキ設定内容は名称が示す通りです。
TRAKTOR KONTROL S2 からは 2 Track Decks + 2 Remix Decks 設定によるコントロールが可能とな
ります。
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► メニューで任意のデッキ設定を選択し、Finish を押して設定内容を適用、(または Cancel をク
リックして設定内容を変更せずに Setup Wizard を終了します)。 TRAKTOR
KONTROL S2 コントローラーを使用する際には、 2 Track Decks + 2 Sample Decks 設定
を使用します。

→ Setup Wizard が選択したデッキ設定を実行し、オーディオルーティングとその他の
TRAKTOR 設定をデフォルト値にリセットします。
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9 S2 オーディオインターフェイスとコントロールパ
ネル

 

TRAKTOR KONTROL S2 は高品質 24-bit/96 kHz オーディオインターフェイスを内蔵しています。 コン
ピュータの性能と使用用途に合わせてオーディオインターフェイスの設定を調整してください。
Windows または Mac OS X を使用するかで、これらの設定内容を調節します。

9.1 Mac OS X の設定
 

Mac OS X では各音楽アプリケーションごとに S2 オーディオインターフェイスの設定を設定することが可
能です。TRAKTOR では以下のように設定を行って下さい。

► Preferences > Audio Setup と進んで S2 オーディオインターフェイスの設定画面に進みま
す。

ここで TRAKTOR KONTROL S2 のオーディオインターフェイスの設定を行います。 セッテイングは 2 通
りあります。
▪ サンプルレート (Sample Rate) : 使用している音楽アプリケーションに対応したサンプル・レートを選

択してください。サンプルレートを高くするほど CPU ロードも高くなります。デフォルトでサンプル
レートは 44100 Hz (CD の音声品質と同等) に設定してあります。

サンプルレートでサウンドを 1 秒間にどれだけ録音/再生するか設定します。高いサンプルレートに
なるほど音質がよくなります。44100 Hz (CD 規格) が一般的な値です。録音媒体が CD である場合
はこの設定、または倍に設定します(88200 Hz)。48000 Hz は DAT または DVD (映画)用規格値で
す。96000 Hz は DVD、 HD DVD、Blue-ray Disc で使用します。サンプルレートを高くするほど
CPU ロードも高くなります。

▪ レイテンシー (Latency) : レイテンシーを下げるほど、コンピュータの TRAKTOR コントローラー、ソ
フトウェアに対する反応が早くなります。
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オーディオをデジタル、またはアナログ変換する場合、オーディオドライバがデータをバッファとし
て保管する必要があり(オーディオバッファ)、 これらは CPU によって処理、送信されます。バッフ
ァサイズが大きくなるほど、シグナルがアウトプットまで到達するまでの時間がかかります。この時
間差はコンピュータの音楽ソフトウェアをコントロールする場合コントローラーのキーを押したと
き、またはアウトプットのサウンドの反応が遅れる際に実感できるものです。 この遅れをレイテンシ
ーと呼びます。この設定の際は速いレイテンシー値から始めて、演奏と音声に問題がなくなるまでこ
の値を徐々に下げることで設定するとよいでしょう。音声に問題が生じる場合は、使用しているコン
ピュータの CPU では現在のレイテンシー値が適切で無いことを意味します。

9.2 Windows での設定: コントロールパネル
 

Windows で TRAKTOR KONTROL S2 オーディオインターフェイスの設定は Traktor Kontrol S2 コント
ロールパネルで行います。 コントロールパネルは S2 コントローラー用ドライバと共に TRAKTOR
KONTROL S4 のインストールの際にインストールされているはずです。 このセクションでは Traktor
Kontrol S2 コントロールパネルユーザーインターフェイスについて解説します。

9.2.1 コントロールパネルを開く
 

コントロールパネルを開く方法はいくつかあります。

► TRAKTOR PRO で Preferences > Audio Setup と進み、Latency スライダーとディスプレ
イの右にある Settings ボタンをクリックします。

► デスクトップからは Start > Programs > Native Instruments > TRAKTOR KONTROL S2
> TRAKTOR KONTROL S2 Control Panel と進みます。

以下がコントロールパネルです。
左には Audio Settings と Diagnostics のタブがあります。

► 左のタブをクリックしてコントロールパネルを開きます。
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9.2.2 Audio Settings ページ
 

Audio Settings ページでオーディオインターフェイスの設定を調節します。

Audio Settings ページを開いた状態の Control Panel です。

Audio Settings ページには 2
つのセクションがあります。
▪ Audio Processing: オーディオインターフェイスで処理されるアナログ-デジタル/デジタル-アナログ変

換の設定を行います。
▪ Device Monitor: オーディオインターフェイスの処理状況とシステムのアウトプットレイテンシーを表

示します。

Audio Processing セクション
Audio Processing セクションには 2 つのメニューと 1 つのディスプレイがあります。
▪ サンプルレート (Sample Rate) : 使用している音楽アプリケーションに対応したサンプル・レートを選

択してください。サンプルレートを高くするほど CPU ロードも高くなります。デフォルトでサンプル
レートは 44100 Hz (CD の音声品質と同等) に設定してあります。
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サンプルレートでサウンドを 1 秒間にどれだけ録音/再生するか設定します。高いサンプルレートに
なるほど音質がよくなります。44100 Hz (CD 規格) が一般的な値です。録音媒体が CD である場合
はこの設定、または倍に設定します(88200 Hz)。48000 Hz は DAT または DVD (映画)用規格値で
す。96000 Hz は DVD、 HD DVD、Blue-ray Disc で使用します。サンプルレートを高くするほど
CPU ロードも高くなります。

▪ Process Buffer : バッファサイズを下げるほど、コンピュータの TRAKTOR コントローラー、ソフトウ
ェアに対する反応が早くなります。

オーディオをデジタル、またはアナログ変換する場合、オーディオドライバがデータをバッファとし
て保管する必要があり(オーディオバッファ)、 これらは CPU によって処理、送信されます。バッフ
ァサイズが大きくなるほど、シグナルがアウトプットまで到達するまでの時間がかかります。この時
間差はコンピュータの音楽ソフトウェアをコントロールする場合コントローラーのキーを押したと
き、またはアウトプットのサウンドの反応が遅れる際に実感できるものです。 この遅れをレイテンシ
ーと呼びます。 バッファサイズを下げるほどレイテンシー値も下がります。 レイテンシーにはバッ
ファサイズの他にも原因となる要素があります(例、CPU スピードと RAM サイズ)。この設定の際は
高いバッファサイズ設定から始めて、演奏と音声に問題がなくなるまでこの値を徐々に下げることで
設定するとよいでしょう。オーディオインプットに問題が生じる場合は、使用しているコンピュータ
の CPU では現在のバッファサイズが適切では無いことを意味します。

▪ USB Buffer: Process Buffer メニューで満足行くレイテンシー設定を得られない場合は、このメニュー
を使用します。USB バッファサイズの値を下げることでオーディオレイテンシーを少なくします。音声
にクリック音声等のノイズが入る場合は、音声に支障がなくなるまでバッファサイズを上げます。

Device Monitor セクション
Device Monitor セクションには 2 つのディスプレイがあります。
▪ Processing State : このモニターでは機器の現在の状態を表示します。表示内容は以下の 3 つです。

◦ Idle: コントローラーは接続した状態ですが、音声情報がありません。
◦ Streaming: ドライバが起動しており、音声を処理していることを示します。
◦ Panic: ドライバが起動停止した状態です。これはインターフェイス内のコミュニケーション中に処

理しきれない程 USB I/O エラーが生じたことを意味します。
▪ Output Latency : システムのアウトプットレイテンシーをミリ単位で表示します。

TRAKTOR KONTROL S2 の使用の際にはインプットレイテンシーも生じることもお考えください。 アウ
トプットレイテンシー値はコントローラーのボタンを押してアウトプットされるまでの、レイテンシー全体を
表示するわけではありません。 全レイテンシーはアウトプットレイテンシーの約 2 倍となります。
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9.2.3 Diagnostics ページ
 

Diagnostics ページでコントローラーのパフォーマンスをモニターし、エラーを検出します。

Diagnostics ページを表示した状態のコントロールパネルです。

Diagnostics ページの情報は上級者向けとなっていますが、問題がある場合はこのページを参照することを
お勧めします。
Diagnostics ページには 3 つのセクションがあります。
▪ Drop-Out Detection: USB I/O エラーと、検出されたバッファアンダーラン (underruns) を表示しま

す。
▪ Connection Monitor: クライアント-ドライバコネクションと、検出された USB データエラーを表示し

ます。
▪ System Performance Test: パフォーマンステストを行いレイテンシー値を計測します。

S2 オーディオインターフェイスとコントロールパネル
Windows での設定: コントロールパネル

 

TRAKTOR KONTROL S2 - オペレーション マニュアル - 140



▪ Information: ドライバとファームウェアのバージョンを表示します。トラブルシューティングへのリン
クもあります。

Drop-Out Detection セクション
Drop-Out Detection セクションには 2 つのディスプレイと 1 つのボタンを備えています。
▪ USB I/O Errors: USB のインプット/アウトプットエラーを表示します。USB I/O Errors の数値はシ

ステムのオーバーロード回数を表示します。
▪ Buffer Underruns: バッファアンダーラン (Buffer underruns) はオーディオバッファを正確に処理で

きなかった場合に生じます。扱いきれない程のバックグラウンド処理が行われている場合、オーディオド
ライバとして機器を使用する音楽プログラム内の CPU 負荷が高すぎる場合にこのアンダーランが生じ
ます。

▪ Reset: このボタンをクリックしてエラーカウントをリセットします。

Connection Monitor セクション
Connection Monitor セクションには 2 つのディスプレイと 1 つのボタンがあります。
▪ Number of Clients: インターフェイスに接続してあるクライアントの数を表示します。マルチ ASIO

アプリケーションは個別に数えられ、WDM と WASAPI では 複数の WDM/WASAPI アプリケーション
でオーディオを再生していても、 単体 (1 個) として数えます。

▪ USB Data Errors: USB データエラーをカウントします。程度の悪いケーブル、または非常に長いケー
ブルは USB バスのデータエラーの原因となる可能性があります。

▪ Reset: このボタンをクリックしてエラーカウントをリセットします。

System Performance Test Section (システムパフォーマンステストセクシ
ョン)
▪ Current Latency: 下の Start ボタンをクリックして現在のレイテンシー値を表示します。
▪ Maximum Latency: 最新の計測情報から検出した最高値を表示します。

◦ Reset のクリックは Start を始めてクリックしたときとどうとの機能を果たします。テスト過程を
リセットし、新規テストを行います。

◦ Stop をクリックするとテストが終了します。Maximum Latency 値は表示されたままとなります。

Information セクション
Information セクションには 2 つのディスプレイと 1 つのボタンがあります。
▪ Driver Version: ドライバのバージョンをここで確認します。
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▪ Firmware Version: ファームウェアのバージョンをここで確認します。
▪ Troubleshooting Guide: Show をクリックしてトラブルシューティングガイドを開きます。

9.3 S2 をデフォルトオーディオアウトプットインターフェイス
として使用する

 

使用しているコンピュータの全ての音声再生用に TRAKTOR KONTROL S2 を使用するには、本機器をデフ
ォルトオーディオインターフェイスとして設定する必要があります。

9.3.1 Windows
 

Windows 7 （以降）で TRAKTOR KONTROL S2 をデフォルトインターフェイスとして使用する方法は以
下の通りです。
1. Start > Control Panel > Sound と進みます。
2. Playback タブを選択します。
3. 機器リストで TRAKTOR KONTROL S2 を選択し、Set Default をクリックします。
4. Recording タブを選択します。
5. 機器リストで TRAKTOR KONTROL S2 を選択し、Set Default をクリックします。
6. OK をクリックしてダイアログを閉じてください。

9.3.2 Mac OS X
 

Mac OS X で TRAKTOR KONTROL S2 をデフォルトインターフェイスとして使用する方法は以下の通り
です。
1. Apple メニューで System Preferences (システム環境設定)を選択します。
2. 表示されるパネルで Sound をクリックします。
3. Sound Effects タブの Play alerts and sound effects through メニューで TRAKTOR

KONTROL S2 を選択します。
4. Output タブをクリックして Choose a device for sound output リストから TRAKTOR

KONTROL S2 を選択します。
5. Input タブをクリックして Choose a device for sound input リストから TRAKTOR

KONTROL S2 を選択します。
6. ウインドウを閉じて設定内容を適用します。
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10 トラブルシューティングとヘルプ
 

この章ではよくあるトラブルの解決法を解説しています。 TRAKTOR KONTROL S2 の設定と使用時に起
こりうる一般的な問題はここで解説、解決可能です。

10.1 TRAKTOR が起動しない
 

1. TRAKTOR KONTROL S2 の動作環境を確認してください。 ここで必要最低条件を満たしている場合
でも、高次機能 (例 キーロック、FX) の使用の際に支障をきたす場合があります。 RAM 容量を増やす
ことでこの問題を大幅に回避可能です。

2. 最新の TRAKTOR バージョンを使用しているか確認してください。
3. クリックしたアプリケーションのエイリアス、またはショートカットが有効なものか確認してくださ

い。
4. コンピュータを再起動してください。他のオーディオインターフェイスとコンピュータで使用してい

る周辺機器等の接続をはずしてください。
5. TRAKTOR KONTROL S2 のルートフォルダにある collection.nml ファイルを名称変更し、実質コレ

クションが無い状態で TRAKTOR を再起動し、名称変更したコレクションを再インポートしてくださ
い。ルートフォルダの詳細に関しては TRAKTOR マニュアルを参照してください。

10.2 ハードウェアに関する問題
 

このセクションでは TRAKTOR KONTROL S2 コントローラーに問題がある場合にまずチェックしておく
べき項目を連ねておきます。

10.2.1 ベーシック
 

当たり前のことばかりですが、まず以下の項目をチェックしてください。
▪ TRAKTOR KONTROL S2 を USB ケーブルを用いてコンピュータに接続しているか確認してくださ

い。
▪ コントローラーのスイッチ (リアパネルの ON/OFF) をオンの状態にしてください。

10.2.2 USB とドライバの問題
 

TRAKTOR KONTROL S2 が接続してあり、オンの状態であることを確認してから、機器の中央部にあるマ
スターディスプレイ(Master Display)の USB インジケーターが点灯するか確認してください。

トラブルシューティングとヘルプ
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マスターディスプレイの USB インジケーターです。

USB が点滅する場合は、コンピュータに何も接続されていない、またはハードウェアドライバに問題がある
ことを意味します。では以下の項目を確認してください。
▪ TRAKTOR KONTROL S2 は USB 2.0 を使用する機器で、USB 1.0/1.1 ポートを使用することはでき

ません。
▪ 程度の悪い USB ケーブルはオーディオの接続問題の原因となる可能性があります。正式な USB ロゴ表

示のあるケーブルを使用してください。短いケーブルが有効な場合もあります。
▪ Windows: ドライバを正しくインストールしているか確認してください。 TRAKTOR KONTROL S2

コントロールパネルがあるか確認することで(セクション↑9.2.1, コントロールパネルを開く参照)ドラ
イバの有無を確かめることが可能です。 コントロールパネルが見つからない場合はドライバをインスト
ールしていない可能性が高いです。 この場合別途のセットアップガイドで解説するように TRAKTOR
KONTROL S2 インストールディスクを用いてドライバをインストールしてください。

10.2.3 ドライバのアップデート
 

► NI Service Center を定期的に訪れ、ドライバのアップデートをチェックしてください。

10.2.4 USB に関連する電源の問題
 

S2 の使用の際は外部電源と共に内蔵電源供給ユニットを使用することを強く推奨します。USB 接続による
電源のみで S2 を使用することは可能ですが、ヘッドフォンの出力は低減し、全ての LED も通常より暗く点
灯します。
外部電源を使用できない場合は、以下の点に注意してください。
▪ この USB 2.0 ポートは最小電力を (500 mA) を必要とします。 コンピューターによっては USB 2.0

の使用必要条件を満たさないので USB 2.0 を使用することが出来ません。 この場合、機器を有効に作動
させるための電力が無いという趣旨のメッセージが現れます。 このまま TRAKTOR KONTROL S2 を
使用すると、雑音が生じる、または完全に作動しない場合もあります。

▪ 以上を行っても問題が改善されない場合は、TRAKTOR KONTROL S2 以外の全ての USB 機器の接続を
はずして動作確認を行ってください。

トラブルシューティングとヘルプ
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▪ 使用しているコンピュータが十分なバス電源を供給しない場合は、TRAKTOR KONTROL S2 を外部電
源供給機能付 USB 4 ハブに接続してください。 ハブに他のデバイスを接続することは、使用できる電源
の総量が減少する場合があるので避けた方がいいでしょう。

これらの弱点を解消するには、S2 に外部供給電源を接続するのが一番です。

S2 を iOS デバイスの TRAKTOR DJ に対して使用する場合、Native Instruments iOS ケーブルで
充電することができます。

10.2.5 TRAKTOR KONTROL S2 をラップトップで使用する。
 

始めに、使用しているコンピュータにオーディオドロップアウトがなく、リアルタイムオーディオ処理に適し
ているかを確認してください。 TRAKTOR KONTROL S2 のコントロールパネルには動作を確認する為の
便利なツールがあります。 詳細は↑9.2.2, Audio Settings ページ章で確認してください。
一般的に共有メモリグラフィックカードをラップトップに使用することは推奨されていません。オーディオ
ソフトウェアの処理を円滑に行うには十分なメモリと的確な処理精度が必要です。
ラップトップをライブ用に使用するには、以下の点を確認してください。
▪ ラップトップをバッテリーのみで使用すると、パワーマネージメントシステムがバッテリーを節約し、

CPU のクロックレートを遅くすることがあるので、バッテリーのみの使用は推奨しません。
▪ 演奏中に使用しない機器は外して下さい。(例、プリンター、スキャナー等)。 使用しない機器を外すこと

で音楽ソフトに対する処理能力が向上します。
▪ ラップトップにはオーディオ処理を妨げるネットワークアダプターや、ワイヤレス LAN カード等の内蔵

デバイスが装備されていることが多々あります。 これらの機器も TRAKTOR KONTROL S2 を使用し
ている時は、無効にしておく必要があります。

10.3 ジョグホイールトッププレートがゆるい
 

TKS2 のジョグホイールの交換は簡単です。大きな衝撃や移動中の激しい振動でジョグホイールがゆるくな
ったり、コントローラーから外れてします場合があります。
ジョグホイールは簡単に取り付けを行うことが可能です。以下がその方法です。
1. トッププレートの接続ピンをジョグホイール取り付け部のクリップにあてがいます。
2. 片手でホイールのゴムのリム部を持ちます。
3. もう一方の手でジョグホイールの丸い中心部にプレートを押し、プレートを左回ししてピンをクリップ

に固定します。

トラブルシューティングとヘルプ
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正しくはめ込むことができると、ホイールは再び固定されます。それでもまだゆるい場合は、もう一度同様の
作業を行ってください。ジョグホイールのトッププレートの取り付け、取り外しを行った後はキャリブレーシ
ョンを行うことを推奨します 。 ジ ョ グ ホ イ ー ル の キ ャ リ ブ レ ー シ ョ ン に 関 し て は 、 TRAKTOR 2
documentation フォルダにある Jog Wheel Calibration Guide を参照してください。ガイドは本来
TRAKTOR KONTROL S4 用のものですが、ジョグホイールのキャリブレーション方法は全く同じです。

10.4 TRAKTOR がクラッシュする
 

ランタイム中にクラッシュする場合は、Native Instruments のテクニカルサポートチームに連絡、クラッシ
ュログを提出してください。クラッシュログは以下のフォルダにあります。
▪ Windows: \My Documents\Native Instruments\Traktor 2\Crashlogs\
▪ Mac OS X: Users/~/Library/Logs/CrashReporter/

10.5 ヘルプ
 

10.5.1 ナレッジベース /リードミー / オンラインサポート
 

► サービスセンター (Service Center) アプリケーションを起動して右上隅にあるサポート
(Support) ボタンをクリックします。ここには Native Instruments オンラインナレッジベー
ス (Online Knowledge Base) と オンラインサポートフォーム (Online Support Form)
へのダイレクトリンクを用意しています。

オンラインナレッジベースでは Native Instruments 製品の有用な情報をまとめており、また Native
Instruments 製品を使用する際に生じる問題の解決の糸口となるヒントを多数用意しています。
問題をナレッジベースで解決できない場合は、オンラインサポートフォーラムを使用して Native
Instruments のテクニカルサポートチームに相談することも可能です。オンラインサポートフォームで使用
しているハードウェア、ソフトウェアについてお答えください。ここでの情報は今後サポートチームが問題発
生時に効率よく対応する為の資料となります。
Native Instruments サポートチームとコンタクトをとる際、ハードウェア、オペレーションシステム、使用
しているソフトウェアのバージョン情報、問題の詳細をチームに伝えることが問題を解決する為に非常に有効
となります。情報として提示すべき情報は以下となっています。
▪ 問題に到達するまでの操作手順
▪ 問題解決するために自分で試した解決策
▪ ハードウェアを含む使用しているセットアップの内容
▪ 使用しているコンピュータの機種を含む正確な情報

トラブルシューティングとヘルプ
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新規ソフトウェア、またはソフトウェアをインストールした場合、Readme ファイルに資料に含まれていな
い最新情報を書き添えてある場合があります。テクニカルサポートにコンタクトする前に Readme をお読
みください。

10.5.2 フォーラム
 

Native Instruments ユーザーフォーラムでは他のユーザーやフォーラムの中心人物となるフォーラムの専
門家と製品について直接会話することが可能です。
http://www.native-instruments.com/forum

10.6 アップデート
 

問題に直面した場合は、まずソフトウェアのアップデートを確認、ダウンロードし、インストールすることを
お勧めします。アップデートは頻繁に起きる問題を解決、ソフトを向上させる為に定期的に行います。ソフト
ウェアのバージョン番号は Native Instruments 各アプリケーションの About ダイアログで表示可能です。
このダイアログはユーザーインターフェイスの右上隅の NI ロゴをクリックしても開くことができます。更
にインストールしてある全 Native Instruments アプリケーションのバージョン番号はサービスセンターの
製品一覧ページでも確認することができます。アップデートはサービスセンターの アップデートページ、ま
たは 以下当社ウェブサイトから行うことも可能です。
http://www.native-instruments.com/updates

トラブルシューティングとヘルプ
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11 付録 A – 一般的な設定
 

この付録では TRAKTOR KONTROL S2 を他の機器に接続する方法を段階的に説明します。
TRAKTOR KONTROL S2 のフロント、リアパネルにある各端子とコントロール部の詳細に関してはセクシ
ョン↑6.2, リアパネルと↑6.3, フロントパネルを参照してください。
これらの設定内容を使用するにはまず TRAKTOR KONTROL S2 をコンピュータに正しくインストールし
てから行ってください。 インストールの詳細に関しては別途のセットアップガイドを参照してください。
ここではまず基本的なセットアップを紹介します。その後各設定応用例について解説します。

11.1 TRAKTOR KONTROL S2 基本設定
 

この設定が最も一般的な例です。この設定はセットアップガイドでも解説しており、殆どのチュートリアルで
使用する設定内容です。
この設定には S2、コンピュータ、ヘッドフォン、アンプシステムが必要となります。

パワーサプライの接続
1. 同封してある電源部を使用国のコネクターを使用して電源プラグに差し込みます。

付録 A – 一般的な設定
TRAKTOR KONTROL S2 基本設定
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2. 電源部を S2 のリアパネルの電源供給コネクター(POWER) に接続します。

S2 の使用の際は外部電源と共に内蔵電源供給ユニットを使用することを強く推奨します。 USB 接続による
電源のみで使用することは可能ですが、ヘッドフォンの出力は低減し、全ての LED も通常より暗く点灯しま
す。 更に使用機器が USB 電源に関連した問題にさらされる場合があります(セクション↑10.2.4, USB に
関連する電源の問題参照)

旧型の TRAKTOR KONTROL S2 Mk1 電源部を使用すると、S2 Mk2 デバイスに十分に電源を供給
できません。

付録 A – 一般的な設定
TRAKTOR KONTROL S2 基本設定
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USB を使用して S2 をコンピュータに接続する
► USB 2.0 ケーブルの一方を S2 のリアパネルにある USB 端子に接続、もう一方の端子をコン

ピュータの USB 2.0 ポートに接続します。

TRAKTOR KONTROL S2 は USB 2.0 を使用する機器で、USB 1.0/1.1 ポートを使用することはできませ
ん。

付録 A – 一般的な設定
TRAKTOR KONTROL S2 基本設定
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全てのボリュームコントロール部を下げる
► オーディオケーブルを接続する前に、S2 とアンプシステムの全てのボリュームノブを下げて

ください。これで聴覚にダメージを与えるようなノイズ等の発生を事前に防ぎます。

付録 A – 一般的な設定
TRAKTOR KONTROL S2 基本設定
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メインアウトプットをアンプシステムに接続する
► S2 のリアパネルの メインアウトプット 1/2 用 1/4" 端子(バランスド) または RCA 端子(ア

ンバランスド) からそれぞれのケーブルを用いてアンプシステム、またはスピーカーに接続し
ます。

付録 A – 一般的な設定
TRAKTOR KONTROL S2 基本設定
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PHONES 端子(フロントパネル)にヘッドフォンを接続する
► S2 のフロントパネルで、ヘッドフォンをヘッドフォン端子(PHONES)に接続します。

ヘッドフォンを接続する際は常に、ヘッドフォンボリュームノブ (CUE VOL) を最小にしてから行ってくださ
い。ヘッドフォンボリュームを最小値にするには CUE VOL を反時計回りに回しきってください。その後音
声を再生して徐々に CUE VOL ノブを右に回すことで音量を上げて適切な音量にしてください。

付録 A – 一般的な設定
TRAKTOR KONTROL S2 基本設定
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S2 の起動
1. S2 のリアパネルの ON/OFF スイッチで機器を起動します。

2. コントローラーのトップパネルを確認してください。LED が点滅した後、マスターディプレイの USB
インジケーターが点滅し、完全に起動すると点灯した状態となります。これでコンピュータが S2 を認
識したことになります。

USB インジケーターが点滅し続ける場合は、USB 接続、またはドライバに問題があります。 セクション↑
10.2, ハードウェアに関する問題を参照して問題の解決に役立ててください。

TRAKTOR の起動
TRAKTOR ソフトウェアを起動するには、例えばデスクトップのエイリアス、またはショートカットをダブ
ルクリックします。TRAKTOR ウインドウが開きます。

TRAKTOR のデッキの種類を設定する
ここで解説するように手動でデッキの種類を設定する代わりに、Setup Wizard のメニューで 2 Track
Decks + 2 Remix Decks を選択して Finish をクリックすることで自動的に設定を行うことも可能です。
Setup Wizard を使用すると、TRAKTOR の設定を全てデフォルトの状態に戻してしまうので注意してくだ
さい。 Setup Wizard の詳細はセクション↑8.4, セットアップウィザード (Setup Wizard)で確認してくだ
さい。
TRAKTOR ソフトウェアで、下段のデッキ C と D を Remix Deck にします。

付録 A – 一般的な設定
TRAKTOR KONTROL S2 基本設定
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1. TRAKTOR のヘッダの環境設定ボタンをクリックして環境設定ウインドウを開きます。

2. Preferences > Decks > Deck Flavor と進み、C/D のメニューで Remix Deck を選択します。

3. 環境設定 (Preferences) ウインドウの下部にある Close を押して設定内容を適用します。

ノート
▪ S2 のトップパネルの中央部にある MAIN LEVEL ノブとメーターを使用して全体のアウトプットレベル

を調節します。

▪ S2 フロントパネルの各 CUE VOL と CUE MIX ノブでヘッドフォンのボリューム調整と、キューシグナ
ルとマスターシグナルの音量バランスをコントロールします。

11.2 マイクの追加
 

上記の基本設定にマイクを追加し、TRAKTOR KONTROL 2 の AUX チャンネルで使用する方法を解説しま
す。

付録 A – 一般的な設定
マイクの追加
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この設定を行う前に、セクション↑11.1, TRAKTOR KONTROL S2 基本設定で解説した設定を完了させて
ください。

MIC 端子にマイクを接続する

MIC 端子と GAIN ノブです。

マイクを接続する前に、MIC 端子の隣の GAIN/FILTER ノブが下がりきっているか確認してください。
1. S2 のリアパネルの一番左のマイクセクションにあるマイク端子に (MIC)マイクを接続します。
2. S2 のフロントパネルの左側にある MIC ENGAGE ボタンを押します。　
3. S2 のリアパネルにあるマイク用 GAIN ボリュームコントロールを徐々に上げます。

付録 A – 一般的な設定
マイクの追加
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12 付録 B – 技術情報
 

ここには TRAKTOR KONTROL S2 の技術仕様を掲載しています。

12.1 技術仕様書
 

ジャックと端子
▪ モノ 6.3 mm (1/4 inch) フォン プラグ用 1 インプットジャック (MIC)
▪ 6.3 mm (1/4 inch) TRS (バランスド) フォノ プラグ用 2 アウトプットジャック (MAIN OUT 1/2)
▪ モノ (アンバランスド) RCA プラグ用 2 アウトプットジャック (MAIN OUT 1/2)
▪ ゲインコントロールとミュートボタン付きマイクインプット
▪ ステレオ 6.3mm (1/4 inch) フォノプラグ用 1 ヘッドフォンジャック
▪ 1 盗難防止スロット
▪ 1 USB 2.0 Type B
▪ 1 パワーサプライコネクター

12.2 環境仕様
 

▪ 作業可能気温 +5 から +35 °C (41 から 95 °F) (85% 凝縮湿度では無い通常湿度)
▪ 保管気温 0  C から 40°C (32°F から 104°F) (85% 凝縮湿度ではない通常湿度)

高い湿度の場所、直射日光の当たる場所で本機を設置しないでください。

付録 B – 技術情報
技術仕様書
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13 付録 C – クイックリファレンス
 

この付録では、TRAKTOR KONTROL S2 各部のコントロール部の基本機能をクイックリファレンスとして
記載しています。 ここでコントローラーの基本機能を簡潔に紹介します。 各コントロール部の詳細に関し
ては↑6, ハードウェア 概観章を参照してください。

13.1 クイックリファレンス
 

↑7, ハードウェアコントロールリファレンス章でコントロール各部の詳細を確認してください。

コントロール部 機能

Remix モードボタン A/B
(REMIX ノブの下)

CUE/REMIX SLOTS ボタンで Remix Deck モードに切り替えます。 Remix
Deck モードが起動すると点灯します。 CUE/REMIX SLOTS セクションモードの
詳細は↑7.5, CUE/REMIX SLOTS セクションの使用を参照してください。

ロードボタン A/B (BROWSE エ
ンコーダーの下)

通常は各デッキに選択したトラックをロードする機能を果たします。
SHIFT と共に使用すると、反対側のトラックデッキの内容をデッキにコピーします。
ジョグホイールのトップパネルを押すと光ります。

ジョグホイール 外輪に触れることでテンポベンド機能を使用できます。
トッププレートでスクラッチします。
SHIFT + トッププレートでトラック内を素早く移動します。
ループ中に LOOP IN / LOOP OUT ボタンのどちらかを押しながらジョグホイール
をまわすことで各ループイン/ループアウトポイントを微調整することができます。

テンポフェーダー デッキのテンポを調節します。
SHIFT と併用することでテンポを変更することなくフェーダーの位置を移動するこ
とができます。

FLUX ボタン ここを押すと TRAKTOR の Flux モードを起動します。
SHIFT + FLUX でデッキテンポをリセットします。

付録 C – クイックリファレンス
クイックリファレンス
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コントロール部 機能

LOOP IN ボタン 現在の再生位置にフローティングキューポイント(浮動キューポイント)を再生を停
止することなく設定します。フローティングキューポイントは LOOP OUT ボタン
を押すことでループインポイントに変化します (以下参照)。
再生内容が起動しているループ内である場合は、LOOP OUT も点灯します。
ループを起動している状態でここを押し続けるながらジョグホイールを操作するこ
とでループインポイント (Loop In Point) を調節することができます。

LOOP OUT ボタン ループアウトポイント (Loop Out Point) を現在の再生位置に設置し、先ほど設置し
たフローティングキューポイントとこのループアウトポイントによるフローティン
グループを起動します。
ループを起動している場合、 再生位置がループ内である場合は LOOP IN と共に点灯
し、起動しているループの外を再生している場合はこのボタンのみが点灯します。
ループを起動している状態でここを押し続けるながらジョグホイールを操作するこ
とでループアウトポイント (Loop Out Point) を調節することができます。

LOOP MOVE エンコーダー 設定したループを解除します。
ループを起動した状態で、ここを回すとループがステップ単位で移動します。SHIFT
+ 回す動作でループを 1 ビート単位で移動します。
ループを起動していない状態で、ここを回すと選択したループサイズ（値はソフトウ
ェアのループコントロール部で確認できます）でトラックが移動します。SHIFT +
回す動作で 1 ビート単位で移動します。

LOOP SIZE エンコーダー 押すことでループを起動/起動停止します。選択したループサイズで現在の再生位置
にフローティングループを設置、自動的にループを起動します。
ループを起動していない状態で回すと、次のフローティングループ用のループサイズ
をビート単位で選択することができます。ループサイズはソフトウェアのループコ
ントロール部で確認できます。
ループを起動した状態で回すと、現在のループのサイズを半分/倍にします。

PLAY ボタン 再生を開始/停止します。再生中はボタンが点灯します。
SHIFT + PLAY でキーロックを起動、起動解除します(ソフトウェアのループイン、
ループアウトボタンの真上にある KEYLOCK インジケーターが点灯します)。

CUE ボタン デッキの再生中にこのボタンを押すと、フローティングキューポイント (Floating
Cue Point) にジャンプして停止します。
デッキを停止している状態でこのボタンを押すと、新規フローティングキューポイン
トを設置します。CUE ボタンを押している間トラックはその位置からの再生を続け
ます。ボタンを放すと、配置したフローティングポイントに戻り停止します。
SHIFT と CUE でトラックの最初に戻ります。

付録 C – クイックリファレンス
クイックリファレンス
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コントロール部 機能

SYNC ボタン テンポマスターへの同期機能を起動/解除します (シンクを起動すると点灯します)。
SHIFT と SYNC でデッキをテンポマスターとしてセットします (デッキディスプレ
イの MASTER インジケーターが点灯します)。
SHIFT を押したまま SYNC を 1 秒以上押すと、ビートグリッドが現在のシンク参照
内容を元にビートグリッド (Beatgrid) をマッチさせます。

SHIFT ボタン このボタンを押し続けることで他のコントロール部の二次機能にアクセス可能とな
ります。
5 回以上タップすることでトラックのビートグリッドを修正します。

13.2 ミキサークイックリファレンス
 

BROWSE エンコーダーの解説は↑13.3, FX ユニットクイックリファレンスを参照してください。

↑7, ハードウェアコントロールリファレンス章でコントロール各部の詳細を確認してください。

13.2.1 メインセクションクイックリファレンス
 

コントロール部 機能

MAIN LEVEL ノブ S2 のメインアウトプットに送信する音量を調節します。

13.2.2 チャンネル/クロスフェーダークイックリファレンス
 

コントロール部 機能

GAIN エンコーダー 回すとそのチャンネルのインプットゲインレベルを調節します(チャンネルフェ
ーダーと MAIN ボリュームコントロールより前の段階の音量設定です)。
押すことでインプットゲインを 0 dB にリセットします。

FX アサインボタン 1/2 通常は FX Unit 1/2 にチャンネルをアサインします。
(4 つの FX ユニットの使用方法についてはセクション↑7.8, FX ユニットの使
用を参照してください。)

付録 C – クイックリファレンス
ミキサークイックリファレンス
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コントロール部 機能

高周波数帯域ノブ (High-frequency、
HI)

シグナルの高周波数帯域を調整します。

中周波数帯域ノブ (Mid-frequency、
MID)

シグナルの中周波数帯域を調整します。

低周波数帯域ノブ (Low-frequency、
LOW)

シグナルの低周波数帯域を調整します。

ヘッドフォンキューボタン (CUE) プレフェーダーシグナルをキューチャンネル(ヘッドフォン)に送信します。

チャンネルフェーダー チャンネルのレベルをコントロールします。

チャンネルメーター チャンネルのプレフェーダーレベルを視覚的に表示します。
青表示でシグナルがクリッピングしていないことを意味します。
赤表示はシグナルがクリッピングしていることを意味します。

クロスフェーダー 両側から送信している音声のミックスバランスを調節します。

13.2.3 マスターディスプレイクイックリファレンス
 

コントロール部 機能

アラートインジケーター 問題が生じると点滅します。メインボリュームノブ、またはヘッドフォンボリュ
ームノブがソフトウェア上で低すぎる場合、CPU 負荷が高すぎる場合、ラップ
トップパワーサプライが接続されていない時にここが点滅します。

USB インジケーター ドライバが正常に起動すると点灯します。
点滅する場合は、接続に問題がある、またはドライバに問題があることを意味し
ます。

MIC インジケーター マイクロフォンインプット音声がある場合は点灯します。

13.3 FX ユニットクイックリファレンス
 

セクション↑7.8, FX ユニットの使用でコントロール各部の詳細を確認してください。

付録 C – クイックリファレンス
ミキサークイックリファレンス
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コントロール部 シングルモード (Single Mode) グループモード (Group mode)

FX オンボタン 通常は FX ユニット全体を起動/起動解除し
ます (起動すると点灯します)。
SHIFT を使用して FX リストから FX を選
択します (Preferences > Effects > FX
Pre-Selection と進んで設定します)。

通常は使用しません。
SHIFT との併用で、3 種の FX をロードしま
す (Preferences > TRAKTOR KONTROL S2
> S2 Control Options > Direct FX 1-3)。

FX DRY/WET ノブ ドライ/ウェットシグナルバランスを調節します。

FX ノブ 1-3 FX パラメーター 1-3 (FX により内容が変
化します)。

1 番目、2 番目、3 番目の FX 用パラメーター
です。

FX ボタン 1-3 FX ボタン 1: 全 FX パラメーターをデフォ
ルト値にリセットします。
FX ボタン 2 と 3: FX によって内容が変化
します (起動により点灯)。
SHIFT + ボタンで既存の FX をロードしま
す (Preferences >
TRAKTOR KONTROL S2 > S2 Control
Options > Direct FX 1-3 で内容を設定し
ます)。

FX スロット 1-3 を起動/起動解除 (スロット
が起動すると点灯します)。
SHIFT + ボタンで FX リストの次の FX をス
ロットにロードします (Preferences >
Effects > FX Pre-Selection で設定します)。

13.4 ブラウズ、ロード、コピークイックリファレンス
 

セクション↑7.9, ブラウズとロードでコントロール各部の詳細を確認してください。

コントロール部 機能

ロードボタン A/B (BROWSE
エンコーダーの下)

通常は各デッキに選択したトラックをロードする機能を果たします。
SHIFT と共に使用すると、反対側のトラックデッキの内容をデッキにコピーします。
ジョグホイールのトップパネルを押すと光ります。

BROWSE エンコーダー 回すことで、プレイリスト内をスクロールします。
SHIFT +回す動作で、ブラウザツリー内をスクロールします。
SHIFT + 押す動作でブラウザツリーのフォルダを展開、最小化します。
押すことでブラウズモードを起動/停止します。
押しながら回すことでプレイリストを 10 個飛ばしながら移動します。

付録 C – クイックリファレンス
ブラウズ、ロード、コピークイックリファレンス

 

TRAKTOR KONTROL S2 - オペレーション マニュアル - 162



索引
アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
Absolute (prefs) [130]
Absolute モード [100]
Analysis [57]
Audio Processing (Control Panel) [138]
Audio Settings (コントロールパネル) [138]
Auto Loop (prefs) [129]
Beatgrid [57]
Beatjumps [103]
BPM [60]
BROWSE エンコーダー

Quick Loading [122]
Channel [87]

CUE ボタン [30] [116]
FX Assign ボタン [114]
HI ノブ [113]
LOW ノブ [113]
MID ノブ [113]

Clock
テンポマスターとして設定する [59]
パネル [58]

Collection [19]
Connection Monitor (Control Panel) [141]
Controller Editor [124]
Crossfader [33]
CUE MIX ノブ [30] [91]
Cue Points

Floating Cue Point [102]

CUE VOL ノブ [91]
Cue チャンネル [30]
Cue ポイント

設定と保存 [31]
CUE ボタン (Deck)

on Track Decks [109]
CUE ボタン (Mixer) [116]
CUE/REMIX SLOTS [104]

Cue の状態 [105]
Remix Deck Mode [106]
キューまたはループポイントの保存 [105]
キューモード [105]
サンプルのクイックロード [107]
サンプルの取り込み [107]
ホットキューの削除 [106]

CUE/SAMPLES ボタン [43]
Deck [83]

flavor [86] [133]
Device Monitor (Control Panel) [139]
Direct FX 1-3 (prefs) [129]
Distortion [40]
Drop-Out Detection (Control Panel) [141]
DRY/WET ノブ (FX Unit) [56]
EQ [113]

トラックミックスでの使用 [33]
FILTER ノブ

トラックミックス [33]
Flavor (Deck) [86] [133]
Floating Cue Point [102]
Floating Loop [102]
FLUX モード [73]
Front パネル l

索引
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Microphone Volume ノブ (MIC VOL) [91]
FX

loading (Group mode) [54]
loading (Single mode) [55]
デフォルト [53]
テンポシンク [55]
同期 [57]

FX Assign ボタン [114]
FX Unit

DRY/WET ノブ [56]
Group モード [120]
Quick Reference [161]
Single モード [120]
コントロール [54]
スナップショット [56]
チャンネルへのアサイン [54]

FX ユニット [88]
リファレンス [119]

FX をチャンネルにアサインする [54]
GAIN エンコーダー [38]
GAIN/FILTER エンコーダー [112]
Group モード [120]

FX Dry/Wet バランスの調節 [56]
Hardware Control Reference [97]
Headphones 端子 (PHONES) [153]
HI ノブ [113]
Information (コントロールパネル) [141]
iTunes [21]
iTunes から音楽をインポートする [21]
Knowledge Base [146]
Latency [136]
LEDs (prefs) [132]
Loop Buttons (prefs) [129]
LOOP IN ボタン

on Track Decks [102]
Loop mode [48] [108]
Loop MOVE encoder

on Track Decks [103]
LOOP MOVE エンコーダー

トラックデッキ [42]
Loop Out Point [102]
LOOP OUT ボタン

on Track Decks [102]
Loop Size Display [41]
Loop SIZE エンコーダー

on Track Decks [103]
トラックデッキ [41]

Loop セクション
トラックデッキ [40]

Looped モード [57]
Loops

activating/deactivating [103]
Floating Loop [102]
サイズの調節 [103]
トラック内での設定 [41]

LOW ノブ [113]
MAIN OUT セクション [90]
Main セクション [88]
MAIN ノブ (software) [39]
Main レベル [39]
Master ディスプレイ

アラートインジケーター [117]
MIC VOL ノブ [91]
Microphone Volume ノブ (MIC VOL) [91]
MID ノブ [113]
MIDI モード [123]
Mixer [86]

channel [87]

索引
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Main セクション [88]
Quick Reference [160]

Mixing
自動シンクの使用 [29]

ON/OFF スイッチ [91] [154]
One-shot mode [48]
Online Support Form [146]
Output Latency [139]
OUTPUTS Section

BOOTH/MAIN Switch [90]
OUTPUTS セクション

Level ノブ [90]
MAIN アウトプット [90]
MAIN/BOOTH アウトプット [90]

PHONES ソケット [91]
PHONES 端子 [153]
PLAY ボタン (Deck)

on Track Decks [109]
Playlist [86]

ブラウズ [122]
POWER セクション [90]
Preferences

Audio Setup page (Windows) [137]
TRAKTOR KONTROL S2 page [127]

Preferences ボタン [125]
Process Buffer (コントロールパネル) [139]
Processing State (コントロールパネル) [139]
QUANT ボタンとインジケーター [32]
Quantize モード [32] [60]
Quick Loading

サンプル [121]
トラック [121]

Quick Overview [16]
Decks [17]

FX ユニット [18]
Mixer [18]

Quick Reference [158]
FX Unit [161]
Loading, copying [162]
Mixer [160]

Quick-loading
トラック [24]

Relative (prefs) [130]
Relative モード [130]
Remix Deck [45]

concept [86]
Remix Decks [16] [86]
Remix Mode ボタン [119]
REMIX ノブ [119]
S2 からのコピー [121]
S2 からのブラウズ [121]
S2 からのロード [121]
S2 とラップトップの使用 [145]
S2 のキャリブレーション [132]
Sample Rate

Mac OS X [136]
Windows [138]

Sample Slot [47] [86]
Samples [45]

capturing from a track [49]
playback mode [48]

Scratching
on a track [99]

Seeking through a track [99]
Settings ボタン (prefs) [137]
Setup Wizard [133]
SHIFT ボタン

タッピング [111]

索引
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Single モード [120]
Snap モード [42] [50] [60]
Switching between Deck flavors [133]
SYNC button

on Track Decks [110]
SYNC ボタン

トラックデッキ [59]
Tempo

自動調整(Sync) [30]
手動調節 [34]

Tempo bending
on Track Decks [99]

Tempo Faders (prefs) [130]
Tempo master

Track Deck の設定 [60]
Tempo Offset ボタン (OFFSET)

in Relative mode [130]
Tempo Reset [101]
TEMPO フェーダー [100]

Absolute モード [100]
Relative モード [130]

Tempo マスター
Track Deck の設定 [110]

Track
info [26]

Track Collection [19]
Track Deck [46]
Track Decks [16] [86]
TRAKTOR Clock

テンポマスターとして設定する [59]
TRAKTOR クロック [58]
TRAKTOR モード [123]
TRAKTOR をデフォルト S2 設定にリセットす

る [133]

TRAKTOR DJ [63]
Filters [65]
Freeze Mode [77]
FX [79]
iOS 互換性 [63]
Loop Slicer [74]
Loops [74]
Stripe Navigation [70]
Tempo Faders [71]
Transport Section [71]
波形のズーム [76]

TRAKTOR DJ 操作のための主要機能
デッキボリュームコントロールとクロスフェー

ダー [63]
TRAKTOR KONTROL S2 コントローラー

メインエリア [83]
TRAKTOR KONTROL S2 のカスタマイズ

[125]
Troubleshooting [143]
USB インジケーター [117] [144]
USB の問題 [143]
USB 端子 [91] [150]
一般的な設定 [148]
音楽のインポート [19]
音楽ファイル [19]
音楽フォルダ [19]
音程 (トラック) [61]
各チャンネルのシグナルフロー [112]
環境設定

Audio Setup ページ (Mac OS X) [136]
環境設定(Preferences) [125]
環境設定アイコン [125]
基本設定 [148]
技術仕様 [157]
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曲のインポート [19]
互換性 [15]
資料

Setup Guide [13]
TRAKTOR 2 マニュアル [13]
マニュアル [13]
読む順序 [14]

手動キュー [35]
手動ループ (prefs) [129]
選択

トラック [24]
端子

MIC [156]
PHONES [153]
USB [91]

電源 [148]
電源コネクター [91]
電源供給コネクター [149]
動作環境 [15]
同期 [56]
波形 [44]
歪み [37]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
アップデート [147]
アラートインジケーター [117]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
インプットルーティング [133]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
エフェクト [88]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
オーディエンス [37]
オーディオインターフェイス [136]
オフセット

手動修正 [36]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
キーロック [61]
キャリブレーション [132]
キュー [31] [40]
キューポイントの保存 [31]
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アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
クイックリファレンス [158]
クリッピング [37] [40]
クロスフェーダー [116]
クロック [58]

クロックのテンポ設定 (BPM) [60]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ケンジントンロックスロット [89]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
コントロールパネル

Audio Settings ページ [138]
Diagnostics ページ [140]

コントロールパネル(Control Panel) [137]
コントロール各部

ジョグホイール [94]
各エンコーダー [93]
各スイッチ [96]
各ノブ [93]
各フェーダー [95]
各ボタン [92]
各メーター [95]

コントロール部の種類
SHIFT ボタン [92]
SHIFT ボタン & 二次機能 [98]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
サンプル [86]

サンプルの停止と頭出し [48]
トリガー [48]
ロード [46]
再生 [48]

サンプルの削除 [109]
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アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ジョグホイール

トッププレート [36]
トラックデッキ [99]
外枠 [36]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
スナップショット (FX Unit) [56]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ソケット [96]

PHONES [91]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ダイナミックレンジ [37]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
チャンネル [26]

シグナルフロー [112]
フェーダー [115]
メーター [115]

チャンネルに FX をアサインする [114]
チャンネルフェーダー [115]
チャンネルメーター [115]
チュートリアル [23]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
デフォルト FX [53]
デフォルトオーディオインターフェイスとして

S2 を使用する [142]
デフォルト設定の再現 [131]
テンポベンド

トラックデッキ [36]
テンポマスター [56]
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アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ドライバの問題 [143]
トラック [86]

ロード [23]
再生 [23]

トラックデッキ
コンセプト [86]

トラックでループを設定する。 [41]
トラックの再生 [23]
トラックの最初に戻る [33]
トラックの同期

オートシンクの使用 [30]
マニュアル操作 [34]

トラック同士を揃える [32]
トラック内のループ設定 [101]
トラブルシューティング

無音 [27]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ナビゲート

選択したループサイズによるトラック [42]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ノイズレベル [37]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ビート

マニュアルアライン [36]
ビートマッチ

マニュアル操作 [34]
ビートマッチング

クオンタイズ [31]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
フェイズオフセット(修正) [36]
フェーダー

TEMPO [100]
チャンネル [115]

プレビュープレイインジケーター [118]
フロントパネル [91]

ヘッドフォンボリュームノブ (CUE VOL) [91]
ヘッドフォンミックスノブ (CUE VOL) [91]
ヘッドフォン端子(PHONES) [91]
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アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ヘッドフォンキュー

CUE MIX [68]
ヘッドフォンキューボタン [116]
ヘッドフォンボリュームノブ (CUE VOL) [91]
ヘッドフォンミックスノブ (CUE MIX) [30] [91]
ヘッドフォンを使用したミックスの準備 [30]
ヘッドフォン端子(PHONES) [91]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ホットキュー [43]

削除 [44]
保存 [31] [43]

ホットキューの削除 [44]
ホットキューの保存 [31] [43]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
マイクロフォン [155]
マイク端子 (MIC) [156]
マスターディスプレイ [117]

USB インジケーター [117] [144]
プレビュープレイインジケーター [118]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ミキサー

チャンネル [26]
マスターディスプレイ [117]
メインセクション [116]
リファレンス [112]

ミックス
マニュアル操作 [34]
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アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
メインアウトプット 1/2 [152]
メインセクション [116]
メーター

チャンネル [115]
メトロノームアイコン [58]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ユーザーフォーラム [147]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
リアパネル [89]

MAIN OUT セクション [90]
POWER セクション [90]

リミッター [40]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
ループ

サイズの調整 [101]
サイズの調節 [41]
トラック内での設定 [41] [101]
ループの解除 [43]
ループの保存 [43]
移動 [42] [101]

ループサイズの変更 [41]
ループセクション

トラックデッキ [101]
ループの移動 [42] [101]
ループの解除 [43]
ループの保存 [43]
ループ機能 [40]

アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ
レイテンシー [139]
レベル

調整 [37]
レベルメーター [37]
レベル調整 [37]
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アイコン[*];数字[0-9];あ;い;う;え;お;
か;き;く;け;こ;さ;し;す;せ;そ;た;ち;つ;
て;と;な;に;ぬ;ね;の;は;ひ;ふ;へ;ほ;ま;
み;む;め;も;や;ゆ;よ;ら;り;る;れ;ろ;わ

ロード
サンプル [46]
トラック [23]
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